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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
Applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

PeopleSoft Hosted Online Help

You access the PeopleSoft Online Help on Oracle’s PeopleSoft Hosted Online Help website, which
enables you to access the full help website and context-sensitive help directly from an Oracle hosted
server. The hosted online help is updated on a regular schedule, ensuring that you have access to the
most current documentation. This reduces the need to view separate documentation posts for application
maintenance on My Oracle Support, because that documentation is now incorporated into the hosted
website content. The Hosted Online Help website is available in English only.

Note: Only the most current release of hosted online help is updated regularly. After a new release is
posted, previous releases remain available but are no longer updated.

Locally Installed Help

If your organization has firewall restrictions that prevent you from using the Hosted Online Help
website, you can install the PeopleSoft Online Help locally. If you install the help locally, you have more
control over which documents users can access and you can include links to your organization’s custom
documentation on help pages.

In addition, if you locally install the PeopleSoft Online Help, you can use any search engine for full-text
searching. Your installation documentation includes instructions about how to set up Elasticsearch for
full-text searching. See PeopleTools Installation for your database platform, “Installing PeopleSoft Online
Help.” If you do not use Elasticsearch, see the documentation for your chosen search engine.

Note: See Oracle Support Document 2205540.2 (PeopleTools Elasticsearch Home Page) for more
information on using Elasticsearch with PeopleSoft.

Note: Before users can access the search engine on a locally installed help website, you must enable the
Search field. For instructions, go to your locally installed PeopleSoft Online Help site and select About
This Help >Managing Locally Installed PeopleSoft Online Help >Enabling the Search Button and Field
in the Contents sidebar.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format.
The content in the PeopleBook PDFs is the same as the content in the PeopleSoft Online Help, but it has
a different structure and it does not include the interactive navigation features that are available in the
online help.
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Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main

types of common help are:
* Application Fundamentals

* Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for

fundamental implementation tasks.

In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using

PeopleSoft Applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the

documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention

Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any

number of times in PeopleCode syntax.

{ } (curly braces)

Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe ( | ).

[ 1 (square brackets)

Indicate optional items in PeopleCode syntax.
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Typographical Convention Description

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry ldentifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

* Asia Pacific
* Europe
¢ Latin America

¢ North America
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Industry ldentifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

e USF (U.S. Federal)

*  E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.

Using and Managing the PeopleSoft Online Help

Click the Help link in the universal navigation header of any page in the PeopleSoft Online Help to see
information on the following topics:

*  What’s new in the PeopleSoft Online Help.
* PeopleSoft Online Help accessibility.
* Accessing, navigating, and searching the PeopleSoft Online Help.

* Managing a locally installed PeopleSoft Online Help website.

Understanding PS/nVision

This book covers the use of PS/nVision, a PeopleTools software that you use to design and create
Microsoft Excel spreadsheet reports for PeopleSoft data. It covers the basic concepts behind PS/nVision,
how to run PS/nVision reports, how to create the layouts on which reports are based, and how to secure
and tune PS/nVision.

PeopleTools Related Links

Hosted Online Help Home

PeopleSoft Information Portal

My Oracle Support

Oracle University

Xii Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.


http://docs.oracle.com/cd/E17566_01/epm91pbr0/eng/psbooks/psft_homepage.htm
http://www.peoplesoft92.com/
https://support.oracle.com/CSP/ui/flash.html
http://education.oracle.com/pls/web_prod-plq-dad/db_pages.getpage?page_id=402&p_nl=OPSE

Preface

Oracle's PeopleSoft PeopleTools 8.56 Home Page (Doc ID 2259140.2)

Elasticsearch Home Page (Doc ID 2205540.2)

"PeopleTools Product/Feature PeopleBook Index" (PeopleTools 8.56: Getting Started with PeopleTools)

Contact Us

Send your suggestions to PSOFT-INFODEV_US@ORACLE.COM. Please include release numbers for
the PeopleTools and applications that you are using.

Follow Us

'F Facebook.
YouTube

Twitter@PeopleSoft Info.

PeopleSoft Blogs

LinkedIn

SE-ER-E
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Chapter 1

Getting Started with PS/nVision

PS/nVision Overview

PS/nVision retrieves information from your PeopleSoft database and places it into a Microsoft Excel
spreadsheet, in a form that helps you see the big picture, explore details, and make decisions. You
use familiar Excel commands to format and analyze the data. With PS/nVision, you spend your time
analyzing results rather than summarizing data and entering it into a spreadsheet.

PS/nVision works within spreadsheets. You access PS/nVision features from a special PS/nVision menu
within Microsoft Excel to create templates (layouts) for data retrieval. Once you create a report layout
(XNV file), you can use it to format data automatically.

The PS/nVision interface is similar to a Web browser, with buttons and displays that can be customized.
You can also create a custom front-end macro sheet for point-and-click access to reports and reporting
functions.

PS/nVision selects data from your PeopleSoft database using ledgers, trees, and queries. Queries are
useful for extracting data from sources other than ledgers, so you should be familiar with PeopleSoft
Query concepts, especially query result sets, before working with PS/nVision. Also, tree data is used to
limit the query results, so you should be familiar with nodes and detail values.

On the Web version, PS/nVision works closely with Process Scheduler and Distribution Agent and

forms a report server with them in a Windows NT machine. When running and drilling a PS/nVision
report, Process Scheduler is the bridge between nVision engine and PeopleSoft Pure Internet Architecture
applications that launch nVision engine and communicate the report running status back to the
applications. PS/nVision uses Distribution Agent to transfer the report instances between nVision file
server and the report repository. The report repository servlet in the Web server enables users to access
PS/nVision reports in Report Manager.

Similar to the Web version, on the UNIX version, the Process Scheduler is the bridge between nVision
engine and PeopleSoft Pure Internet Architecture applications. On the UNIX version, the Process
Scheduler should run on a UNIX machine.

PS/nVision works in three modes:
*  OpenXML mode.
¢ Excel Automation mode.

¢ Cross Platform mode.

Note: On the Web version, the OpenXML, Excel Automation, and Cross Platform modes are mutually
exclusive. Only one mode is in effect at any given time. On the UNIX version, Cross Platform mode is
the only mode currently available.
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PS/nVision — OpenXML Mode

nVision uses the OpenXML mode on the batch server that uses Microsoft’s OpenXML SDK to generate
Excel-compatible documents.

Note: The OpenXML mode is the default mode in PeopleTools, and the default setting of the
UseExcelAutomationMode flag in psprcs.cfg is 0.

Image: nVision architecture - Web version of PS/nVision in OpenXML mode

This diagram illustrates the Web version of PS/nVision in OpenXML mode.

Browser Web App
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PS/nVision - Excel Automation Mode

PS/nVision continues using the operation mode called Excel automation mode that automates the Excel
application to generate spreadsheet documents in PeopleTools PIA architecture.

Note: To enable the Excel automation mode in nVision, you need to set the UseExcelAutomationMode
flag in psprcs.cfg to 1.
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Image: nVision Architecture - Web version of PS/nVision in Excel automation mode

This diagram illustrates the Web version of PS/nVision in Excel automation mode.
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PS/nVision - Cross Platform Mode

PS/nVision uses the Cross Platform mode to generate spreadsheet documents in PeopleTools PIA

architecture.

Note: To enable the Cross Platform mode in the Web version of PS/nVision, you set the

UseExcelAutomationMode flag in pspres.cfg to 2.

In the UNIX version, the Cross Platform mode is the default mode and the only mode currently available.
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Image: nVision Architecture - Web/UNIX version of PS/nVision in Cross Platform mode

This diagram illustrates the Web/UNIX version of PS/nVision in Cross Platform mode.
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PS/nVision Implementation
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Although PeopleSoft delivers a number of PS/nVision layouts that you can use to run PS/nVision reports,
you probably want to create your own report layouts and set up PS/nVision to suit your particular needs.
Use the following steps, as appropriate.

Note: These setup steps assume that you have already installed and implemented your PeopleSoft
applications, that you are familiar with PeopleSoft Query, that you have set up your ledgers in PeopleSoft
General Ledger (if you are using PS/nVision to run ledger-based reports), and that you have set up
ChartField trees in PeopleSoft Tree Manager (if you are using PS/nVision to run reports based on tree
nodes and detail values).

Basic PS/nVision Setup

The following table lists the basic setup tasks that you perform to create and run your own PS/nVision
report layouts.
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Step

Reference

Set up the PeopleSoft Configuration Manager settings for your
Microsoft Windows client.

You must define the directories where PS/nVision looks for
various file types on the nVision tab on the Edit Profile dialog
box in Configuration Manager.

Note: If, when you first try to access PS/nVision, an error
message indicates that your client machine is not configured
for nVision, you may also need to click the Install Workstation
button on the Client Setup tab in Configuration Manager

to load important PS/nVision DLL files to your machine's
Windows registry.

See Using Configuration Manager.

Set up PeopleSoft Process Scheduler settings for the
PeopleSoft Pure Internet Architecture.

See Configuring PS/nVision on the Web.

Plan your layouts.

See Understanding Layouts, Converting Existing Layouts and

Reports to OpenXML Format, Comparing Tabular Layouts
Matrix Layouts, and QueryLink, Working With Layouts.

Create layouts.

See Creating Layouts, Creating Tabular Layouts,

Understanding Matrix Layouts, Creating Matrix Layouts

Understanding Ledger-Based Matrix Layouts.

Define report scopes (optional).

See Understanding Report Scopes, Defining Scopes, Working
With Existing Scopes, Using Scope-Related Variables,

Creating Scope Definitions.

Define Drilldown layouts (optional).

See Using DrillDown, Using DrillDown Navigation, Using

DrillDown Layout Formats, Using the PS/nVision DrillDown
on the Web.

Define nPlosion criteria, defaults, and style sheets (optional).

See Understanding nPlosion, Defining nPlosion Criteria,
Defining nPlosion Defaults, Enabling nPlosion for Specific

Situations, Using Style Sheets with nPlosion Layouts.

Define report distributions based on tree nodes and other scope

variables (optional).

See Understanding Report Distribution, Distributing Reports

for Scopes Based on Tree Nodes, Distributing Reports for

Scopes Based on Value Tables, Configuring the Report Node.

Set up PS/nVision security.

See Securing PS/nVision Elements, Securing Report

Distribution, Implementing PS/nVision Ledger-Based Data
Security, Implementing PS/nVision Query-Based Data
Security.
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Advanced PS/nVision Setup

The following table lists advanced setup tasks you can perform to configure PS/nVision to meet your

needs.
Task Reference
Set up advanced PS/nVision options (optional). See Enhancing Report Layouts, Setting PS/nVision Options,

Creating Virtual Ledgers, Using PS/nVision-Defined Names,
Formatting Dates, Setting Trace Files, Dismissing Unattended

This task includes selecting whether to display warning

messages and dialog boxes when PS/nVision runs reports, Dialogs.
creating virtual ledgers, and enabling trace files.
Personalize PS/nVision (optional). See Understanding PS/nVision Personalization, Using

Configuration Manager, Personalizing NVSUSER.XLS,
Setting Report Preferences, Customizing Delivered Visual

Basic Application Wizards, Changing the Startup File, Using

PS/nVision API Functions, Configuring PS/nVision on the

Web.
Develop Visual Basic applications that call PS/nVision See Using Designer Object Methods, Designer Object
features (optional). Methods, Using Session Object Methods, Session Object

Methods, Instance Hooks.

Tune PS/nVision performance (optional). See Understanding PS/nVision SQL, Assigning Ledger Tables,

Using Indexes and PS/nVision Tuning, Using Trees, Setting
Tree Performance Options, Using Tree Tables.

Other Sources of Information

In the implementation planning phase, take advantage of all PeopleSoft sources of information, including
the installation and upgrade guides, release notes, red papers, updates and fixes posted to My Oracle
Support, PeopleSoft curriculum guides, and other product documentations.
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Accessing PS/nVision
You can access PS/nVision from the web or from Windows. You can use any of the following three
navigation paths:
*  From the PeopleSoft Windows-based application (Application Designer): Select Go > nVision.

*  From Microsoft Windows: Select Start > Programs > PeopleSoft 8.x > nVision. Enter a database
name, user ID, and password as you would to start any PeopleSoft application.

*  From the Web: Select Reporting Tools > PS/nVision.

If you are using Windows, PS/nVision automatically opens Microsoft Excel when it starts. The PS/
nVision program itself appears minimized on the Windows taskbar. You can click the PS/nVision icon to
open the PS/nVision window, but unless a specific PS/nVision dialog box is currently active in Excel, the
PS/nVision window is blank.

Important! Don’t close this window—it will end your PS/nVision session, even though Excel is still
running.

You initiate PS/nVision commands using the nVision menu in the Excel menu bar or—depending on your
setup—Dby using a special spreadsheet file, NVSUSER.xls, which opens when you start PS/nVision. When
you close Excel, PS/nVision closes automatically as well.

Note: Your Windows locale must support the signon language.

For PS/nVision to appear in the Microsoft Windows navigation path, select the nVision option located
under the Configuration Manager — Client Setup dialog box.

In PS/nVision for Microsoft Windows, you use the PeopleSoft Configuration Manager to configure the
locations of various PS/nVision files, such as layouts, templates, and spreadsheets.

When you first access PS/nVision in Microsoft Windows, if an error message indicates that PeopleSoft
PeopleTools DSN is missing in ODBC data sources, you need to run the psodbccrinst.exe to install the PS
ODBC driver. If an error message indicates that your client machine is not configured for nVision, you
need to click the Install Workstation option on the Client Setup tab in the Configuration Manager to load
important PS/nVision DLL files to your machine's Windows registry.

See PeopleTools Installation Guide: Setting Up the Install Workstation.
Related Links

Personalizing NVSUSER.XLS
"Configuring nVision" (PeopleTools 8.56: System and Server Administration)
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Creating Report Instances and Layouts

22

Each Excel spreadsheet created with PS/nVision is a report instance or a report layout. A report instance
contains data that PS/nVision has retrieved from your PeopleSoft database. Every report instance is based
on a report layout. PS/nVision uses the specified layout to determine the data to retrieve for the report and
how to display it.

Note: Beginning from PeopleTools release 8.51, all PS/nVision layouts and all report instances (that are
used to perform drilldown) must be in OpenXML (.xIsx) format. If you want to use existing layouts and
reports that are in Excel 2003 (.xls) format, you must convert their format to .xlsx.

See Converting Existing Layouts and Reports to OpenXML Format.

Creating a PS/nVision report is a three-step process:

1. Define a report layout that specifies the ledgers, criteria, or queries to use for the report and how to
format the report.

The report layout is an Excel spreadsheet that does not include actual PeopleSoft data; it defines the
structure of the report—query information, criteria, text, formulas, graphics, formatting, or other
information. After a layout has been saved, you can use it repeatedly to run reports.

2. Create a report request, specifying the layout and runtime options for the report.

3. Run the report request, using the nVision menu in Microsoft Excel, the Run button on the request
dialog box, or a button/macro that calls PS/nVision to run the report.

As the report runs, a copy of the layout—an instance—is populated with data and is saved as a normal
spreadsheet file. You can produce multiple instances of the report. For example, you might provide an
inventory report for each location within your organization. Each instance is an individual report with
current data from your database, selected and formatted according to the instructions in the report
layout.

Note: If you are using a scope with your report, you can produce several instances from one layout with
one report request.

Most PeopleSoft applications deliver predefined PS/nVision report layouts (such as Salaries by
Department, Balance Sheet, Profit and Loss, and Operations Summary). Like any spreadsheet, a layout
spreadsheet can be cloned and modified; you may rarely need to build one from scratch.

Besides the features that are available through PS/nVision, you can use Excel features to personalize
layouts (and the resulting reports). For example, Excel includes dynamically linked charting and drawing
tools for creating colorful graphs and diagrams. Because the layout is the basis for all reports produced
from it, you can format and enhance the report once and get the benefits automatically each time the
report is run.

Note: If you’re working with PeopleSoft Financials products, you may be interested in using ledgers with
PS/nVision and taking advantage of the TimeSpan feature to define reports that roll from period to period
without any changes to the layout. Using TimeSpans, you can have the same layout retrieve year-to-date
data based on the as of date for which the report is requested.
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See Understanding [edger-Based Matrix Layouts, Defining Ledger Criteria, Understanding Report
Scopes, Defining Scopes.

Layout and Instance Example

To help you visualize the relationship between a report layout and a report instance, this section includes a
sample matrix layout with unique data selection criteria for individual rows and columns.

Image: A Sample layout having the Department, Description, Sales, and Costs fields

The following layout is an example of a report based on the layout. The Sales and Costs columns specify
account numbers, and the rows specify department numbers.

YaAPMNY%

Department Description Sales Costs

Tree Mode for Sales Label Associated Software License Sales Expense

Depts. with Department Revenue Account Accounts 800000
Table 600000 and 801000

Sales Departments SUm SUMm

Image: A sample final report having the Department, Description, Sales, and Costs fields

In the final report, each cell contains the data for the account number (column) and department number
(row) that intersect at that cell.

October

Department Description Sales Costs

0200 San Francisco 4 800 2,774
0210 Chicago 3,500 1,883
0220 Mew York 4 800 2,774
0230 Paris 3,800 1,884
0240 Takyo 5,700 1,778
Sales Departments 23,600 11,203

The sample layout contains several types of information:
*  Text

This refers to text that appears as-is in all report instances. In the sample above, the column headings
—Department, Description, and so on—are standard text that remains the same in all reports created
from the layout.

¢ PS/nVision variables

PS/nVision replaces variables with values when you run a report. The sample layout uses the % APN
% variable for the time period reported on. When PS/nVision creates a report with this layout, it
replaces the variable with the period covered by the report. If you use a scope to produce multiple
instances of a report, you can use variables in the report heading so each reader knows what data the
report contains.

*  PS/nVision labels
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PS/nVision examines the tree structure and determines where to obtain the appropriate label for either
a tree node or a detail value. In the example, PS/nVision relates a sales department description to the
department table entry for each department corresponding to the Sales Depts tree node.

PS/nVision selection criteria

Selection criteria specify the data to retrieve from your PeopleSoft database. For example, the Sales
column in the sample layout has criteria that direct PS/nVision to retrieve data from the Sales account.

Microsoft Excel formulas

These formulas perform calculations on the report data. In the example, the bottom row automatically
displays totals of the Sales and Costs columns. You could add a calculated column, Gross Income,
calculated via an Excel formula that subtracted Costs from Sales.

Formatting

Formatting information includes attributes such as font size, underlining, column width, print options,
and so on. You design your layouts using familiar Excel methods; any formatting and enhancements
you place in the layout appear in all reports created from it.

Using Microsoft Excel Features

In addition to the PS/nVision functionality for retrieving data from your PeopleSoft database, you still
have all of Microsoft Excel's features at your disposal. This section describes how to:

L]

Insert formulas

Insert and format text

Inserting Formulas

Formulas enable you to perform calculations such as adding column or row data, computing variances,
calculating ratios, and so forth. You can use cell references such as =C2+(C3, name references such as
=Revenue-Expenses, or worksheet functions (see the Excel documentation or online help for a list of
commands). All formulas begin with an equal sign (=). You can use a number of formula operators for
calculations.

The following table lists the most common operators.

Symbol Description Purpose

+ Plus sign Addition

- Minus sign Subtraction

* Asterisk Multiplication

/ Slash Division
Colon Range

24
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Symbol Description Purpose
Space Intersection
s Comma Union
- Hyphen Negation
% Percent sign Percent
& Ampersand Text concatenation operator

To enter a formula, click in the worksheet cell where you want the formula or text to appear, and begin
typing. As you type, your cursor appears in the Excel formula bar (the rectangular box just below the
menu bar, above the worksheet). The Cancel and Enter buttons appear to the left of the cursor.

Image: Example of Excel and nVision formula bar

This example shows the Excel and nVision formula bar.

B9 Microsoft Excel - n¥ision_2.xn¥
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Inserting and Formatting Text

Text is used mainly for column and row headings, captions, and callouts. Excel has a number of
formatting features to enhance the appearance of text in your worksheet.

Formatting is also straightforward, provided that you know where to look for the commands. To resize
columns and rows in Excel, either highlight the row or column and drag its border, or select Format,
Column, Width or Format, Row, Height. You can also select Column Width, Best Fit to automatically set
the width for headings. Do not select Best Fit until you have typed the longest line in the column.

To wrap column headings within a cell, select Format > Cells and then select the Wrap Text on the
Alignment tab.

Note: You can use conventional Excel commands for additional formatting.

See the Microsoft Excel User s Guide.
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Understanding Layouts

PS/nVision enables you to import information directly from your database into an Excel spreadsheet,
so you can spend your time analyzing results rather than summarizing data and entering it into your
spreadsheet.

To specify the data you want to bring into Excel, you use a report layout. A report layout is an Excel
spreadsheet used as a template to define how a report looks and the type of information that goes into the
spreadsheet’s different cells. A layout does not contain data from the database. Rather, it specifies what
data should be mapped directly into your report.

You do not need to create a new layout every time you run a report. After you have created a library of
report layouts, select the existing layout that best suits your needs. PS/nVision keeps track of the layout
used in any given report, so to run an existing report you simply select nVision, Report Request and
specify the report name or simply click the Run Reports button from the NVSUSER homepage. The
correct layout is loaded automatically.

Converting Existing Layouts and Reports to OpenXML Format

All PS/nVision layouts and all report instances (that are used to perform drilldown) must be in OpenXML
format (.xIsx). If you want to use existing layouts and reports that are in previous Excel format (.xls), you
must convert their format to .xIsx.

To convert layouts and reports from .xls format to .xIsx format, perform one of these methods on the PS/
nVision client desktop:

¢ Manual and individual conversion.

e Mass conversion using Microsoft conversion utility.

Manual and Individual Conversion

To manually and individually convert layout or report from .xlIs format to .xlsx format:

1. Open the .xIs layout or report in Microsoft Excel 2007.

2. Click on the Office button on the upper-left corner.

3. Select Save As, Excel Workbook for the layout or report that does not contain macros.

Otherwise, select Save As, Excel Macro-Enabled Workbook for the layout or report that contains
macros.

4. Enter the name of the layout or report using the .xnv format.
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For example, ExpenseDetail xnv.

Set the Save As type in .xIsx for the layout or report that does not contain macros.
Otherwise, set the Save 4s type in .xIsm for the layout or report that contains macros.
Click the Save button to complete the conversion, and close the layout or report.

Repeat step 1 through step 6 for each layout or report that needs to be converted.

Mass Conversion Using Microsoft Conversion Utility

Microsoft provides these free software toolset for converting .xls format to .xIsx format:

MigrationPlanningManager.exe, which includes the ofc.exe file and other tools used for mass
conversion.

FileFormatConverters.exe Office Pack, which installs binaries used for format conversion.

To convert layouts from .xIs format to .xIsx format using the Microsoft conversion utility:

1.

Download the MigrationPlanningManager.exe folder and extract it into a new folder.
For example, C:\Office.

Download and install the FileFormatConverters.exe Office Pack.

Note: This step is required even if Microsoft Office 2007 is already installed on your computer.

Access C:\Office\tools and open the ofc.ini file using Notepad.
In Notepad, set the following values:
*  MacroControl=1

This setting processes the macros associated with the layouts.
o fldr=<PS HOME>/nVision/Layouts

This setting refers to the source folder location that contains the layouts to be converted.

Backup all layouts that need to be converted and move them to a separate folder.
Rename all nVision layouts from *.xnv to * xIs.

This step is required because the utility does not recognize any file types other than Excel's native file
types.

Open the command prompt and access C:\Office\Tools.
Run the ofc.exe file.

This utility converts all .xls files present in the source folder, which are stored in the ofc.ini file,
to .xlsx format.
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9. Rename the layouts from *.xIsx or *.xlsm to *.xnv.

Note: Microsoft conversion utility may not successfully convert password-protected layouts; password-
protected layouts should be manually or individually converted.

Comparing Tabular Layouts, Matrix Layouts, and QueryLink

PS/nVision offers two kinds of report layouts: tabular layouts and matrix layouts. The major difference

between them is how they specify the data to retrieve from the database. In general, tabular layouts lend
themselves to detailed transaction reporting, while matrix layouts are more appropriate for summarized
reporting and analysis.

Tabular layouts are simpler than matrix layouts. They use a query defined in PeopleSoft Query to retrieve
data. The columns in the report correspond to the fields returned by the query; the rows in the report
correspond to the rows in the query result set. You can specify a heading row, a first result row, and a
totals row (if you need one). You can also use scopes in a tabular layout to filter your results.

Matrix layouts have data selection criteria based on the intersection of columns and rows in the
spreadsheet, creating a criteria matrix. The data retrieved for an individual cell is determined by a
combination of the criteria for its column and its row. Unless you are specifying a query in the matrix
layout, all matrix layouts must have at least one TimeSpan, at least one ledger, and at least one ChartField
as criteria.

You can specify a ledger, a query, or both a ledger and a query to retrieve data. For PeopleSoft Financials
applications, matrix layouts most often use ledgers for data retrieval. PS/nVision knows automatically the
tables to access and the fields to retrieve based on the ledger definition.

QueryLink is a PeopleSoft Query feature that enables you to send the results of a query directly to

an Excel spreadsheet, bypassing the need for a PS/nVision layout. Any query results sent to Excel
through QueryLink are based on the QUERY.XLT Excel template. To make any permanent changes to
spreadsheets derived through QueryLink, make the changes to QUERY.XLT.

The following table shows some of the key differences between tabular layouts, matrix layouts, and
QueryLink.

Feature/Function Matrix Layout Tabular Layout QueryLink

Data sources Multiple queries and ledgers; | Single query. Single query.
labels.

Data Numbers in matrix, text in Text and numbers. Text and numbers.

labels and variables.

Data delivery Matrix intersections of field Selected query result columns, | All query result columns, one
criteria and queries (amounts) | one data row per spreadsheet | data row per spreadsheet row.
of label and field criteria TOW.

(text).
Layouts One per workbook. Multiple worksheets per None: produces one sheet in
workbook. template workbook (QUERY.
XLT).
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Feature/Function Matrix Layout Tabular Layout QueryLink
Selection criteria Scope Scope Query
Business Unit Query

Effective Dates
Query/Ledger
TimeSpan
Field
Label
String
PS/nVision variables Yes No No
Scope Multiple instances from the Multiple instances from the None
layout workbook. layout workbook.
nPlosion Rows and columns. None None
Drilldown from instance Yes No No
TimeSpans Yes, with data keyed by year, |No No
period.
Number of layout sheets One Many One

Working With Layouts

In general, how you create a layout depends on the layout type. However, some basic tasks are common
to all layout types. This section discusses how to:

*  Specify criteria.

* Use nPlosion (matrix layouts only).

e Set a TimeSpan.

*  Specify setIDs and business units.

* Enter effective dates.

Specifying Criteria

Data selection is the heart of the PS/nVision layout. The database values retrieved for a matrix-based
report are the results of intersecting criteria defined in the matrix layout. These criteria tell PS/nVision
exactly which database values to retrieve and where to put them. The values retrieved from a tabular

30

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 3 Using Layouts

layout are not row and column intersections but the results of a query. Each instance is a list file
representing either a partial or complete answer set for that query.

You can specify data selection criteria at the level of the entire spreadsheet, a row or column, or an
individual cell. Generally, you specify criteria at the highest level applicable. So, if you have criteria that
apply to the entire worksheet, you specify them at the worksheet level; if you have criteria that are unique
to a single cell, you apply them to that cell only.

If there is a conflict between row and column criteria, the row overrides the column criteria. Cell criteria
override all other criteria, followed by row, column, and finally worksheet criteria at the lowest level of
the hierarchy.

Note: nVision should not use trees with a mixture of dynamic details and range details. The
results returned from the reports using such trees could be inaccurate.

Related Links
Criteria Types

Using nPlosion

nPlosion is a feature that you can specify within your field criteria. If field criteria uses a tree node value,
nPlosion automatically adds rows or columns that contain the sublevels (while subtotaling) as well as
detail values found under the tree nodes that you specify. This creates a group of rows or columns that
can be summarized—showing just the tree node value—or expanded to show the detail values and the
summarized value.

You can also use nPlosion to show detailed TimeSpan information.

See Understanding nPlosion, Defining nPlosion Criteria, Defining nPlosion Defaults, Enabling nPlosion
for Specific Situations, Using Style Sheets with nPlosion Layouts.

Setting a TimeSpan

A TimeSpan limits query or ledger results to those from a particular period of time. Although you can use
TimeSpan in a query-based matrix layout, it is more commonly used in ledger-based matrix layouts.

Related Links
Using TimeSpans

Specifying SetlDs and Business Units

PS/nVision uses the setID you specify when creating a matrix layout to determine available choices
when you define layout criteria. If the Use Business Unit in nVision option is clear, you can omit the
setID. If you enter one, it must be valid. To set the Use Business Unit in nVision option on or off, select
PeopleTools > Utilities > Administration > PeopleTools Options.

Note: The Use Business Unit in nVision option is selected by default because essentially all PeopleSoft
applications now use business units.
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Entering Effective Dates

When you define a matrix layout, you must always enter an effective date. Like the setID, this controls
which values are available for you to select when defining criteria. For some criteria, you can override
the global effective date. Generally, it’s a good idea to use an effective date as late as any control (tree,
department, and so on) you might want to use in the layout. The effective date used for prompting while
designing a layout is not used when running the report; instead, the as of date for trees and other controls
is specified in the report request when running a report.

Creating Layouts

This section describes how to:

* Plan a layout.

* Open an existing layout.

* Create a new layout.

* Save a spreadsheet as a layout.
* Select a layout type.

*  Specify a layout definition.

Planning a Layout

Before you begin to define a layout online, you should do some planning and outlining on paper so you
fully understand what data you want to retrieve, what you want the resulting reports to look like, and so
on. The following checklist is a good way to make sure that you cover all bases before you start defining a
layout.

*  Outline your report specifications on paper, showing the desired rows, columns, and headings.
* Examine existing layouts and copy them, if possible, instead of starting from scratch.
* Determine the naming convention for your layout, scope, report request, and instances.

*  Determine at which levels (worksheet, column, row, or cell) you should specify the queries and
ledgers, fields, and labels you want to use as your criteria.

* Identify existing PeopleSoft queries that might support your query criteria. If they don’t exist, you’ll
have to create them. Do you want to use TimeSpans?

» Identify existing PeopleSoft trees that might support your field criteria, because it’s simpler to use tree
nodes than to specify detail values as your field criteria. Do you want to use nPlosion?

Opening an Existing Layout

You can open an existing layout to copy the report and then make minor changes to it. To open an existing
layout in PS/nVision:
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Select nVision > Open Layout from the nVision menu of PS/nVision (Nvsuser.)
Alternatively, click the Open Layout button.

The Open nVision Layout dialog box appears.

Select a layout (.xnv) file.

The directory this dialog box opens to is defined in the Configuration Manager.
Specify whether to create the layout as read-only.

Click the Open button.

After the file is open, select the Save as Layout option from the nVision menu and give the layout a
new name.

Note: If you used Microsoft Excel 2007 to save a layout with named cell using the File Name field, when
you open this layout file through PS/nVision, the named cell reference might be corrupted and the named
cell details are not properly shown.

Related Links

Using Configuration Manager

Creating a New Layout

You can create a new layout from scratch rather than basing a new layout on an existing one.

To create a new layout in PS/nVision:

L.

Select nVision > New Layout from the nVision menu.
The Create New nVision Layout dialog box appears.
Enter a name in the File name field.

PS/nVision supports file names of up to 50 characters in length. You cannot change the default .xnv
extension.

Specify whether you want to open the new layout as read-only.

Selecting this option enables you to open layouts in read-only mode. This protects shared layouts
from accidental changes and eliminates Excel messages indicating that the layout is in use (or resides
on a read-only network drive). Changes made to a read-only layout are not saved and are not reflected
in the report instances produced.

Click the Save button.

The new layout is created, saved, and opened for you to define.

Related Links
Choosing a Layout Type
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You can save an existing Excel spreadsheet or layout as a new layout.

To save an Excel spreadsheet or layout as a new layout:

1. From PS/nVision, open the spreadsheet by selecting File > Open from the nVision menu.

2. Select nVision > Save As Layout from the nVision menu.

The Save As nVision Layout dialog box appears, which enables you to save an opening Excel
spreadsheet (.xls file) as an nVision layout (.xnv file), or to save an opening layout as a new layout.

3. Type in a file name and click the Save button.

An Excel spreadsheet opens in PS/nVision.

4. Enter any text, such as headings in the columns and rows, that you need to type in manually.

Choosing a Layout Type

34

When you first create a new layout, the type — matrix or tabular — is not yet defined. You use the
PeopleSoft nVision Layout Options dialog box to specify the layout type.

Image: PeopleSoft nVision Layout Options dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Layout Options dialog box.
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Specify Type of Sheet
M atriv Layout Sheet
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Business Unit;

o]

Cancel

To specify a layout type in PS/nVision:

1. Select nVision > Layout Definition from the nVision menu.
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The PeopleSoft nVision Layout Options dialog box appears.
2. Select either the Matrix Layout Sheet option or the Tabular Layout Sheet option.
3. Enter a setID, effective date, and business unit.

A setID identifies the table set you want to work with and corresponds to the set control value used in
establishing table set sharing within the PeopleSoft database.

The effective date determines which values in PeopleSoft tables are valid at the time you develop the
report. The effective date is not the same as the as of date that is entered in the report request. (The as
of date determines the current period for data retrieval.)

The business unit represents part of your corporation that is independent with regard to one or more
operational or accounting functions. PeopleSoft General Ledger business units typically comprise
individual entities for accounting purposes.

Note: The values you enter here do not determine the setID and effective date used for the reports—
runtime controls are specified on the report request. Instead, PS/nVision uses the setID and effective
date you enter here to determine the data you can select from while creating your layout.

4. Click the OK button.

The nVision Layout Definition dialog box appears prompting you to define your layout further.

Specifying a Layout Definition

You set layout options for your report using the nVision Layout Definition dialog box. The tabs at the
top of the dialog box vary depending on the type of layout you are creating. Select a tab to select layout
criteria or special nVision functionality for your worksheet.

Note: You are able to run nVision reports that include up to 16384 columns of data if your nVision
layouts are in Microsoft Excel 2007 file formats. Notice that nVision report execution time is directly
proportional to the number of columns of data returned. When you design the nVision layout, the location
of column criteria can also be set at up to column 16384. However, nVision report execution time is
dependent on the location of column criteria; for example, if the column criteria is defined at column
16384 instead of the same column criteria at the column 100, then the report execution time increase
because the used area of the worksheet increases when the criteria is defined at the farthest column.

Informational Group Boxes

A group box in the upper-left corner of the Summary tab displays information about the contents and
location of the selected cells.
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Image: PeopleSoft nVision Layout Definition dialog box: Summary tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Summary tab.

r
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Cancel

Clear All

A

M avigate
HrE

[ Retain Contents

I Confirm Changes

When no PS/nVision information is stored in the current selection, the group box appears as it does in
this dialog box. The box is titled Undefined, followed by the location of the cells selected. If you have
an entire row selected, the name of that row appears; the same applies to columns. If you have the entire
worksheet selected, the location text is Sheet Defaults.

If the current selection contains PS/nVision information, the title of the group box reflects it. Also, the
details about that information appear as the contents of the group box.

Image: Informational group box displaying PS/nVision cell contents

This example shows the informational group box displaying PS/nVision cell contents.

Surimary lSu:uuru:e] Filter l

Armaount Criternia; Calumn C
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Column: C.PRICE
Reverse Sign

Note: When you view a PS/nVision layout, you’ll notice that Row 1 and Column A are always hidden.
PS/nVision reserves them to store control information, such as data selection criteria; you cannot use Row
1 or Column A in your layout. The first available column is B, and the first available row is 2. Whenever
you open a new layout definition, the cell pointer is automatically placed at cell B2—the upperleft cell
available for use in the layout.
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Navigating Within Layouts
To move between cells and columns, use the navigate buttons in the dialog box.

For example, clicking the right arrow moves the cell pointer in Excel one cell to the right. You can select
individual cells, or you can select entire rows and columns by navigating to the uppermost and leftmost
sides of the layout. You can also select the entire worksheet by navigating to the upper-left corner of the
layout. The new cell selection appears in the informational section title.

Image: Navigate section

This is an example of the navigate section.

M avigate
12
[ Retain Contents

[v Confirm Changes

Select the Retain Contents option to preserve the currently displayed information in the informational
group box when you navigate elsewhere. You can then apply the same information to the new cells and
make only minor changes, if necessary.

Clear the Confirm Changes option to stop being prompted to save your changes each time you change
the PS/nVision information and navigate elsewhere. This can save time if you are creating a new
layout. When this option is cleared, changes you have made to the current row, column, and so on are
automatically saved when you use the arrow keys.

Dialog Box Control Buttons

OK Click this button to close the dialog box and you are able to
access the Microsoft Excel menus, or to enter text into the
worksheet manually.

Clear All Click this button to remove any existing criteria from the current
selection.

Note: If you clicked the Clear All button and you navigate

to another cell or other area of the layout, your criteria are
permanently deleted unless you click the Cancel button before
you move the cursor.

Apply This button is only available after you click the Clear All button.
Click this button to apply your changes.

Cancel Click this button to exit the sheet without clearing criteria.
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Six tabs appear at the top of most Layout Definition dialog boxes. Not all layout types require the same
information, so not all of these tabs appear with each type of layout.

Image: Example of the Layout Definition tabs

This is an example of six taps in the PeopleSoft nVision Layout Definition dialog box.

PeopleSoft nVision Layout Definition

Surnmary l Su:uur-:e] Filter ] Label ] "v"arial:ule] String ]

Using these tabs, you can specify options for your worksheet and for rows and columns. The controls on
the dialog box vary depending on whether you have a cell, row, column, or the entire worksheet selected.

Summary

Source

Filter

Label

Variable

String

Column

Options
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Displays the information about the contents and location of the
selected cell.

Enables you to select query, ledger, and TimeSpan criteria as
well as some nPlosion options.

Identifies specific detail values from PeopleSoft trees. These act
to limit query, ledger, and label criteria.

Retrieves descriptive field values from either tree nodes or detail
values. Like queries and ledgers, these criteria also perform the
role of a data source—although the data is always textual rather
than numeric.

Displays information that is specific to each report request and
report instance—for example, scope instance number, reporting
period, and other information that can change when you use a
different scope.

Enables you to build multilingual layouts. Certain text strings
are replaced by specially formatted strings whose user-language
equivalents are retrieved from a table in the database.

Enables you to map the layout columns to the appropriate query
columns. The columns contain the data that the query returns.
This tab is only available if you have selected a tabular layout.

See Mapping Tabular Layout Columns.

Enables you to select one of the Sheet Options, Row Options
and Column Options. This tab is only available if you have
selected a tabular layout.

See Defining Layout Options.
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Understanding Tabular Layouts

Tabular layouts use PeopleSoft queries to retrieve data. Unlike matrix layouts, tabular layouts do not rely
on the intersection of rows and columns to retrieve data. The columns in the report correspond to the
fields selected by the query. The rows display the entire query result set, although you can use a scope

to limit the results. By using query criteria, you can retrieve data from almost any table in a PeopleSoft
database.

When defining a tabular layout, you select a query and then select the query columns to use and the layout
columns to map them to.

See Understanding Matrix Layouts.

Creating Tabular Layouts

To create a tabular layout in PS/nVision:
1. Create a new layout by selecting nVision, New Layout from the nVision menu.

See Creating a New Layout.

2. Define the layout as a tabular layout.

3. Select nVision > Layout Definition from the nVision menu.
The Layout Options dialog box appears.

4. Select the Tabular Layout Sheet option and click the OK button.

You can also optionally select a setlD, effective date, and business unit to be used as prompts when
searching for your layouts.

The Layout Definition dialog box appears.
5. Select the Source tab to specify the query name you want to use.
6. Select a query name from the drop-down list and click the OK button.

Because you have chosen to create a tabular layout sheet, PS/nVision knows that you will be basing
this layout on a query. Therefore, the only option available in the Type drop-down list is Query.

7. Map the layout columns to query columns.

See Mapping Tabular Layout Columns.
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8. Define options for your worksheet, rows, and columns.

See Defining Layout Options.

Related Links

Creating Layouts

Mapping Tabular Layout Columns

Make sure that the layout columns are mapped to the appropriate query columns. When you run a report
based on the layout, these columns contain the data that the query returns.

Image: PeopleSoft nVision Layout Definition dialog box: Column Tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Column Tab.
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To map layout columns to query columns in PS/nVision:

1. With a nVision layout open, select nVision > Layout Definition from the nVision menu.

2. Select the Tabular Layout Sheet option from the Layout Options dialog box, and click the OK button.
3. From the Layout Definition dialog box, select a layout column to map to a query column.

Use the Navigate buttons to select a result column in the layout. The column appears as dark gray
when selected, and the column tab appears on the Layout Definition dialog box.

4. Select the Column tab that appears on the Layout Definition dialog box.
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You use this tab to map a query result column to the selected layout column.
5. Select a query result column.

The list box shows the output columns associated with the selected query. By default, the list box
displays the headings assigned to the result columns in PeopleSoft Query, and the View Heading
option is selected. To see the names of record fields associated with each result column, select the
View Record Field option.

6. Select Resize column to fit data to use the Microsoft Excel AutoFit command to adjust column width
at runtime.

This selection makes the column as wide as the defined field length when a report is run.

7. Click the Apply button to save your changes and map a different query column to a different layout
column, or click the OK button to save your changes and close the dialog box.

The name of the column you selected is inserted into the third cell of the selected column as a
temporary label. When you run a report, this label does not appear. However, you can define a row to
display column headings in the report.

If you clicked the Apply button, navigate to a new column and repeat steps 3 and 4 to map another
query result column.

Before PeopleTools release 8.48, if a query had a self-join and, therefore, had more than one column with
the same record.field name, then nVision could not distinguish between those two columns.

For example, consider the following query SQL:

Select A.EmpName, B.EmpName from EMPLOYEE A, EMPLOYEE B where A.MgrNo
= B.EmpNo

If A.EmpName and B.EmpName were mapped to two columns in a tabular layout, then the results for
A.EmpName will also be used for B.EmpName.

In PeopleTools 8.48 and later, nVision can distinguish between two columns having same record.field in
a query with a self-join. Also, the criteria string for a column in a tabular layout will now include a new
code “A<xyz>", where <xyz> represents the alias for that record as shown in the following table.

Employee Manager
%,HEmployee,REMPLOYEE,FEmpName,AA %,HManager,REMPLOYEE,FEmpName,AB
Smith, John Wilson, Dave

Patterson, William Adams, Tracie

Defining Layout Options

Use these steps to access the PeopleSoft nVision Layout Definition — Options dialog box:

1. With a nVision layout open, select nVision > Layout Definition from the nVision menu.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved. 41



Creating Tabular Layouts

42

Chapter 4

2. From the Layout Definition dialog box, select a layout column to map to a query column.

3. Select the Column tab.

The PeopleSoft nVision Layout Definition — Options dialog box appears.

Image: PeopleSoft nVision Layout Definition dialog box: Options tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:

Options tab.
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The controls available in the dialog box vary depending on whether you have a cell, row, column, or the

entire worksheet selected.

Note: If the Options tab does not appear in the PeopleSoft nVision Layout Definition dialog box, you may
have to clear a column or the worksheet.

Sheet Options

These options apply to the entire layout.

Instance Criteria

Select an option to dictate how PS/nVision applies the scope
specified in the report request. With a tabular layout, PS/nVision
implements scope by adding selection criteria to the query that
the layout uses. For each report instance, it adds a criterion that
restricts the returned values to those subsets that correspond to
the current value of the scope variables. Options include:

* Inherit All: Select to have criteria specified in the scope
definition apply to the layout. If PS/nVision does not find
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Row Options

Creating Tabular Layouts

scope definition criteria in the query’s table, it displays an
error message.

» Inherit Matching: Select to specify that only the scope
definition criteria found in the query are inherited. PS/
nVision ignores all scope definition criteria not found in the
query’s table.

* Inherit None: Select to indicate that PS/nVision should not
use the assigned scope when processing the query.

These options are available only if you have selected a layout row.

None

Heading Row

First Result Row

Total Row total row

Column Options

No special functionality is applied to the selected row. This is
the default option.

The selected row displays the heading of each query column
in the layout. If you don’t select a heading row, the layout uses
Row 3 as the heading row.

The selected row displays the first row of data returned by the
query. The rest of the data rows are inserted immediately below
this row.

Note: You must define one first result row in your layout.

The selected row can contain Excel formulas that perform
calculations on the result rows in the column. You define the
total row in position relative to the first result row; in the report
instances, the total row actually appears relative to the last data
row. For example, if you leave one blank row in the layout
between the first result row and the total row, there will be one
blank row between the end of the query data and the totals.

Note: After you select this option, you must manually enter the
Excel formulas you want in your total row.

All PS/nVision dialog boxes must be closed before you can
manually insert cell contents.

If a formula is to operate on an entire column, be sure to specify
a range starting with the first result row and ending one row
down. When reports are run, the range is expanded to include all
the inserted result rows.

These options are available only if you have selected a layout column.
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No special functionality is applied to the selected column. This
is the default.

Any Excel formula found at the intersection of the selected
column and the total row is copied to all rows in the column.
This option enables you to easily create columns that perform
calculations based on the other layout columns. For example, if
your query returns projected and actual budget data, you might
want to add a column that displays the variance.

Note: After you select this option, close the PeopleSoft nVision
Layout Definition dialog box and access the layout. Highlight
the cell at the intersection of the total row and the calculated
column and enter the Excel formula you want to use for the
column.

See Understanding Report Scopes, Defining Scopes.

Creating Report Titles

44

Because you cannot insert variables into a tabular layout, you cannot generate report titles automatically,
as you would using a matrix layout. To create a report title in a tabular layout, insert a second sheet into
your Excel workbook and create a matrix layout. Use the %RTT% variable to create the report title in the
matrix layout, and then do an intra-sheet reference in Excel; the report title appears on your tabular report.

See the Microsoft Excel documentation.
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Understanding Matrix Layouts
Typically, the PeopleSoft data you report on is in one or more large tables with lots of details—usually
ledgers. Using a PS/nVision matrix layout, you can fashion that raw data into a summarized form.

Matrix layouts have data selection criteria associated with columns and rows in the spreadsheet, creating
a criteria matrix. The data retrieved for an individual cell is determined by combining the criteria for its
column and row.

Example

To illustrate a matrix layout, assume that a table in the database appears as the following table.

Office Product Sales
CHICAGO PAPER 1,000
BOSTON SODA 2,000
BOSTON BOXES 1,200
TORONTO PAPER 1,500
VANCOUVER BOXES 5,000
COPENHAGEN PAPER 2,000
PARIS SODA 1,200
TOKYO PAPER 4,000
SINGAPORE SODA 1,000
SINGAPORE PAPER 2,000

A table like this one could become very large in a typical business—too large to tell the manager of sales
how the enterprise is doing. From this very large and detailed table, PS/nVision can build a report that
summarizes sales by region and product category, with the option to break these down into offices and
individual products.

Assuming that the company defines a tree that groups offices into a hierarchy of sales districts, countries,
and international regions, we could use that tree to define rows of a PS/nVision report, with one row for
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each region. Similarly, we could use a tree of products to put different types of products—office supplies,
consumer products, and so on—into separate columns.

The following table shows how the summarized report is displayed.

Region Beverages Office Supplies
Asia-Pacific 1,000 6,000
North America 2,000 8,700
Western Europe 1,200 2,000

Common Elements Used in This Product Documentation

Navigate buttons Use these buttons in the PeopleSoft nVision Layout Definition
dialog box to select a row, column, or cell.

Retain Contents If you clicked the Apply button in the Layout Definition dialog
box and you want to reuse all or part of the criteria you just
applied, select this option. It preserves all the dialog box
information when you navigate to a new cell selection.

Matrix Layout Components

46

To create a matrix-based report, you define intersecting criteria in the layout. For example, the Beverages
column in the example displays sales data where the product type is a beverage. The row criterion limits
the displayed data even further. The first row displays only the data for the Asia Pacific region. The
second row displays only the data for the North America region, and so on.

You can specify data selection criteria at the level of the entire spreadsheet, or at the level of a row,
column, or individual cell. Generally, you specify criteria at the highest applicable level to avoid repeating
criteria at the lower levels. If you have criteria that apply to the entire worksheet, (ledgers and TimeSpans
are common global criteria), you specify them at the worksheet level (cell A1l). If you have criteria that
apply to a row, you enter the criteria in column A for that row. You enter column criteria in Row 1 in the
applicable column, and you enter criteria that are unique to a single cell in that cell only.

Note: Cell criteria affect the efficiency of the report, so you should use them only when necessary.

nPlosion

If a field criterion uses a tree node value, nPlosion automatically adds rows or columns that contain the
detail values found under that tree node in the format you specify in your layout. This creates a group of
rows or columns that can be summarized—showing just the tree node value—or expanded to show the
detail values and the summarized values.

You can also use nPlosion to show detailed TimeSpan information.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 5 Creating Matrix Layouts

TimeSpan

A TimeSpan limits query or ledger results to those from a particular time period. Although you can use
TimeSpans in a query-based matrix layout, they are more commonly used in ledger-based layouts.

SetIDs and Business Units

PS/nVision uses the setID you specify when creating a matrix layout to determine available choices when
you define layout criteria. If the Use Business Unit in nVision option is clear, you can omit the setID, but
it is recommended that you specify one. If you enter one, it must be valid. To set the Use Business Unit in
nVision option, select PeopleTools > Utilities > Administration > PeopleTools Options.

Effective Dates

When you define a matrix layout, you must always enter an effective date. Like a setID, this controls
available values for defining criteria. For some criteria, you can override the global effective date.

Related Links
Defining Query or Ledger Criteria

Using TimeSpans
Defining nPlosion Criteria

Criteria Types
Six types of matrix-layout criteria are available:
*  Query criteria

These criteria retrieve an aggregate results column from a PeopleSoft query. The criteria act as data
sources for the selected cells.

* Ledger criteria

Using ledger criteria is an alternative to using query criteria as a data source. While you can use both
ledger and query criteria in the same layout, typically you use one or the other.

Note: You select either Query or Ledger criteria on the PeopleSoft nVision Layout Definition —
Source dialog box.

* Label criteria

These criteria retrieve descriptive field values from either tree nodes or detail values. Like queries
and ledgers, these criteria also act as data sources—although the data is always textual rather than
numeric.

¢ Filter criteria

These criteria identify specific detail values from PeopleSoft trees. They act to limit query, ledger, and
label criteria.

e Variable criteria
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Because you can generate many different report instances from one layout—using report scopes—
hard-coded text is not an effective way of labeling a layout. Using PS/nVision variables, you can
display information that is specific to each report request and report instance (for example, scope
instance number, reporting period, and so on).

String criteria

You can include strings from the PeopleTools Strings table in a matrix layout. These strings are
language-sensitive and are automatically translated into a user’s selected language when the report
runs.

There are four kinds of criteria—query, ledger, filter, and label—that you can combine with other criteria
to retrieve specific values. In fact, two of these types—filter and label—return nothing when used alone.
You must combine them with another criteria type to retrieve and display any data. You can only use the
two remaining criteria types—variable and string—alone. You can use the criteria types in the following
ways:

Query or ledger only

When you use only a query or only a ledger as criteria, the retrieved data for the specified cell is
the same as if you ran the query externally. All values for the specified column are aggregated and
displayed.

Query/ledger with field (Field selected as filter criteria)

This is the most commonly used criteria combination. It enables you to limit the values retrieved from
the data source (the query or ledger criteria). Essentially, the filter criteria act as a SQL Where clause,
limiting the data source results to the rows in which a particular field is found to have the values

you specify. You can specify more than one field or field value, in which case the cell displays the
combined value of all the query or ledger results that match the filter criteria.

Label with field

As with query and ledger criteria, filter criteria act as a SQL Where clause to limit label criteria to
specific values. You use this combination to retrieve descriptive data to identify rows or columns in a
report. If you specify more than one field value in this criteria combination, however, the results are
not combined. Instead, only one value (label) appears.

Variable only

You can only define variable criteria at the cell level—one variable per cell—and only for cells
containing no other criteria.

String only

You can only define string criteria at the cell level—one string per cell—and only for cells containing
no other criteria.

In addition to the rules defined above, criteria must not return values for an infinite number of cells. For

example, you can define query criteria alone at the cell level because the results are displayed in just one
cell. But query criteria in a column with no intersecting filter criteria would—if they were allowed to—

return cell after cell of the same value, throughout the entire column. The same situation would occur if

you defined criteria at the worksheet level and intersected them with criteria in a row or column.
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PS/nVision does not prevent you from defining your criteria in this way, but it does not return any data for
these situations. To define criteria at the worksheet level, define the intersecting criteria at the cell level,
ensuring data retrieval for a finite number of cells.

For combined criteria, valid level combinations are worksheet and cell, row and cell, column and cell, cell
and cell, and row and column.

See Understanding [.edger-Based Matrix Layouts, Defining Ledger Criteria.

Criteria Inheritance Rules

Cells specified by intersection or by single-cell criteria inherit their selection criteria according to the
following rules:

* Criteria defined at the worksheet level specify defaults for the entire worksheet. Criteria at the
worksheet level are combined with criteria for columns, rows, and cells, except where the row,
column, or cell criteria give a different value for the same criterion. In this case, the worksheet criteria
are overridden.

* For the intersection of row and column criteria, criteria are combined where possible. For example,
if a row with vendor ID filter criteria intersects with a column using query criteria, both criteria
determine the resulting cell value. But if a row and column conflict—for example, if both specify a
training location—the row overrides the column criteria.

However, there is a distinction between filter criteria (for example, Product tree nodes), and criteria
types limited to one source, such as query or ledger data source, TimeSpan, and reversal. Data source,
TimeSpan and reversal criteria follow the override rules, but filter criteria are added as you go through
the sheets, columns, and rows (but not cells). Filter criteria accumulate through this process without
regard for the fields they reference.

* A cell can inherit other criteria, such as ledger or TimeSpan, from the sheet, column, and row
levels. A cell’s individual criteria, such as a ledger, overrides anything inherited from another level.
However, because a cell might need to exclude criteria for a field, PS/nVision ignores inherited filter
criteria at the cell level.

* After the above rules have been applied to constructing a query to retrieve data for a group of rows
and columns, any instance criteria (from either a scope or the parent instance of a DrillDown) are
applied. These do not replace filter criteria from the layout; the instance criteria are added to the other
filter criteria (either sheet, column, row, or cell).
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Image: Inheritance rules for non-filter criteria

The following illustration summarizes inheritance rules for non-filter criteria.

Weakest
A Worksheet
Column Column overrides worksheet
Row overrides column
Row
v Cell overrides row
Strongest

Criteria Usage

The following tables show the usage for each criteria type at each level.

Query Criteria

This table lists the usage for the query criteria type at each level.

Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell Yes Yes Filter When used alone, filter

criteria return query
column totals. When
combined, the filter
criteria must be defined

in same cell.

Row Yes No Filter Filter criteria can be
defined in cells or

intersecting columns.

Column Yes No Filter Filter criteria can be
defined in cells or
intersecting rows.

Worksheet Yes No Filter Filter criteria can be
defined in cells only.

Ledger Criteria

This table lists the usage for the ledger criteria type at each level.
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Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell Yes Yes Filter When used alone,
ledger criteria return
ledger amount column
totals. When combined,
the filter criteria must
be defined in same cell.
Row Yes No Filter Filter criteria can be
defined in cells or
intersecting columns.
Column Yes No Filter Filter criteria can be
defined in cells or
intersecting rows.
Worksheet Yes No Filter Filter criteria can be
defined in cells only.
Label Criteria
This table lists the usage for the label criteria type at each level.
Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell No N/A N/A N/A
Row Yes No Filter Filter criteria can be
defined in cells or
intersecting columns.
Column Yes No Filter Filter criteria can be
defined in cells or
intersecting rows.
Worksheet No N/A N/A N/A

Filter Criteria

This table lists the usage for the filter criteria type at each level.
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Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell Yes No Query, Ledger, and Query/ledger criteria
Label. can be defined in same
cell, intersecting rows
or columns, or the
entire worksheet.
Label criteria can be
defined in intersecting
rows or columns.
Row Yes No Query, Ledger, and Query, ledger, and label
Label. criteria can be defined
in intersecting columns.
Column Yes No Query, Ledger, and Query, ledger, and label
Label. criteria can be defined
in intersecting rows.
Worksheet Yes N/A N/A N/A
Variable Criteria
This table lists the usage for the variable criteria type at each level.
Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell Yes Yes None Variables can only be
used alone and at the
Cell level.
Row No N/A N/A N/A
Column No N/A N/A N/A
Worksheet No N/A N/A N/A
String Criteria
This table lists the usage for the string criteria type at each level.
Level Used at this level? | Used alone? Combined with Restrictions
other criteria?
Cell Yes Yes None Strings can only be

used alone and at the
Cell level.
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Level Used at this level? | Used alone? Combined with Restrictions
other criteria?

Row No N/A N/A N/A

Column No N/A N/A N/A

Worksheet No N/A N/A N/A

Creating Matrix Layouts

To create a matrix layout in PS/nVision:

1.

2.

10.

Create a new layout by selecting nVision > New Layout from the nVision menu.
Enter a name for your layout.

It is saved as an XNV file.

Enter descriptive titles as appropriate in the rows and columns that you plan to use.

These titles are not required, but they can be helpful to mark the rows and columns for which you will
define criteria.

Select nVision > Layout Definition to display the PeopleSoft nVision Layout Options dialog box.
Define your layout as a matrix layout and define prompting options.

Click the OK button.

Open a criteria row and column by selecting nVision > Options > Show Row and Column Criteria.
Place your cursor in the cell where you want to add criteria.

Double-click the cell or select nVision > Layout Definition to display the PeopleSoft nVision Layout
Definition dialog box.

Add criteria to the layout.

The type of criteria you define determine the tabs on the PeopleSoft nVision Layout Definition dialog
box you use. Add worksheet-level criteria first. This always is cell Al.

To add row criteria, place your cursor on column A, rows 2 through xxx.
To add column criteria, place your cursor on row 1, columns B through xxx.

To add cell criteria, place your cursor anywhere within the spreadsheet that you want the result to
appear.

See Defining Matrix Layout Criteria.
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Note: As you create a matrix layout, occasionally run a report request based on the layout to ensure that
the layout will work as you expect.

Related Links

Creating Layouts

Defining Matrix Layout Criteria

54

This section provides an overview of the process of defining layout criteria. For details about
implementing different criteria types, see the sections that follow.

To define matrix layout criteria in PS/nVision:
1. With a nVision layout open, select nVision > Layout Definition from the nVision menu.
2. From the Layout Definition dialog box, select a layout column to map to a query column.
3. Select the Source tab.

In most cases, you select the Source tab first to define worksheet-level criteria (cell Al).

Define the data source and general TimeSpan for the layout. Applying criteria at the worksheet level
helps make the report run more efficiently because you do not have to restate the general criteria

in the rows, columns, or cells. You can assign any criteria at the worksheet level that you want
(including data from the Filter tab). Whatever criteria you assign in cell Al can be overridden in the
row, column, or cell criteria.

A restriction exists on returning infinite cell values. If you define query or ledger criteria at the
worksheet level, you can only display results by using cell-level intersections. Row, column, or
worksheet-level intersecting criteria are ignored.

Note: The Ledger Type option is not available if you do not use PeopleSoft Financials products.

4. Select the Filter tab.

Use the options on this tab to establish criteria based on ChartFields and to define nPlosion for the
ChartFields you selected. This tab is used for defining row, column, or cell criteria.

Note: Based on the current cell selection and layout criteria previously applied, some buttons on the
Filter tab may not be available.

5. Define nPlosion defaults.

Setting nPlosion defaults can save time when defining row and column criteria. You set these defaults
using the PeopleSoft nVision Layout Options dialog box (nVision > Layout Options).

6. Define column, row, and cell criteria—in that order.

Use the Navigate buttons to select each column, row, or cell. Then, apply criteria types by selecting
the appropriate tabs:
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* At the column level—with no previously defined criteria—use the Summary and Label tabs.

* At the row level—with no previously defined criteria—use the Summary, Source, Filter, and
Label tabs.

* At the cell level—with no previously defined criteria—use the Summary, Source, Filter, Label,
Variable, and String tabs.

By defining worksheet, column, row, and cell criteria—in that order—you define layout criteria in
ascending order of precedence. At the cell level, any criteria you enter override conflicting criteria
defined at higher levels. Therefore, if you have defined column-level query criteria and you define

a different query for a cell in that column, then the query criteria for the cell overrides the column
criteria. Remember that if you define filter criteria at the cell level, they are combined with other filter
criteria defined at higher levels.

Define other layout features.

You may want to provide additional text and Microsoft Excel formulas to the report layout. Now is
also a good time to specify the fonts and formatting that you want to apply to any report instances
based on this layout.

To enter cell information manually, you must close the PeopleSoft nVision Layout Definition dialog
box.

Save the new layout.

Click the Save button on the Microsoft Excel toolbar or select File > Save from the nVision menu to
save the layout with the name you established earlier.

Run a test report.

You should run a report request based on this layout to verify that the report layout works properly.
When you make the report request, PS/nVision should populate a report instance with data from your
PeopleSoft database.

Related Links
Specifying a Layout Definition

Creating Report Requests

Defining Query or Ledger Criteria

This section describes how to:

Select ledger criteria.

Select query criteria.

Selecting Ledger Criteria

To select ledger criteria in PS/nVision:
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1. With a nVision layout open, select nVision > Layout Definition from the nVision menu.
2. Select the Source tab on the PeopleSoft nVision Layout Definition dialog box.
3. Select Ledger from the drop-down list.
The PeopleSoft nVision Layout Definition — Source dialog box appears.
Like query criteria, you can apply ledger criteria at the worksheet, column, row, or cell level.
Image: PeopleSoft nVision Layout Definition dialog box: Source tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Source tab.

PeopleSoft n¥ision Layout Definition

Summary  SOuUCE l Filter ] Label ] Uarial:ule] String ] Ok

T¥pe || edger = Apply
Ledger Hame c |
[Budgets [BUDGETS] ~| anee

Ledger Amount Colurmn

Posted Base Currency Amount 4
Posted Total Amount Get List

Posted Tranzachon Amaount Clear All

E okl

M avigate
ﬂll
Time Spans u

rl
FER [ [ Retain Contents
| Rewverse Sign Clear [v Confirm Changes

Ledger Name Select the ledger to use.

Ledger Amount Column Click the Get List button and select an amount column from the
list.

TimeSpans Select a TimeSpan to limit the amount of information returned

in your report.

Reverse Sign Select this option to change the sign of the amounts returned
from the database.

See Understanding [.edger-Based Matrix Layouts, Defining Ledger Criteria.

56 Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 5 Creating Matrix Layouts

Choosing Query Criteria

You use a query created with PeopleSoft Query to specify data to be returned to the matrix. Query criteria
specify both a query and a query column. You can select only columns that are the result of a SQL
aggregate function, such as Sum or Count.

Note: The aggregate function must return a numeric value for nVision to process this value properly.

Image: PeopleSoft nVision Layout Definition dialog box: Source tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Source tab.
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[ Reverse Sign Clear [v Confirn Changes

To define query criteria in PS/nVision:
1. With a nVision layout open, select nVision > Layout Definition from the nVision menu.

2. From the PeopleSoft nVision Layout Definition dialog box, select the row, column, or cell that you
want to apply query criteria.

3. Click the Source tab to view the query criteria options.

The Source tab of the PeopleSoft nVision Layout Definition dialog box appears. Use it to specify the
aggregate query column that you want to use as a data source.

4. Select the Query option from the Type drop-down list box.
You can also select the None option.
5. Specify the query name and click the Get List button.

A list of aggregate columns appear in the Query Result Column drop-down list box.
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6. Select an aggregate column from the list.
If the query does not contain any aggregate columns, there is (no entries) in the drop-down list box.
An aggregate query column is either:
* A data column with an aggregate function (such as Sum or Count).

* An expression containing an aggregate function, with the Aggregate option selected.

7. Optionally, select a TimeSpan to limit the query data.

8. To have columns or rows containing TimeSpan details automatically inserted, select nPlode Time
Spans.

9. To reverse the sign of the amounts returned from the database, select the Reverse Sign button.

For example, you might want to see revenue reported as a positive number. This value is normally set
for query criteria at the cell, row, or column level rather than at the worksheet level.

10. Click the Apply button to save your changes and define query criteria for a different group of cells, or
click the OK button to save your changes and close the dialog box.

Related Links
Using TimeSpans

"Working with Aggregate Functions" (PeopleTools 8.56: Query)

Applying Filter Criteria

This section provides an overview of filter criteria and discusses how to:
* Select filter criteria options.

* Add field and tree node values to filter criteria.

* Add field and detail values to filter criteria.

* Add criteria values.

* Remove fields and values from criteria.

Understanding Filter Criteria

58

Filter criteria comprise field or dimension criteria combined with query or ledger criteria. They display
a value from the query column results. You can combine filter criteria with label criteria to display a
tree node or detail value as a descriptive label. Using nPlosion, one row or column of filter criteria can
generate multiple detail rows or columns.

You can apply filter criteria at the column, row, or cell level.

Filter criteria consist of one or more tree detail values. If you select more than one value for your filter
criteria, the total of all specified values is used to limit intersecting query or ledger criteria, and the results
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appear as one consolidated value. However, where multi-value filter criteria intersect with label criteria,
the label values cannot be combined. Only the first label retrieved appears.

You can accept tree effective date when you define criteria. This option enables you to have multiple
trees in the layout with different effective dates, and you can compare the results of the reports based on
different effective dates. In addition, when you run a report request, you can specify a new effective date
that overrides effective date of all trees if effective date was specified in the layout.

Note: Accept tree effective date at the time of criteria definition is available only in nVision windows
client.

When defining filter criteria, you can use detail values summarized under particular tree nodes, or detail
values from value tables. If a value table is entered in filter criteria, it will be used for prompting and
nPlosion labeling. During nPlosion, if some field values do not exist in the value table or if nVision
cannot find corresponding labels in the value table for some field values, nVision will not include the
amount for those values in the nPloded result.

Note: If the value table specified for nPloded labels has an incomplete set of values, the total may differ
from a non-nPloded total.

Related Links
Using DrillDown
Creating Report Requests

Selecting Filter Criteria Options

Use the PeopleSoft nVision Filter Criteria dialog box to add, modify, and delete the nodes from the
criteria.

In addition, you can use this dialog box to include fields that build negative criteria; for example, to select
nodes for Not In Criteria of the query. With this feature, you can select multiple values, tree nodes, and
dimensions as part of Not In criteria query. After making a list of values to be part of the Select clause
with Not-In Criteria, this criterion is inserted as any other criteria into the selected cell of the layout.

To define filter criteria in Windows client:
1. Open nVision client by selecting Start > Program > nVision.
2. Open any existing layout or create a new one.

3. If you create a new layout, select the Matrix Layout Sheet option, define required values, and click the
OK button.

4. Select nVision > Layout Definition from the menu.
The PeopleSoft nVision Layout Definition dialog box appears.
5. Select the Filter tab, and click the Add button.

The PeopleSoft nVision Filter Criteria dialog box appears.

Note: The PeopleSoft nVision Filter Criteria dialog box can only be opened in nVision's Windows client.
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Image: PeopleSoft nVision Layout Definition - Filter dialog box

Chapter 5

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition - Filter dialog

box.
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Image: PeopleSoft nVision Filter Criteria dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Filter Criteria dialog box, which
enables you to select the fields and field values to use as filter criteria.

r

N
PeopleSoft n¥ision Filter Criteria E|

* Field 0K

.
£ | J Cancel

Filter Options

f* Selected Tree Modes
" Selected Detail % alues
£ Al Detail ¥ alues

| Business Unit Keyed Tree

Tree
Tree/Hierarchy: | 2 |
Az of Date: |
Field The text box to the right of the Field option displays the field
that will be used as criteria. It displays value for only one field
at a time—whichever field is selected in the upper text box.
You add fields to this list by clicking the Search (?) button and
selecting field names. To select from a list of fields, type in a
partial name before clicking the Search button.
Filter Options Use the Filter Options section to specify the source of the field

values that you want to add to the filter criteria: Selected Tree
Nodes, Selected Detail Values, or All Detail Values.

If your database contains ledgers, the Selected Summary
ChartField Nodes option appears. If the Selected Summary
ChartField Nodes option is selected, the Tree fields appear
prompting you to select a tree from which you select node
values to use as criteria. You can select any tree that uses the
specified field for its node values and is defined for the setID
and effective date associated with the layout.
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Business Unit Keyed Tree

Tree/Hierarchy

As of Date

Related Links
Using Filter Criteria

Using Summary ChartField Nodes

Multiple Scope Fields
Creating Requests

Chapter 5

Select this option if your criteria is based on a business unit
keyed tree.

Displays the name of the tree.

Note: In a dynamic detail tree structure, the field name of the
detail values should match the field name of the tree nodes.
If these two field names do not match, then an error message
appears indicating that the tree is invalid.

Optionally, enter the As of Date values for the tree.

If the As of Date value is earlier than the effective date of the
tree or is invalid, an error message appears when you save the
criteria.

Adding Field and Tree Node Values to Filter Criteria

To access the PeopleSoft nVision Tree Nodes dialog box:

62

1. Open nVision client.

2. Open any existing layout or create a new one.

3. Ifyou create a new layout, select the Matrix Layout Sheet option, define required values, and click the

OK button.

4. Select nVision > Layout Definition from the menu.

The PeopleSoft nVision Layout Definition dialog box appears.

5. Select the Filter tab, and click the Add button.

The PeopleSoft nVision Filter Criteria dialog box appears.

6. Click the OK button.

The PeopleSoft nVision Tree Nodes dialog box appears.
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Image: PeopleSoft nVision Tree Nodes dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Tree Nodes dialog box.
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To add a field and tree node values to filter criteria in PS/nVision:

L.

2.

Open any existing layout or create a new one.

Select nVision > Layout Definition from the menu.
Select the Filter tab, and click the Add button.

The PeopleSoft nVision Filter Criteria dialog box appears.

In the PeopleSoft nVision Filter Criteria dialog box, click the prompt button to the right of the Field
option.

Select a field name and click the OK button.

Enter a partial tree name in the Tree/Hierarchy field and click the prompt button.

Select a tree and click the OK button.

The Tree Nodes dialog box appears.

If you know the exact node you want to add, enter it in the Tree Node field and click the OK button.

The Tree Nodes dialog box closes and you are returned to the PeopleSoft nVision Layout Definition —
Filter Criteria dialog box, which has an added node in the list box.

Optionally, apply a node list filter.

To limit node choices to a particular level, select a valid tree level.
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To limit node choices to a particular tree branch, enter the tree node at the top of the branch.
10. Display the node list.

To see an alphabetical list of the tree nodes, click the By Name button. Use this button if you have
specified a tree level. If you have also specified a tree node, it must be a valid node in the level or no
nodes will appear in the list.

To see the hierarchical node structure of the tree—similar to what you would see in Tree Manager—
click the By Position button. Use this button if you have specified a tree node. If you also specified a
tree level, it is ignored.

Note: You can use the two list filtering buttons together to help you find the nodes you want. For
example, you might first want to see nodes at a particular tree level, in alphabetical order, using the
By Name button to find the higher-level node that you want. Then, you can specify that tree node and
click the By Position button to see the portion of the tree headed by that node.

11. Highlight the nodes you want to add.
12. Click the OK button to add the highlighted nodes.

The Tree Nodes dialog box closes. You can now see the new node values listed in the tree control list
box of the PeopleSoft nVision Layout Definition — Filter dialog box.

Adding Field and Detail Values to Filter Criteria

64

Image: PeopleSoft nVision Criteria Values dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Criteria Values dialog box.
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To add a field and detail values to filter criteria in PS/nVision:
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I1.

12.

13.

14.

Creating Matrix Layouts

Open any existing layout or create a new one.

Select nVision > Layout Definition from the menu.

Select the Filter tab, and click the Add button.

The PeopleSoft nVision Filter Criteria dialog box appears.
Enter a field name.

Select either the Selected Detail Values option or the A/l Detail Values option.

Note: If the field is a DrillDown child layout, you can select all detail values from a tree node. The All
Detail Values option is used primarily with nPlosion and DrillDown features.

If you selected the All Detail Values option, enter a values table name.
Click the OK button.

If you selected the A/l Detail Values option, the Field Name dialog box closes and the PeopleSoft
nVision Layout Definitions — Filter dialog box appears again. You can skip the rest of this procedure
if you do not need to add specific values and you are using all of them.

If you select the Selected Detail Values option, the PeopleSoft nVision Criteria Values dialog box
appears. You use this dialog box to specify the tree detail values you want to add to your filter criteria.

In the Qualifiers group box of the PeopleSoft nVision Criteria Values dialog box, specify a values
table.

Optionally, enter a new effective date.
The default effective date is the value you specified when creating the layout definition.
Select the values to add.

If you know the value you want, enter it in the Enter Individual Value field and click the OK button.
Otherwise, use the prompt button to display a list of detail values from the Values Table that you
specified. You can select multiple values before clicking the Add to List button.

Select the Blank Value option—with the Enter Individual Value field empty—to include a null value.
Click the Add to List button.

Clicking the Add to List button adds a null value to the list, represented graphically by (None) in the
Current Value List text box. The null value appears at the top of the list in the list box, but the actual
null value is inserted at the bottom of the list on the PeopleSoft nVision Layout Definition — Filter
dialog box.

You can change the order of a value by using the order selection controls on the PeopleSoft nVision
Layout Definition — Filter dialog box.

Click the OK button to save your changes and to close the PeopleSoft nVision Criteria Values dialog
box.

Click the OK button again to close the PeopleSoft nVision Layout Definition dialog box.
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See Using DrillDown, Using DrillDown Navigation, Using DrillDown Layout Formats.

Adding Criteria Values

To add criteria values in PS/nVision:

1.

2.

Open any existing layout or create a new one.

Select nVision > Layout Definition from the menu.

Select the Filter tab, and click the Add button.

On the PeopleSoft nVision Filter Criteria dialog box, select a specified field.

If you have not specified any fields, you must do so now. During that procedure, you are prompted to
add criteria values.

Click the Add button.

At the new dialog box, add your values.

Removing Fields and Values from Filter Criteria

In PS/nVision, to remove a field and its values from filter criteria:

1.

2.

3.

4.

5.

Open any existing layout or create a new one.

Select nVision > Layout Definition from the menu.

Select the Filter tab, and click the Add button.

On the PeopleSoft nVision Filter Criteria dialog box, select the field to remove.

Click the Delete button.

In PS/nVision, to remove a field value from filter criteria:

1.

2.

Open any existing layout or create a new one.

Select nVision > Layout Definition from the menu.

Select the Filter tab, and click the Add button.

On the PeopleSoft nVision Filter Criteria dialog box, select the field value you want to remove.

Click the Delete button.

Using Label Criteria

66

You can use label criteria to add descriptive information that corresponds to filter criteria you have
defined in the rows and columns of the layout. When you define label criteria, you specify a tree node
name or a detail value as the label source. PS/nVision uses this information to generate row and column
labels automatically at runtime from detail or tree node records in the database. When you run the report,
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the rows and columns appear with their labels. Report labels are particularly useful with nPloded rows
and columns, because these are generated by PS/nVision, and you do not have a chance to label them
yourself.

You can define label criteria at the row or column level. You cannot define them in any row or column
that already contains other criteria types. To label filter criteria entered in the rows of the layout, specify
the label criteria in an intersecting column; if you are labeling filter criteria columns, put the label criteria
in a row.

Image: PeopleSoft nVision Layout Definition dialog box: Label tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Label tab.
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To define label criteria in PS/nVision:
1. Open any existing layout or create a new one.
2. Select nVision > Layout Definition from the menu.

3. In the PeopleSoft nVision Layout Definition dialog box, select the row or column to which you want
to apply label criteria.

4. Select the Label tab.
5. Use the Retrieve Label group box to specify where you want the label to be retrieved from.

If you are labeling filter criteria that are based on detail table values, use the Field on Detail Value
Table field to specify a label source. You should also use this field if you want to label the nPloded
rows or columns of node-based filter criteria. Enter either the field name itself or a descriptive field
from the detail value table, which is defined in the tree structure.
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Note: If you are using fiscal year TimeSpans, you can also specify a special label for nPloded
TimeSpans by entering ACCOUNTING PERIOD in the Field on Detail Value Table field.

If you are labeling filter criteria based on tree node values, use the Field on Tree Node Table field to
specify a label source. For detail or summary tree node values, enter either TREE NODE or DESCR,
as these are the only descriptive fields on the TREE NODE TBL (as delivered).

For node-oriented trees, enter either the field name itself or another descriptive field from the table
that supplies the node values, as defined in the tree structure. For example, for filter criteria based on
nodes in the DEPT _SECURITY tree, you might use DEPTID, DESCR, or SHORTDESCR.

Select your runtime options.

The Runtime Options group box is not visible until you enter a field name in the Retrieve Label group
box.

If you select the Put labels in blank cells only option, the labels will not overwrite any text, PS/
nVision variable, or strings that you have inserted in the layout.

If you have selected a column, you can also select the Resize column for labels option. This value
automatically applies the Excel AutoFit command to the column at runtime, which makes the column
as wide as the widest label.

Click the Apply button to save your changes and define label criteria for a different row or column.

Alternatively, click the OK button to save your changes and close the dialog box.

Related Links
"Understanding Types of Trees" (PeopleTools 8.56: Tree Manager)

Adding Variable Criteria

This section provides an overview of variable criteria and explains how to define the criteria.

Understanding Variable Criteria

68

You insert PS/nVision variables into the layout to display heading information that might change from
report to report, or between report runs. For example, you could use a variable to automatically insert
the report ID you specify in the Report Request dialog box, so you do not restrict this layout to a single
purpose. Remember that your layout may be used with a scope that changes its contents, which could
make a hard-coded title misleading.

You can define variable criteria at the cell level only—one variable per cell—and the variable must be the
only element in that cell.

Note: Besides using PS/nVision variables in your layouts, you can use some of these variables in the
Instance Controls section of the PeopleSoft nVision Report Request dialog box.
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When inserting a variable into a cell, you select it from the Variable tab of the PeopleSoft nVision Layout
Definition dialog box. Because there are many different variables to select from, the dialog box displays

them by category. Tables describing the variables in each category follow.

Note: When you select a variable, you select its three-letter code. However, when a variable is used in
a layout or report request, its code must be enclosed within percent signs (for example, %RID%). The
following tables omit the percent signs.

Report Request Variables

The Report Request dialog box defines most of the values that are returned by using the variables in the

following table.

Variable

Returned Value

Sample Value

Remarks

DTS

Detail or Summary (nPlosion
enabled or disabled)

Defined in the Report Request
dialog box: S=Summary
(nPlosion disabled)D=Detail
(nPlosion enabled).

ICT

Instance Counter

Starts at 1 and is increased
by increments of 1 for each
additional instance.

IDN

Instance Directory Name

CAUSER\NVISION
\INSTANCE

Full path.

The Directory Template field
defines the full path in the
Report Request dialog box.

IFN

Instance Output File Name

<Various>.XLS

The File Template field
defines the path in the Report
Request dialog box. The .XLS
extension is included.

LAN

Language Template

ENG

Defined in the Report Request
dialog box.

LYN

Layout Name

<Various>

Defined in the Report Request
dialog box. (Does not include
the . XNV extension.)

OPC

User Class

ALLPANLS

Provided by the PeopleSoft
security tables.

OPL

User Language

ENG

Provided by the PeopleSoft
security tables.

OPR

User ID

WPS004

Provided by the PeopleSoft

security tables.
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Variable Returned Value Sample Value Remarks

RID Report Name <Various> Defined in the Report Request
dialog box.

RBK Report Book Name N/A N/A

RTT Report Title <Various> Defined in the Report Request
dialog box.

Date and Time Period Variables

This table lists the values that enable you to label layouts where different accounting periods are reported

in each instance.

Variable Name Sample Value Remarks

APA Period Abbreviation DEC N/A

APN Period Name December N/A

ASD As of Reporting Date 2003-12-31 Defined in the Report Request
dialog box.

AST As of Tree Date 2004-01-01 Defined in the Report Request
dialog box.

FY2 Year (YY) 04 N/A

FY4 Year (YYYY) 2004 N/A

PED End Date of Current Period 2004-12-31 N/A

PER Accounting Period 12 N/A

Scope-Related Variables

The following table lists the values that enable you to label layouts for which you have defined a report
scope. A scope is used to define multiple instances of a report based on different field values. For
example, you could produce an instance of an expense report for each department, or an operations
summary for each business unit.

Variable Name Sample Value Remarks

BUV Business Unit Name MO04 Defined in the Report Request
dialog box.

BUN Business Unit Description US1 Manufacturing N/A

70
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Variable Name Sample Value Remarks

SCN Scope Name DEPARTMENT N/A

SCD Scope Description Sales Departments N/A

SFN Scope Field Name DEPTID N/A

SFV Scope Field Value FINDEVELOP N/A

SFD Scope Field Description Financial Development N/A

STN Scope Tree Name FUNCROLLUP N/A

STD Scope Tree Description Functional Organization N/A

SLN Scope Tree Level Name DIVISION N/A

SLD Scope Tree Level Description | Instances for each division N/A

DES Scope Descriptive Field FINDEVELOP A user-defined variable
that retrieves descriptive
information from a field in
either the detail value table or
the tree node table.

Related Links
Understanding Report Scopes

Defining Scopes
Creating Requests
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Image: PeopleSoft nVision Layout Definition dialog box: Variable tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Variable tab.

PeopleSoft nYision Layout Definition

Summar_l,ll Su:uuru:e] Filter ] Label “ariable l Shring ] Q.

Cateqarny Apply
* Report Request

" Date and Time Periods Cancel
" Scope-Felated

W ariables:

RID - Report Hame A

RTT - Report Title

LM - Layout Mame

RBU - Requesting Bu M avigate

RBM - Requesting BLI .
+

Clear All

ek

OPR - Operator 1D

OFC - Operator Clazs nun

OPL - Operatar Langl
DTS - Detail or Surmm ™

[ Retain Contents

ﬁ [+ Confirm Changes

To define variable criteria in nVision:

Open any existing layout or create a new one.
Select nVision > Layout Definition from the menu.

In the PeopleSoft nVision Layout Definition dialog box, select the cell to which you want to apply
variable criteria.

Select the Variable tab.
Select the appropriate category, and then select a variable.
If you selected one of the Date and Time Periods variables, specify a ledger.

When you select the Date and Time Periods option and you click a variable in the Variables list, the
Ledger field appears.

If you selected one of the Scope-Related variables, fill in the Scope Field field, if necessary.

When you select any Scope Related variable except SCN or SCD, the Scope Field text box appears to
the right of the Variables field.

If the layout uses a scope that has multiple fields, use the Scope Field option to specify the scope
field on which to base the variable you want to insert. For example, if you defined a scope using the
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Department and Product fields, and wanted a descriptive field from the Department table to appear on
your report, you would enter DEPTID as the scope field.

Note: If you do not specify a scope field, the default value is the first field defined in the scope.

8. Ifyou selected the DES variable, indicate where to retrieve the descriptive information.

The Descriptive Field (DES) variable is user-defined and retrieves text information from either the
tree node table or detail value table associated with a field in the scope. For example, if your scope

is based on DEPTID, and creates an instance for each tree node at the Division level, you can use
variables to identify each instance with the division name and related information from the tree node.

Use the Field on Detail Value Table field to retrieve descriptive information from any text field on
the detail values table that is associated with the scope field. For example, if you were generating
instances of a report using a scope based on detail values of the Department field, you could enter the
name of any descriptive field, such as the Manager Name field, on the Department table, and the text
contained in that field would appear on each department’s instance of the report.

Use the Field on Tree Node Table field to retrieve descriptive information from any text field on the
tree node table (usually named TREE NODE TBL) when using a tree-based scope. For example,
if you added a field for the manager responsible for each node in your tree, you could retrieve this
information by specifying the field name, such as Mgr Name, from the tree node table.

9. Click the Apply button to save your changes and define filter criteria for a different cell.

Alternatively, click the OK button to save your changes and close the dialog box.

Defining String Criteria

Layouts typically contain a considerable amount of constant text, such as the column headings “Last
Year to Date” or “Current Budget.” With PS/nVision, you can build multilingual layouts where these text
strings are replaced by specially formatted strings whose user-language equivalent is retrieved from a
table in the database. These string names are somewhat like user-defined PS/nVision variables.

You insert string criteria into layout cells with the following format:

% .<name>, R<program>$%

Name is the string name as described in the following table and program is the program ID group that
contains the string definition. In this example

%.STDHDG_PAGE NO, RSTDHDGTRS
the string name is STDHDG_PAGE_NO and the program ID is STDHDGTR.

When you select a string to insert, you can select from strings created specifically for use with PS/nVision
—that is, strings with a program ID of NVISION. If you insert one of these strings, the program name
does not appear in the string. For example:

%.DATE LABELS
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Image: PeopleSoft nVision Layout Definition dialog box: String tab

Chapter 5

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:

String tab.

=

PeopleSoft n¥ision Layout Definition

5ummar_l,l] Snurce] Filter ] Label ] Varable Shing l
v nizion Only String Apply |
Pragran Id: Cancel |
String Id:
| d
String % alue Bkl
[Mone] M avigate

52
[ Retain Contents

ﬁ v Confirm Changes

To define string criteria in PS/nVision:
1. Open any existing layout or create a new one.

2. Select nVision > Layout Definition from the menu.

3. On the PeopleSoft nVision Layout Definition dialog box, select the cell to which you want to apply

string criteria.
4. Select the String tab.

5. Clear the nVision Only String option if appropriate.

By default, the String tab displays only strings that were created for use with PS/nVision—those with

a program ID of NVISION.

To select from all available strings, clear the nVision Only String option.
6. Ifthe nVision Only String option is cleared, select a program ID.
7. Select the String ID of the string you want to insert.

You can select from the strings assigned to the program ID that you specified.

Note: If the nVision Only String option is selected, the program ID is NVISION.

8. Click the Apply button to save your changes and define string criteria for a different cell.
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Alternatively, click the OK button to save your changes and close the dialog box.
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Understanding Ledger-Based Matrix Layouts

A ledger is a special type of query in PS/nVision, with an implied aggregate operation (sum) and record
and field names specified through the ledger definition. In PS/nVision, a ledger-based layout is essentially
a matrix layout that uses the ledger table in place of a query. Typically, you use ledger-based layouts with
applications such as PeopleSoft General Ledger or Enterprise Performance Management. Although you
can use ledgers and queries in the same report, ledger and query specifications are mutually exclusive for
a row or column, because a row, column, or cell can have only one data source.

These topics discuss the differences between ledger-based layouts and reports and query-based matrix
layouts.

Related Links
Understanding Matrix Layouts

Creating Matrix Layouts

Defining Ledger Criteria

When you define ledger criteria, you can select the same options as with query-based matrix layouts. As
with query criteria, you can apply ledger criteria at the worksheet, column, row, or cell level.
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Image: PeopleSoft nVision Layout Definition dialog box: Source tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Definition dialog box:
Source tab.
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To define ledger criteria in PS/nVision:

1.

2.

Open any existing layout or create a new one.
Select nVision > Layout Definition from the menu.

In the PeopleSoft nVision Layout Definition dialog box, select the row, column, or cell that apply
ledger criteria.

Use the Navigate controls to select the location.
Select the Source tab, and then select Ledger as the source type.
Select a ledger from the Ledger Name drop-down list box.

Select a ledger amount column by clicking the Get List button and clicking the available columns that
appear.

Select a TimeSpan to limit the ledger data.

To have columns or rows containing TimeSpan details automatically inserted, select the nPlode Time
Spans option.

The nPlode Time Spans option appears only if you have a row or column selected.

To reverse the sign of the amounts returned from the database, select the Reverse Sign option.
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For example, you may want to see revenue reported as a positive number. This setting is normally
selected for query criteria at the cell, row, or column level, not the worksheet level.

10. In the Ledger Amount Column field, select the ledger amount to report on.

Note: If the ledger contains separate credit and debit columns, they appear in the Ledger Amount
Column field.

11. Click the Apply button to save your changes and define ledger criteria for a different group of cells.
Alternatively, click the OK button to save your changes and close the dialog box.

If you clicked the Apply button and you want to reuse all or part of the criteria you just applied, select
the Retain Contents option. This selection preserves the dialog box information when you navigate to
a new cell selection. Then, repeat the procedure to define more ledger criteria.

Using TimeSpans

Copyright

TimeSpans express fiscal-year and accounting-period ranges relative to the main as-of date specified in
the report request. TimeSpans control the periods for which data is extracted from the database. Many
TimeSpans are expressed relative to the current period, so that they automatically adapt the content of a
report to the report as-of date. TimeSpans are required when you use ledgers, but they are optional with
queries.

An example of using TimeSpans is an earnings summary report that compares earnings from the end

of 2000 to the end of 2001, broken down by four quarters. Revenue from operations and net earnings
are listed down the left side of the report, while quarterly earnings appear across the top of the report

as column headings. You select the appropriate QTR TimeSpan for each quarter at the column level.
Then, you specify the Accounts ledger in the criteria for the entire spreadsheet. For the rows, specify the
individual accounts whose earnings you want to report on.

Relative Adjustment Periods

Use the following example to specify the Relative Adjustment Period. To retrieve x number of periods
back:

"BaseAdjustmentPeriod - x"
where BaseAdjustmentPeriod = (FirstAdjustmentPeriod - 1).

For example, FirstAdjustmentPeriod = 901 (for period 1). BaseAdjustmentPeriod = 900. To specify the
last two adjustment periods, Relative StartAdjustmentPeriod should be 898.

To retrieve x number of periods ahead:

"BaseAdjustmentPeriod + x".

Using the example above, to retrieve two periods ahead, define Relative EndAdjustmentPeriod as 900 + 2
=902.
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Using Filter Criteria

As with other matrix layouts, you use filter criteria to specify the character field values (such as
ACCOUNT) selected for rows and columns of the report.

As in query-based layouts, filter criteria can be expressed in terms of detail values or tree nodes, and can
be nPloded to generate multiple detail rows or columns. However, with ledger-based layouts, filter criteria
also can be expressed as summary ChartField nodes.

Using Summary ChartField Nodes

When defining filter criteria for a database containing ledgers, you can use summary ChartField nodes as
criteria values. This use of summary ChartField nodes retrieves data from a summary ledger ChartField
that contains tree nodes as values. Detail ledger ChartFields serve as keys to the detail ledger by
categorizing posted total amounts. You can create summary ledgers that roll up detail amounts based on
specific detail values or on selected tree nodes. When detail values are summarized using tree nodes, you
must use summary ChartFields in the summary ledger data record. The maximum length of a node name
is 20 characters.

For example, values contained in a Department ChartField (such as DEPTID 0100, 0200, 0300, and
so forth) on a detail ledger can be rolled up (using an organizational tree) into a Division ChartField
on a summary ledger. You can store these values with summary ChartField node names such as Sales,
Marketing, and Administration.

You can use summary trees or summary ChartField nodes to access data from a summary ledger of this
type. You should use summary trees because then you can create different rollups of the summarized
nodes and use nPlosion on them. When you drill down, summary trees also let you translate summary
criteria to the corresponding detail criteria back in the general ledger. When specifying criteria via a
summary tree, click the Selected Tree Nodes option in conjunction with the summary ChartField.

Note: PS/nVision does not support the translation of summary ChartField nodes when you are drilling
down to the detail ledger. Use the summary tree criteria.

To add a field and summary ChartField node values to filter criteria in PS/nVision:
1. Follow the procedure for adding tree node values.

See Using Filter Criteria.

2. From the Field Name dialog box, select the Selected Summary ChartField Nodes option.

Adding Label Criteria

80

Label controls are available on ledger-based layouts, just as they are on any matrix layout.

If you are basing the layout on a ledger, you can retrieve label text from a number of fields defined in
Application Designer for the detail or tree node table of a ChartField. You can also specify a special label
for nPloded TimeSpans in the format YYYY-PP (year-period) by entering ACCOUNTING PERIOD in
the Detail Values field.
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Using nPlosion

For PeopleSoft General Ledger, note that nPlosion is available for detail ledger ChartFields or summary
ledger ChartFields that contain detail values, and for summary ledger ChartFields accessed through
summary trees. nPlosion is not available for summary ledger ChartFields specified as Selected Summary
ChartField Nodes. For other applications, nPlosion is available for criteria fields that have value tables
listing the valid values of the field (usually, this is the prompt table for that field).

Related Links

Understanding nPlosion
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Understanding Report Scopes

A report scope enables you to create multiple instances of a report using a single report layout and report
request. Using a scope, each report instance contains data specific to an individual field value, such

as a business unit or department, or to a group of values, such as a tree node that summarizes all sales
departments. In this way, each report instance can share the same layout, while containing data unique

to these field values. You might run three instances of an expense report that share the same layout but
contain the expenses of one division each.

When defining a report request, you can use the scope feature to create multiple instances of a report from
a single request.

You can specify more than one field in the scope to create instances that represent combinations of values
of multiple fields. For example, you can use a multifield scope to create an instance for each product line
(a grouping of products) within each region (a grouping of departments).

Whenever you use scope to produce multiple instances of a report, use PS/nVision variables in the layout
headings to identify the content of each report.

Related Links
Adding Variable Criteria

Multiple Scope Fields

When you define a new scope, you must determine how many instances to produce and how each
instance is summarized.

If your scope is based on two or more fields (such as business unit and product), PS/nVision normally
produces a report instance for each combination of the selected nodes or detail values for all specified
fields. However, you might have data for only a subset of these combinations—for example, if each
business unit sells only a subset of the total list of products. You could limit the number of report
instances produced by defining multiple scopes, specifying only the valid combinations, and using
different report requests to apply these scopes to appropriate layouts. But if you are working with many
combinations, a better solution is to create a field combination table containing only the field value
combinations you want for your scope. If you specify a field combination table, PS/nVision generates an
instance of the report for only those field values that are listed as valid combinations on the table.

You create a field combination table in Application Designer just as you would create any other custom
table. After creating the table with the combinations of fields to use, you point to that table from the Field
Combination Table field in the PeopleSoft nVision Scope Definition dialog box.
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You can also create a dynamic record that is populated by a query and includes only the combinations of
field values that actually have data for that reporting period. This eliminates printing blank pages (report
instances) when you have fields that have no data for a particular reporting period.

Note: When you create a combination table, you need only include the scope fields whose values you
want to limit, but you can also include SETID and EFFDT. You can populate the table using a SQL tool
as well, but a better option might be to create a simple page to update the table.

If you specify field values using tree nodes, PS/nVision uses the combination table to determine whether
the underlying details are valid before producing an instance for a tree node. For example, if an instance
is requested for each product and division (a rollup of departments on an organization tree), PS/nVision
determines whether any departments in each division are valid in combination with a particular product.
In this case, the combination table should contain a DEPTID and PRODUCT field, with each row
containing the valid department/product combinations.

Using Business Unit Keyed Trees

You can define report scopes using business unit keyed trees by adding a valid business unit to the scope
definition. You must still enter a setld as the key field for the scope, and the business unit you enter is
used for selecting business unit keyed trees. At the field level, you must select the BU Keyed Tree option
to limit the tree selection list to those trees keyed by the business unit entered.

At runtime, the requesting business unit is used as a replacement for the business unit that you entered
when defining the scope. Therefore, if you define a tree with the same name for multiple business units,
you can use the same scope for each version.

Defining Scopes

This section discusses how to:
* Create new scopes.
*  Select scope fields.

¢ Select tree levels and tree nodes.

Creating New Scopes

Access the PeopleSoft nVision Scope Definition dialog box by selecting nVision > Scope Definition from
the nVision menu.
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Image: PeopleSoft nVision Scope Definition dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Scope Definition dialog box.
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To define a new scope in PS/nVision:
1. Select nVision > Scope Definition from the nVision menu.
2. Click theNew button.
3. Enter a scope name and a description.
You may use up to 10 characters for the scope name and up to 30 characters for the scope description.
4. Enter the setID for this scope.
5. If you are defining your scope using business unit keyed trees, enter the business unit.

6. Ifyou are using multiple scope fields, enter the appropriate tables in the Field Combination Table
field.

7. Add fields to the scope definition by clicking the Add button.

The PeopleSoft nVision Scope Field dialog box appears.
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Selecting Scope Fields
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Image: PeopleSoft nVision Scope Field dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Scope Field dialog box.
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For each field that you add to a scope, you specify the source of the field values and the values to use.
This process is similar to defining field criteria in a matrix layout.

Each of the options in the PeopleSoft nVision Scope Field dialog box selects a different set of these values
for building your scope:

* Tree Node (Summary) Instances: Selected Tree Nodes, Children at a Level, All Nodes at Selected
Levels.

e Used with Summary Ledgers only: Selected Summary ChartField Nodes.
* Detail Value (Detail) Instances: Detail of Selected Parents, Selected Detail Values, All Detail Values.
Field Enter a field to add to your scope.

Selected Tree Nodes Select this option to create an instance for each tree node that
you select. When you type the field name, you are prompted to
enter a tree name and level.

Children at a Level Select this option to create an instance for each tree node at a
specified tree level that is a child of the parent node. The parent
nodes need not be the immediate parent of nodes at the specified
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All Nodes at Selected Levels

Selected Summary ChartField Nodes

Detail of Selected Parents

Selected Detail Values

All Detail Values

Effective Date

BU Keyed Tree

Tree Name

Related Links

Defining Report Scopes

level. When you type the field name, you are prompted to
specify a tree name and level.

Select this option to create an instance for every node at each
selected level. When you type the field name, you are prompted
to specify a tree name and level.

Select this option to create an instance for every specified node
in a tree used to create a summary ledger. (This option applies
only to users of PeopleSoft General Ledger.) You should use
summary trees rather than the summary ChartField nodes.

When detail values are summarized into tree nodes, you must
use a different ChartField in the summary ledger data record
to accommodate the maximum length of a node name (20
characters). When you type a field name, you are prompted to
specify a tree name and level.

Select this option to create an instance for each detail value
associated with the specified tree nodes.

Select this option to create an instance for each detail value that
you specify. This option activates the Value Table field, where
you can specify the table that contains the values that you want
to select.

Select this option to create an instance for all detail values. This
option activates the Value Table field, where you can specify the
table that contains the values that you want to use.

Enter a date to determine the trees you can select from.

Select this option to limit tree selection to trees keyed by
the business unit entered on the PeopleSoft nVision Scope
Definition dialog box.

Select the required tree for your scope. The list is filtered based
on the setID or business unit, and field entered.

"Working with Tree Concepts" (PeopleTools 8.56: Tree Manager)

Choosing Tree Levels and Tree Nodes

If you selected the All Nodes at Selected Levels, Selected Tree Nodes, Children at a Level, or Detail of
Selected Parents options in the PeopleSoft nVision Scope Field dialog box, the PeopleSoft nVision Tree
Nodes dialog box appears prompting you to specify the tree levels that contain the nodes you want to use.
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Image: PeopleSoft nVision Tree Nodes dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Tree Nodes dialog box.
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To select tree levels and nodes in PS/nVision:

10.

Select nVision > Scope Definition from the nVision menu.

Click theNew button.

Enter a scope name and a description.

You may use up to 10 characters for the scope name and up to 30 characters for the scope description.
Enter the setID and other values for this scope.

Add fields to the scope definition by clicking the Add button.

The PeopleSoft nVision Scope Field dialog box appears.

Select All Nodes at Selected Levels,Selected Tree Nodes,Children at a Level, or Detail of Selected
Parents option.

The PeopleSoft nVision Tree Nodes dialog box appears.

In the PeopleSoft nVision Tree Nodes dialog box, select a level.

Place the cursor in the Tree Node field and click to see a list of nodes either by name or by position.
Select the nodes to use for your report.

Click the OK button.

The PeopleSoft nVision Scope Definition dialog box shows your fields and tree nodes.
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11. Click the Save button to save the scope.

Defining Report Scopes

Note: Make sure to click the Save button when you are finished with your scope. Clicking the OK button

closes the PeopleSoft nVision Scope Definition dialog box without saving your scope.

Working With Existing Scopes

This section discusses how to:

*  Open existing scopes.

* Delete existing scopes.

* Add fields and values to existing scopes.

* Remove fields and values from existing scopes.

Opening Existing Scopes

Image: PeopleSoft nVision Open Scope Definition dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Open Scope Definition dialog

box.

PeopleSoft n¥ision Open Scope Definition

[lualifiers
]
TableSetID:  [SHARE 2] _ |
Cancel
Scope Mame: |I]EDEF'TD|"-"
Get Lizt
TableSet ID: Scope Mame - Description:
QEDMZ REDERTDIY -- Selected Admin & Engi Div
QEDEPTGRP - Selected Azzem & Planning GRFP
QELOMGEY -

LERESTWS -- Scope for Restart Testing

To open an existing scope in PS/nVision:

1. Select nVision > Scope Definition from the nVision menu.

2. Click theNew button, and enter a scope name and a description.
3. Enter the setID and other values for this scope.

4. Add fields to the scope definition by clicking the Add button.
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10.

I1.

12.

13.

Select either All Nodes at Selected Levels, Selected Tree Nodes, Children at a Level, or Detail of
Selected Parents option.

In the PeopleSoft nVision Tree Nodes dialog box, select a level.

Place the cursor in the Tree Node field and click to see a list of nodes either by name or by position.
Select the nodes to use for your report.

Click the OK button.

From within the PeopleSoft nVision Scope Definition dialog box, click the Open button.

The PeopleSoft nVision Open Scope Definition dialog box appears.

Click the Get List button to see a list of available scope definitions.

In the TableSet ID list box, there is a list of setIDs; in the Scope Name — Description list box, there is
a list of scope definitions for each setID.

You can limit the list by entering qualifiers into either the TablesSet ID or Scope Name fields before
clicking the Get List button.

Select a scope definition from the list.

Click the OK button.

Deleting Existing Scopes

To delete an existing scope in PS/nVision:

1.

2.

Open the scope that you want to delete.

Click the Delete button.

Adding Fields and Values to Existing Scopes

90

To add additional field values to a scope in PS/nVision:

1.

2.

Select nVision > Scope Definition from the nVision menu.
Click theNew button, and enter a scope name and a description.
Enter the setID and other values for this scope.

Add fields to the scope definition by clicking the Add button.

Select either All Nodes at Selected Levels, Selected Tree Nodes, Children at a Level, or Detail of
Selected Parents option.

In the PeopleSoft nVision Tree Nodes dialog box, select a level.
Place the cursor in the Tree Node field and click to see a list of nodes either by name or by position.

Select the nodes to use for your report.
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10.

I1.

12.

Defining Report Scopes

Click the OK button.

In the PeopleSoft nVision Scope Definition dialog box, click the Add button in the Fields selection
area.

The PeopleSoft nVision Scope Field dialog box appears.
Enter the new scope fields and related values, and click the Save button.

Click the OK button to return to the NVSUSER homepage.

Related Links
Selecting Scope Fields

Removing Fields and Values from Existing Scopes

To remove a field from a scope definition in PS/nVision:

1.

2.

8.

9.

10.

I1.

Select nVision > Scope Definition from the nVision menu.
Click theNew button, and enter a scope name and a description.
Enter the setID and other values for this scope.

Add fields to the scope definition by clicking the Add button.

Select either All Nodes at Selected Levels, Selected Tree Nodes, Children at a Level, or Detail of
Selected Parents option.

In the PeopleSoft nVision Tree Nodes dialog box, select a level.

Place the cursor in the Tree Node field and click to see a list of nodes either by name or by position.
Select the nodes to use for your report.

Click the OK button.

In the PeopleSoft nVision Scope Definition dialog box, select the field to remove.

Click the Delete button in the Fields group box.

To remove a field value from a scope definition in PS/nVision:

1.

2.

3.

In the PeopleSoft nVision Scope Definition dialog box, select the field whose value you want to
remove.

In the right-hand list box, select the value to remove.

Click the Delete button in the right-hand group box.

Using Scope-Related Variables

Note: Using scope-related variables is discussed in the Creating Matrix Layouts topics.
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See Understanding Matrix Layouts, Creating Matrix Layouts, Adding Variable Criteria.
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Using DrillDown

Using DrillDown

DrillDown enables you to select a cell in your report and expand it according to new criteria contained
in a special DrillDown layout. This is useful when reporting is based on summary ledgers, as it provides
underlying details when and where they are needed.

Note: Although you create DrillDown layouts in PS/nVision on the Windows client, you can run
DrillDown with a browser on any report that you have access to in Report Manager.

The following report was run based on the Emplsal layout delivered with the PeopleTools Demo database
(PTDMO). By expanding the nPloded rows, you can review details about the data in the report. But what
if you want to review the monthly salaries of individual employees, and this is not in your original report
layout? With DrillDown, you can create a DrillDown layout that expands cell data to show the monthly
employee salary rates.

Image: Selecting a cell for DrillDown in a sample layout

In this example, L5 is the cell we are drilling down on, representing the total monthly rate for the Human
Resources department.
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After selecting a cell, pick the DrillDown layout you want to use from the nVision, DrillDown menu. The
results appear in a DrillDown report.
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Image: Report resulting from DrillDown

This example shows the results in a DrillDown report.

= Drill2 =] E3
B C D E F G =

- =

3 |EmpliD Name Department Job Code Head Count Sum Monthly Rt

4

3 |/705  |Holt,Susan 10200 5061 1 2920

6 |5121 Gregary Jan 10200 G001 1 1900.575

7 |8300 “incent,Catherine 10200 5033 1 39258.035

8 |8412  Little Paula 10200 1503 1 2820

9 |86 Daobbs Janice 10200 1101 1 9725784

10 (3750 Fuller, Darlene 10200 5032 1 2544932

11 (3540 Hill Jeffrey M. 10200 7102 1 528667

12 [5854 Smith,Bernice 10200 5038 1 J674.813

13 [3895 Gonzalez,Gemma 10200 1406 1 5354.513

14 [FOO1  Largon,Marcel 10200 2003 1 2013.109

15 (5001 Gaston Claudia 10200 (5060 1 5456.356

16 (G002 Matthews, Steven 10200 1504 1 2632225

17 (5003 Bishoff Allan 10200 5001 1 g602. 473

18 (G006 Scott,Martin 10200 =030 1 47585934

19 (5011 Sherwood,Steven 10200 5002 1 7061423

20 (5012 | Sherwood,Mancy 10200 =070 1 4600

21 G015 [ Kelly William 10200 1407 2 10167 .52

22 |5100 | Peterson Beth 10200 5082 1 JB09.058 |-

14| 4] »| M. Sheet1 14| [ Il

The DrillDown layout inherits all the criteria of the selected cell on the original report and provides a
subreport with the details you need.

Because DrillDown depends on child layouts, you might want to create a library of common layouts to
use. These might include:

* Accounts by department.

*  Products by cost center.

* Accounts by period.

* Departments by benefit plan.

Your system comes with a number of generic reports, and you can tailor or clone these reports as
needed. Many of these layouts employ nPlosion, so you can view both summary and detail levels in your
subreport.

You can also perform a series of DrillDowns on cells in reports until you have reached the level of detail
that you need.

DrillDown is available from matrix layouts only. However, the layout that displays the results of the
DrillDown can be either matrix or tabular. For example, you might produce a financial report using a
matrix layout, and then select one of the amounts and drill down to another matrix layout that breaks
down the departments and products that were summarized into that amount. From that report, you might
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select a department/product combination and drill down, this time using a tabular layout that queries the
individual sales transactions. This is the end of the DrillDown trail, because you can drill further only
from a matrix report.

Note: A PeopleTools upgrade may change the web server domain name, port number, or servlet path
required to access web server resources in the PeopleSoft Pure Internet Architecture. As a result, PS/
nVision drilldown operations on reports that were created before upgrade would fail, primarily because
drilldown links are, by design, hard-coded into PS/nVision reports. This is UpdateNvsDrill.xls. We have
provided a simple search and replace utility that you can use to replace old links with new ones. This
Excel macro, along with all other Excel macros, is located in the PS_ HOME\Excel directory.

Related Links
Using the PS/nVision DrillDown on the Web

Using Inherited Criteria

The key to DrillDown is the passing of selection criteria from a parent cell to its child using the
DrillDown layout. The child layout may have criteria of its own (possibly on other fields than those
mentioned in the parent), but any conflicts in criteria must be resolved so that the child query accesses a
subset of the data selected from the parent query.

Think of inherited criteria as the equivalent of a scope for the resulting report. The DrillDown layout can
have criteria (including nPlosion) for fields that were not included in the original report, and it can have
criteria for fields that defined the selected amount from the original report.

Criteria for fields from the original report override any specified in the DrillDown layout, with the
exception of nPlosion options, which enable you to see more detail than in the original report.

Within a DrillDown layout, you can specify TimeSpan nPlosion without entering a TimeSpan, since the
DrillDown layout inherits the TimeSpan of the original report.

Ledger Inheritance

Ledger criteria can be overridden in a child layout, either by ledgers specified in the child layout or by
queries to access tables that do not contain the LEDGER field.

An example of a ledger-based DrillDown that expands ledger criteria compares budget to actual
expenditures. Assume that you want to drill down from a budget variance report produced at the business
unit level and compare the actual to budget for each department. You can construct a DrillDown layout
with DEPTID nPloded in the rows and columns for actuals, budget, and variance. Because PS/nVision
allows this layout to override the inherited ledger, you can see each department’s budget performance in a
single picture.

Soft Inheritance

You can create a DrillDown with multiple TimeSpans. It is called soft inheritance for TimeSpans. To
create a soft inheritance for TimeSpans, you define a DrillDown layout with multiple columns and various
combinations of ledgers and TimeSpans.

For example, suppose you have a ledger total posted amount for the year 2001. You want to show year
2001’s detail amounts, which make up this total amount in one column, with 2000’s detail amounts in
the column beside it. You define a DrillDown layout with two amount columns. One column has no
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TimeSpan, (although you might specify nPlode TimeSpans), and the other column specifies a TimeSpan,
such as YTD-1YR. When you drill down, the first column inherits the TimeSpan, year 2001, from the
parent cell; and the other overrides the TimeSpan from the parent cell and uses its own defined year 2000
TimeSpan.

Note: Soft inheritance only controls when you drill down to a tabular layout. It does not function for
matrix layouts.

Using DrillDown Instances

Because DrillDown instances may be numerous and temporary, PS/nVision does not save them
automatically as it does for parent instances. Also, since these instances are generated without a report
request, there are no directory and file name templates. Therefore, PS/nVision performs the following
operations when creating the instances:

1. Saves the layout as a temporary template sheet (DRILL.XLT) in your TEMP directory.
2. Opens an instance of the template; this causes Excel to assign a name such as DRILLI.

3. Populates the instance as usual but neither saves nor closes it. You can save it (assigning a name at
save time) or close it without saving it once you are finished using it.

Using DrillDown Navigation

96

Unlike nPlosion, DrillDown does not require you to enable it before running your report. Run a report,
select a cell to expand, select the DrillDown option from the nVision menu, and then click the Drill
button on the toolbar, or use a predefined item on the Drill menu. The predefined Drill menu items are
most convenient because you can personalize them to express common DrillDown actions for your
organization.

To create a new DrillDown layout, select the New Layout option from the nVision menu and define
your selection criteria just as you would a report layout. Save the layout in the directory identified as
DrillDown Layouts on the nVision tab of the PeopleSoft Configuration Manager.

Remember that criteria from the selected cell in the parent instance are inherited in the child layout.
Reports inherit criteria from the parent cell so you get the same summary amount in the detail report,
but you also get the summary amount broken into its component details. This produces a single report
instance containing a subset of the data selected in the parent instance, but the data is separated into one
or two dimensions to show more detail.

Jump Back

After you have reviewed the result of a DrillDown report, the Jump Back command from the nVision
menu (CTRLA+SHIFT+J) returns you to the cell from which you drilled down. This occurs even if you
closed the parent report.

ReDrill

To repeat a DrillDown starting from a different cell on the parent report, press CTRL+SHIFT+I. For
example, suppose that you have drilled down from the current year’s Travel Expense amount, showing
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balances by detail account and department. Now you want to see the same breakout for last year’s
amount. Jump back to the original report, select last year’s amount, and press CTRL+SHIFT+I.

AutoDrill

For both ledger-based and query-based matrix reports, AutoDrill is a quick and easy DrillDown method.
To use AutoDrill, define a default DrillDown layout within the parent layout by using the Excel Insert,
Name, Define command to define the name NvsDefaultDrill as a string with the name of the default
DrillDown layout in the parent layout.

Image: Define Name dialog box

This example illustrates the fields and controls on the Define Name dialog box.

F i

Define Hame §|

Mames in workbook:
MysInstCritOpt | ok |

MywsInskCribopt Sheetl J—
MywsLayoutType |  Close |
MvshplSpec -
My sPanelBusUnit | add |
ryvsPanelEFFdE —_—
MyvsPanelSetid |
MysOueryMame Sheet1
MvsShest Type Sheet1
MyvsSkyleime

sl pdakeCption Sheetl

Refers to:
="R" |E|

After running a report, you can use AutoDrill in various ways:
* Double-click one of the amount cells.
The Nvsuser front end generally sets double-click to call the PS/nVision AutoDrill function.
*  Select the AutoDrill option from the nVision menu in Microsoft Excel.
*  Click the AutoDrill button on the nVision toolbar.

AutoDrill checks whether the instance you are drilling from has a default DrillDown layout. If so, PS/
nVision runs that layout.

Note: The default DrillDown layout may contain a matrix layout, a tabular layout, or both.

If no default DrillDown layout exists, PS/nVision checks the data source in the parent instance for the cell
you are drilling from. If it is a ledger, PS/nVision asks you to select a DrillDown layout. If it is a query,
PS/nVision adds the inherited criteria to the same query and then runs the query in QueryLink mode. To
show the underlying detail from a query designed for matrix reporting, PS/nVision removes aggregate
functions, such as Sum, from the query. This causes the query to show the lowest level of the detail from
the database. This modification of the query happens only when drilling down in QueryLink mode.

To get an intermediate level of detail in a query-based report using AutoDrill, define a default tabular
layout in NvsDefaultDrill. You might want to define a slightly different query to aggregate the
intermediate level of detail you need, and then build the default DrillDown layout using this query.
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Related Links

Using Configuration Manager
Personalizing NVSUSER.XLS

Using DrillDown Layout Formats

Basic DrillDown layouts typically have one data row and one data column. These simple layouts take
data already selected on a report and expand it in two dimensions. Both columns and rows may specify
nPlosion and automatic labeling of inherited and nPloded data.

Note: A DrillDown layout can be as complex as you like. For example, if you are building a DrillDown
layout you expect to be used from a corporate-level management report, you could design it with
departments grouped into regions, with nPlosion to detail. If you drill down to this layout from a regional
report, PS/nVision filters the layout criteria through the inherited criteria, and all the other regions have
ZEros.

Because DrillDown layouts are based on a simple matrix, you can set up a library of layouts based on the
field and TimeSpan combinations most common for your reporting and analysis needs.

For example, if you frequently select an amount from a summary income statement and expand it to show
that amount broken down by individual accounts, you could create a DrillDown layout that uses nPlosion
to expand account detail in the rows and that breaks out a TimeSpan to the individual accounting periods
in the columns. Alternatively, you might want to see the value broken out by department in the rows and
product in the columns.

Let’s say that you specify All Detail Values in the DrillDown layout as the selection criterion for a field,
and the cell you are drilling down from on the original report used a specific tree node for its criteria. In
this case, the report from the DrillDown nPlodes only the detail values for that tree node, creating a row
or column for each in addition to a summary column based on the tree node.

If the parent cell had no criteria for a field specified on the child as all detail values, the child report lists
amounts for all values in the specified field.

DrillDown and Summary Ledger

98

When using DrillDown from a report based on a summary ledger, you can either translate summary
ledger criteria into the corresponding detail ledger or drill down within the summary ledger.

To drill down within the summary ledger using the web, define the name NvsTranslateLedger in the
DrillDown layout. PS/nVision reads this defined name at runtime.

» Ifthe value is ¥, summary ledger criteria is translated into the corresponding detail ledger.
» Ifthe value is N, DrillDown within summary ledger is selected.

o If NvsTranslateLedger is not defined, summary ledger criteria is translated into the corresponding
detail ledger.

To define the name NvsTranslateLedger in the DrillDown layout:

1. Use the Excel Insert, Name, Define command to define the name NvsTranslateLedger.
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2. Define the name as a string with either Y or /N for the value.

Note: If you are using the Windows client, PS/nVision continues to ask whether to drill within the
summary ledger or drill to the corresponding detail ledger.

DrillDown and Queries

When drilling down from a ledger-based report, you can use predefined queries (built into PeopleSoft
Query) in the following ways:

» Use a matrix DrillDown layout that specifies query, rather than ledger, criteria.

This provides a matrix report that accesses tables other than ledgers, but inherits all the field criteria
(business unit, account, and so on) from the parent report.

* Drill down to a tabular layout, inheriting the field criteria from the parent report.

This is useful for seeing the details of transaction data, such as journals and voucher lines.
* Drill down to a query without a layout.

The query inherits the criteria and runs to Excel in QueryLink mode.

When drilling down from a query-based report, you can use another query in a matrix layout, in a tabular
layout, or without a layout. The query you use must be capable of inheriting the criteria from the cell you
are drilling down from.

In any case, PS/nVision bends the rules of inheritance slightly to enable you to see the needed data. The
ledger construct (which implies a special query against a specific type of table defined in PeopleSoft
General Ledger) is replaced by the query specification. The implied field criteria for the inherited ledger
(for example, LEDGER=ACTUALS) may or may not be inherited. While drilling down to journals within
the PeopleSoft General Ledger application requires criteria for the LEDGER field (because journals may
exist for various ledgers), drilling down to Accounts Payable voucher data only makes sense from the
Actuals ledger, and the voucher tables do not include the LEDGER field. PS/nVision thus looks at the
records being queried and includes criteria for the Ledger field only if it is present.

Naming Conventions

Use a three-character naming convention for DrillDown layouts, so that the fields and accounting periods
in the layout are easily identified in the Open Layout dialog box. The PS/nVision DrillDown layouts
supplied with the system use the abbreviations described in the following table.

Abbreviation DrillDown Layout
ACT Account

BUS Business Unit

DEP Department ID

PRD Product

PRJ Project
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DrillDown Layout Directory
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Abbreviation

DrillDown Layout

PER

Accounting Period

Each layout is named RRRCCCXX XNV, where RRR is the abbreviation for a field expanded in the rows,
CCC is the abbreviation for a field expanded in the columns, and XX is an optional identifier for a specific

layout or version of RRRCCC.

Note: With recent versions of Windows, file names can be long and descriptive, but a consistent
convention is still a good idea. For example, you might want to name a DrillDown layout

DepartmentByProduct.

Store DrillDown layouts in a separate directory from the parent standalone layouts. You specify the
directory path on the nVision tab of the PeopleTools Configuration Manager. The DrillDown layout path
can contain multiple directories, which are searched in sequence. The DrillDown directory is also defined
in the PeopleSoft Process Scheduler configuration for your report server.

Related Links

Using Configuration Manager
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Using nPlosion

Understanding nPlosion

You use nPlosion to expand rows or columns containing field criteria. When enabled, nPlosion
automatically creates individual rows or columns for each detail value defined in the criteria—whether
those values are defined specifically or implicitly (by association with a parent tree node). A detail row or
column is generated for the blank [or (None)] value if you are nPloding a tree containing a blank.

You can only enable nPlosion at the row or column level. When you enable nPlosion for a row, PS/
nVision inserts the detail or summary value rows immediately above the nPloded row. When you enable
it for a column, PS/nVision inserts detail and summary value columns to the left of an nPloded column.
If you have intersected label criteria with an nPloded row or column, descriptive text identifies each
nPloded amount. (If you do not use labels, you may have trouble identifying the detail rows that are
dynamically included in the report.)

Note: For Oracle's PeopleSoft General Ledger, nPlosion is available for detail ledger ChartFields or
summary ledger ChartFields that contain detail values. You may also use nPlosion for summary ledger
ChartFields accessed through summary trees. nPlosion is not available for summary ledger ChartFields
specified as selected summary ChartField nodes.

You cannot use nPlosion for a summary tree ChartField filter if the ledger's corresponding ChartField type
is detail. Nor can you use nPlosion for a detail Chartfield filter if the ledger's corresponding ChartField
type is summary. Attempting to nPlode in these situations returns a Microsoft Excel error, “PS/nVision
returning the Excel error code #N/A to the affected cells.”

For other applications, nPlosion is available for criteria fields that have value tables with field values
(usually, this is the prompt table for that field).

nVision does not support duplicate detail values when using nPlosion. Trees with duplicate detail values
could return incorrect results in nPlosion. To perform nPlosion in such a case, you need to use different
trees for the different parts of the report so that nVision would retrieve the overlapping nodes separately.

When processing nPlosion, PS/nVision uses the Excel outline feature to group the detail or summary
rows or columns and associate them with their total. After a report containing nPloded values has been
generated, you can use the Excel outlining symbols to collapse and expand the nPloded entries. Outlining
symbols automatically appear in the report’s left margin (for rows) or above the worksheet (for columns).

In web-based PS/nVision reporting, you can still use outlining in full nPlosion. With Internet Explorer
and the Excel add-in, reports produced in XLS format can be displayed with full Excel features, including
outlining.

The nPlosion feature is particularly useful with the DrillDown feature, which enables you to select cells in
your report and expand them to intermediate or detailed levels of summarization in an ancillary subreport.
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Defining nPlosion Criteria
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Use these step to access the PeopleSoft nVision nPlosion Criteria dialog box in PS/nVision:

1.

2.

With a layout opens in nVision, select a column or a row to nPlode.
Select nVision > Layout Definition from the nVision menu.

Select the Filter tab.

Select the required fields and click the nPlosion button.

The PeopleSoft nVision nPlosion Criteria dialog box appears.

Image: PeopleSoft nVision nPlosion Criteria dialog box

This example illustrates the fields and controls on the PeopleSoft nVision nPlosion Criteria dialog box.

PeopleSoft n¥ision nPlosion Criteria

nPlozion Type

\iMM_QUEUE_TYPE
Cancel
¢ Maone
" Ta bottam of e
" To specified level

" Toimmediate children

" To details anly

nPlozion Options
v Include underlying detail

[ Suppress nodes without data
[v Exclude intermediate levels

v Utilize outline feature

[v Collapze outline to level |1 j

nPlosion Type

There are four different nPlosion types, which can be combined with nPlosion options to create different
reports depending on the data you want to retrieve.

None Select to disable nPlosion for this field.

If you have previously selected a type of nPlosion, you must
select the None option to remove the selection.

To bottom of tree Select to nPlode all the way to the bottom of a tree (including

detail values) from a selected node.
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If you decide to include detail, all sub-nodes are also displayed
with summary values of the rollup for those nodes.

To specified level Select to nPlode down a tree to the specified node, including or
excluding intermediate data.

This option enables you to retrieve any branch of data from a

given tree.
To immediate children Select to nPlode one level below a selected tree node.
To details only Select to nPlode from a given node to all its detail values.
nPlosion Options
Include Underlying Detail When trying to nPlode from a node to another subnode or to

the bottom of the tree, select to include all of the detail and
summary subvalues for each subnode.

Suppress Nodes Without Data Select to suppress nodes or subnodes with a value of zero from
the report instance.

Exclude Intermediate Levels Select to exclude intermediate subnodes if a report is being
nPloded from a node to another level or to the bottom of the
tree.

Utilize Outline Feature Select to roll up summary and detail information using Excel

outline functionality. If this option is cleared, none of the
information is rolled up.

Defining nPlosion Defaults

Use these steps to access the PeopleSoft nVision Layout Options dialog box:
1. With a layout opens in nVision, select a column or a row to nPlode.
2. Select nVision > Layout Options from the nVision menu.

The PeopleSoft nVision Layout Options dialog box appears.
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Image: PeopleSoft nVision Layout Options dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Layout Options dialog box.
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To define nPlosion defaults in PS/nVision:

1. With a layout open in PS/nVision, select any row, column, or cell that does not contain selection
criteria—or select the entire worksheet.

2. Select nVision > Layout Options from the nVision menu.

3. Select the nPlode Rows tab from the PeopleSoft nVision Layout Options dialog box.
The PeopleSoft nVision Layout Options — nPlode Rows dialog box appears.

4. Select whether to enable a default nPloded criteria field for all rows, or columns, or both.

To define a default nPloded field for all rows, select the nPlode This Criteria Field option in the For

All Amount Rows group box. And then enter or select a field name in the editable field below the
check box.

To define a default nPloded field for all columns, select the nPlode Columns tab, and then select the
nPlode This Criteria Field option in the For All Amount Columns group box.

Chapter 9

Note: Enabling row- or column-wide nPlosion can be useful when, for example, you have a large
layout where you would not want to specify nPlosion for each individual row or column.

5. Optionally, specify the default fields to be nPloded.
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If a column or row contains multiple criteria fields, nPlosion only occurs for the single field that you
select here—unless you have specifically enabled nPlosion for those other fields on the PeopleSoft
nVision Layout Definition — Criteria dialog box.

Select the conditions under which you want to suppress nPlosion for rows and columns.

The Suppress Detail options enable you to suppress the creation of detail rows and columns under
certain circumstances, as follows:

* If entire detail column/row is zero: Creates detail columns or rows for a field value only if there is
a corresponding positive or negative amount. Suppresses rows with zero amounts in all columns,
or columns with zero amounts in all rows.

» Ifno data for entire detail column/row: Creates detail columns or rows for each field value if
amounts for that value are present on the query, even if those amounts net to zero.

* Never (show all detail): Creates detail columns or rows for all details under the nodes being
nPloded.

The zero suppression options are independent. The node suppression option overrides the detail
suppression option when they are in conflict. In other words, if zero nodes are suppressed, their
underlying details are also suppressed. To see all details for all nodes, even if zero, you should turn off
zero suppression at both levels.

Specify a detail style to be applied to the detail rows and columns.

Style selection and defaults appear in the Excel Format — Style dialog box. The column format is used
for nPloded values if a row style is not specified.

Related Links
Setting Tree Performance Options

Enabling nPlosion for Specific Situations

You can enable or disable nPlosion for specific:

Criteria fields

To enable or disable nPlosion for a specific criteria field, select a field from the Fields and
Dimensions list on the PeopleSoft nVision Layout Definition — Filter dialog box, and then click the
nPlode button. This generates underlying details only for the criteria fields you specify.

Query or ledger TimeSpans

To enable or disable nPlosion for a query or ledger timeSpan, select or clear the nPlode TimeSpan
option on the PeopleSoft nVision Layout Definition — Source dialog box. This option is only available
if you have a TimeSpan specified. This option generates detail rows and columns for the individual
periods in the TimeSpan; for example, the periods comprising year-to-date.

Report requests
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To enable or disable nPlosion for a report request, open the PeopleSoft nVision Report Request dialog
box and select or clear the Enable nPlosion If Specified In Layout option. You can specify summary
rows or columns before or after nPlode rows or columns based on an Excel option in layout. To set
this, open your layout in Excel and select Data > Group and Outline > Settings.

Related Links
Applying Filter Criteria

Using TimeSpans
Creating Report Requests

Using Style Sheets with nPlosion Layouts

This section provides an overview of style sheets and discusses how to:
» Use the style sheet wizard.

*  Open the Style Sheet Wizard.

*  Modify a style.

*  Apply styles to a report layout.

*  Modify styles using the Excel menu bar.

* Configure the style sheet directory location.

Note: If a level is missing within the hierarchy, the next-lower-numbered level that is defined takes on the
missing level’s style attributes.

Understanding Style Sheets

With nPlosion styles, you can control the layout and appearance of the multilevel hierarchy of rows and
columns nPlosion generates. In PS/nVision, the styles for your summary rows and columns come directly
from the styles that you have defined in the summary rows and columns in your layout. The styles for all
nPloded rows or columns in your report are controlled by nPlosion styles, but not the styles defined in the
summary rows or columns. You define nPlosion styles either by using Style Sheet Wizard or by directly
applying the styles from the Excel menu bar using PS/nVision nPlosion style naming conventions.

Note: You can also format nPloded detail rows or columns by selecting Format > Cells from the
Microsoft Excel menu bar when you create a report layout. However, by default, PS/nVision nPlosion
style sheets override any such manual formatting of nPloded detail rows or columns. If you want nPloded
details to appear in the format that you applied from the Excel menu bar rather than the nPlosion style
sheet, you must define the name NvsSkipDetailStyles using the Define Name dialog box (by selecting
Insert > Name > Define from the Excel menu bar), entering the value =1 in the Refers To field.

106 Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 9 Using nPlosion

Using the Style Sheet Wizard

You can use the Style Sheet Wizard exclusively to create and edit nPlosion styles, which are stored in a
special Excel worksheet provided with PS/nVision.

Image: nVision nPlosion Style Wizard window

This example illustrates the fields and controls on the nVision nPlosion Style Wizard window.
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There are two nPlosion styles:

* The RowStyles tab displays Row styles.

e The ColumnStyles tab displays Column styles.

Seven levels of each style are provided, as well as a separate style for detail values.

The Style sheet Classical.xIs is delivered with PS/nVision. You can create your own style sheet wizard
by saving the Classical.xls file under a different name in the Style Sheet directory location. Configure the
Style Sheet directory location using the Configuration Manager.

Note: You can override the base style by modifying any of the other styles that come after it. For
example, you could make a particular field shaded, even though the base style for that row or column
does not include shading.

Opening the Style Sheet Wizard
To open the Style Sheet Wizard:
1. With an layout opens in PS/nVision, click the Format Style Sheets button on the nVision toolbar.

2. Select the Classical.xls style sheet and click the OK button.
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The RowStyles tab of the Style Sheet Wizard appears.

The Style Sheet Wizard displays a rollup of data for eight rows and eight columns (Excel has a limitation
of rolling data up into only eight outlines).

Heading An outlined row or column of data has two parts.

When opened, the top portion of the outline is considered the
header, and the bottom portion is considered the Label. The
Heading does not contain any data; it is strictly for display
purposes.

Label The bottom portion of the outline.

The Label is the only thing displayed if the outline is collapsed.

Amount Any numeric data that will be a result of an nPlosion.
Base The formatting options for the Heading, Label, and Amount
styles.

Note: If there are style settings for the Label, Heading, or
Amount, they will override the Base Style setting.

Modifying a Style

108

To modify a style:
1. With an layout opens in PS/nVision, click the Format Style Sheets button on the nVision toolbar.
2. Select the Classical.xls style sheet and click the OK button.
The RowStyles tab of the Style Sheet Wizard appears.
3. Click the button with the name of the style you want to modify.
The Style dialog box of Excel appears.
4. Click the Modify button to modify the style’s display attributes, and then click the OK button.
The Format Cells dialog box of Excel appears.
5. Make more changes to styles by clicking the appropriate Style button.
6. Ifyou do not have any PS/nVision report layouts open, you can save the current styles by selecting

File > Save from the nVision menu.

This saving enables you to modify styles globally in the style worksheet, and then apply the new
styles to any report layout you want.

If you have a style at the Label, Heading, or Amount level, this saving overrides the base style.

Note: All Row Style settings override the Column Style settings.
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See the Microsoft Excel documentation for more information about how to use the Excel Format Cells

dialog.

Applying Styles to a Report Layout

To apply styles to a report layout in PS/nVision:

1. Open a report layout in nVision by selecting nVision, Open Layout.

2. Click the Format Style Sheets button on the nVision toolbar to open the Style Sheet Wizard and

modify styles as needed.

3. When you have finished modifying styles, click the Apply Styles button on the Style Sheet Wizard.

A list of all open layouts appears.

4. Select the required layout and click the OK button.

Modifying Styles Using the Excel Menu Bar

The Style Sheet Wizard is designed so you can easily take advantage of the Excel Style formatting
settings and properly use the designed nVision Style naming convention. You can accomplish the same
thing simply by opening a layout and selecting Format > Styles from the Excel menu bar. The Style
dialog appears and you can create styles using the same naming convention as the Style Sheet Wizard.

The following examples show the naming convention for PS/nVision nPlosion styles. Note that if you
apply the styles both from the Style Sheet Wizard and the Excel Menu Bar, the last applied style takes

effect:

RxxH

RxxL

CxxA

CxxB

The Header Style for any given level of a Row, where R
represents a row, xx represents the number of the level (that
is, 01, 02, and so on—00 represents the detail level), and H
represents the Header Style.

The Label Style for any given level of a Row, where R
represents a row, xx represents the number of the level (that
is, 01, 02, and so on—00 represents the detail level), and L
represents the Label Style.

The Amount Style for any given level of a column, where*“C
represents a column, xx represents the number of the level (that
is, 01, 02, and so on—00 represents the detail level), and 4
represents the Amount Style.

The Base Style for any given level of a column, where C
represents a column, xx represents the number of the level (that
is, 01, 02, and so on—00 represents the detail level), and B
represents the Base Style.

Note: Detail Row and Column Style settings are represented by the 00 level.
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Configuring the Style Sheet Directory Location

110

Your style sheet directory is indicated by PeopleSoft Configuration Manager for PS/nVision on Windows
or by the Process Scheduler configuration file for PS/nVision on the web.

To configure the style sheet directory using the Configuration Manager for PS/nVision on Windows:

1. Open the Configuration Manager by double clicking the Configuration Manager icon on your
desktop.
Alternatively, select Start > Program > PeopleTools 8.x > Configuration Manager.

2. Select the Profile tab, select a profile to edit, and then select the nVision tab to view or change PS/
nVision settings.

3. Enter the location of the PeopleSoft style sheets.

The Oracle PeopleSoft application delivers a set of style sheets that can be located at <PS_ HOME>\Excel

\Style Sheets.

To configure the style sheet directory using the Process Scheduler configuration file for PS/nVision on the

web:

1. Select Start > Command Prompt.

2. Change the directory to <PS_HOME>\appserv\.

3. Type psadmin and press ENTER.
The PeopleSoft Server Administration menu appears.

4. Select option 2 (Process Scheduler) and press ENTER.
The PeopleSoft Process Scheduler Administration menu appears.

5. Select option 3 (Configure a Process Scheduler Configuration) from the Process Scheduler
Administration menu.

6. Enter the number that corresponds to the desired database and press ENTER.
A message about shutting down the Process Scheduler is displayed.

7. Enter yto continue.

8. Reply n to the questions Do you want to change any values <y/n> [n]? for all sections, except the
nVision section.

9. For the nVision section, reply y to the questions Do you want to change any values <y/n> [n]?.

10. Use the following information to modify the nVision section:

* Parameter: StyleDir

* Description: Enter the default location where PS/nVision keeps nPlosion Styles (these are usually
inherited by the layout that the user is designing).
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11. Accept the default values for the remaining options.

Related Links

"Understanding PeopleSoft Configuration Manager" (PeopleTools 8.56: System and Server
Administration)

"Starting PeopleSoft Configuration Manager" (PeopleTools 8.56: System and Server Administration)

Using Multiple Chart-field nPlosion

The Multiple Chart-field nPlosion feature is an extension of the existing nPlosion feature. You can specify
any number of fields for nPlosion with Multiple Chart-field nPlosion.

Related Links

Understanding nPlosion

Understanding Multiple Chart-field nPlosion

Multiple Chart-field nPlosion is used to provide functionality for data in financial reports to show detailed
data values when there are multiple chart fields specified in the report. This data view helps people
performing detailed financial analysis to get the data at the most granular level, and to do a comparative
study across different entities like Account, Department and Business Units.

This feature offers:
* nPlosion on more than two chart-fields using a single criterion.
* Detailed data view at every entity or level.

* A summary or roll-up view at every level.

Note: Multiple chart-field nPlosion does not combine with a cell criteria.

Note: Filter criteria must be defined as a row criteria and all chart-fields for nPlosion must be added in
this criteria.

Related Links

Understanding nPlosion

Defining nPlosion Criteria

Defining nPlosion Defaults
Enabling nPlosion for Specific Situations

Using Style Sheets with nPlosion Layouts
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Image: Defining Multiple Chart-field nPlosion

Chapter 9

This example illustrates how to define Multiple Chart-field nPlosion using the existing functionality in

nVision:
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Image: Multiple Chart-field nPlosion — Layout

This example illustrates the fields and controls on the multiple chart-field nPlosion Layout window:
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To define Multiple Chart-field nPlosion in nVision:
1. Open any existing layout or create a new one.

2. Select nVision >Layout Definition from the menu.

Using nPlosion

3. In the PeopleSoft nVision Layout Definition dialog box, select the cells to which you want to apply

multiple chart-field nPlosion.
4. Select the Filter tab.
5. Click the Add button to add the chartfield.
6. Select the chart-field and then select the tree.
7. Add the node for which nPlosion is required.
8. Repeat steps 6 through 8 to add subsequent chart-fields.
9. Click OK.

Image: Multiple Chart-field nPlosion — Report

This example illustrates the fields and controls on the multiple chart-field nPlosion Style Wizard window:
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Enabling Multiple Chart-field nPlosion for Specific Situations

You can enable or disable nPlosion for specific:

¢ Criteria fields
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To enable or disable nPlosion for a specific criteria field, select a field from the Fields and
Dimensions list on the PeopleSoft nVision Layout Definition — Filter dialog box, and then click the
nPlode button. This generates underlying details only for the criteria fields you specify.

Query or ledger TimeSpans

To enable or disable nPlosion for a query or ledger timeSpan, select or clear the nPlode TimeSpan
option on the PeopleSoft nVision Layout Definition — Source dialog box. This option is only available
if you have a TimeSpan specified. This option generates detail columns for the individual periods in
the TimeSpan; for example, the periods comprising year-to-date.

Note: Timespan must be specified as a column criteria for multiple chart-field nPlosion.

Report requests

To enable or disable nPlosion for a report request, open the PeopleSoft nVision Report Request dialog
box and select or clear the Enable nPlosion If Specified In Layout option. You can specify summary
rows before or after nPlode rows based on an Excel option in layout. To set this, open your layout in
Excel and select select Data, then select Group and Outline, then select Settings.

Note: Drilldowns are not allowed for multiple chart-fiels nPlosion.

Related Links

Enabling nPlosion for Specific Situations

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 10

Using Advanced PS/nVision Options

Enhancing Report Layouts

You can use Microsoft Excel to personalize the display and printing of your layout, including the use of
built-in graphics and charts. Any elements that you define in the layout carry into the reports that you run.

Image: Example of Microsoft Excel window

This example illustrates the fields and controls on the Microsoft Excel window.
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When you have completed refinements to the layout, remember to select File > Save from Microsoft
Excel.
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Setting PS/nVision Options

Access the Options dialog box by opening an layout in PS/nVision and selecting nVision > Options from
the toolbar.

Image: PeopleSoft nVision Options dialog box

This example illustrates the fields and controls on the PeopleSoft nVision Options dialog box.
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General

Funtime Optionz
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Content Cellz
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Show Warning Messages Select this option to display warning messages and dialog boxes
when PS/nVision creates a new directory or overwrites a file.

If you do not select this option, PS/nVision runs with as little
prompting as possible.

This option is ideal if you plan overnight or lunch-time report
runs.

Show Report SQL Select this option to display the SQL statements that retrieve the
labels and amounts for your report. As PS/nVision prepares to
execute each statement, a SQL reference dialog box appears.
Click the OK button to continue or the Cancel button to stop the
report at that point.

You can copy the SQL statements to the Microsoft Windows
Clipboard by pressing the TAB key until the text is selected,
then pressing CTRL+INS or CTRLA+C.

Select this option only if you intend to step through the report
run, as you must click the OK button after each statement.

Suppress Amount Retrieval Select this option to have PS/nVision run the layout to make
sure that all selection criteria are valid. PS/nVision does not
retrieve amounts, so you can test the layout without waiting for
data to be selected.
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This option is useful in combination with other options when
you are debugging a report. If you also select the Show Report
SQL option, you can determine whether the displayed SQL
retrieves the data you want.

Show Row and Column Criteria Select this option to display the contents of Row 1 and Column

A, PS/nVision reserves for data selection criteria when you
create a layout. Content cells typically contain codes that relate
to the ledger, TimeSpan, field criteria, and query names.

Creating Virtual Ledgers

A virtual ledger is an alternate view of ledger data used only for PS/nVision reporting. For instance, you
might want to join data from another table (such as a product category table) with ledger data at reporting
time.

You can also use a virtual ledger to provide an alternate security view for different groups of users. For
example, you might want to provide an alternate view of the LOCAL ledger for users who need data
secured by PROJECT, while other ledger users have access secured by DEPTID. You can set up a virtual
ledger called PROJLOCAL, which is a view of the LOCAL ledger secured by PROJECT.

To create a virtual ledger called PROJLOCAL.:

1.

2.

Select Start > Programs > PeopleTools 8.x > Application Designer.

In Application Designer, create an authorization table (AUTH_PROJ_TBL) with OPRID and
PROJECT columns.

Create a page to maintain the authorization table.

Open the LEDGER record and use Save As to create a new record.
Name this new record LED PROJLOCAL VW.

Delete any unnecessary columns and create any additional columns.

In this example, we add the OPRID column because this view is used for security, and we delete
PROCESS_INSTANCE and TIMESTAMPS columns because these columns are not used for
reporting.

The view text must contain the following features:

* Since we are using this view for security, it must deliver the OPRID (or OPRCLASS or
ROWSECCLASS) field.

This is the first item in the SELECT list below.

* To get security by Project, the view joins the project authorization table to the ledger, making only
the rows with matching projects visible for each user.

* The SELECT list must deliver the name of the virtual ledger to satisfy the PS/nVision
"...LEDGER="PROJLOCAL'..." criteria, even though the rows retrieved are really ACTUALS.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved. 117



Using Advanced PS/nVision Options Chapter 10

See the third item in the SELECT list of the sample view text that follows.

¢ The Where clause must include "... AND LEDGER ="'LOCAL'..." to select the desired rows from
the real ledger .

This is example of the view text:

select b.oprid,
a.business unit,
'"PROJLOCAL',
a.fiscal year,
.accounting period,
.account,
.deptid,
.product,
.project,
.affiliate,
.currency cd,
.statistics_code,
a.posted total amt
from ps ledger a,
ps_auth proj tbl b
where a.ledger='LOCAL'
and a.project=b.project

ORI T

7. Save the record definition and create the SQL view.

8. Create a ledger definition for PROJLOCAL, specifying LED PROJLOCAL_VW as the reporting
view record name.

The other record and field names can be the same as for LOCAL.

9. Use the Ledgers for a Business Unit page to associate the new ledger with the business units that will
be using it.

In PS/nVision layouts, use PROJLOCAL, rather than LOCAL, in the Ledger criteria for reports to be run
by the project accounting users.

Using PS/nVision-Defined Names

This section describes the names that PS/nVision defines and looks up in layout and instance files. Many
of these names are used for internal purposes, but several, such as NvsEndTime, are intended for users.

Warning! The values of these names, except for rare exceptions, are managed by PS/nVision and are not
intended to be changed by customers. It's much safer to think of them as read-only. The names whose
values you may change are indicated in italics in the following table. Never change the value of the names
not highlighted in italics.

Note: Some names are used only in matrix or tabular layouts, but many apply to both as listed in the
Sheet Type column. The Level column indicates whether the name is defined at the file (workbook) level
or at the sheet level. Some strings begin with V' to avoid problems if the string was null. Names of this
type show V" at the beginning of the Values column.
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Name

Sheet Type

Level

Values

Comments

NvsDateToNumber

Both

File

Y/N

Y indicates to convert
database dates (for
example, the %ASD%
variable) to the Excel
native date format.
Default V.

NvsDrillHyperLink

Both

File

URL string

Stores the static part of
the DrillDown URL.
PS/nVision generates
a DrillDown URL for
each drillable cell in
the delivery instance
to invoke the Run
DrillDown page. The
full URL stores the
information about the
Run DrillDown page
(static) and location
of the drillable cell
(dynamic).

NvsElapsedTime

Both

File

Excel date/time

Indicates the elapsed
time to produce

this instance. To

see this elapsed

time in the instance,
enter the formula
=NvsElapsedTime in a
cell and format the cell
with a time format.

NvsEndTime

Both

File

Excel date/time

Indicates the time this
instance was saved.

To see this time in

the instance, enter the
formula =NvsEndTime
in a cell and format the
cell with a date or date/
time format.

NvsHiddenSheet

Both

Sheet

Used on hidden layout
sheets only to enable
data retrieval on the
sheet.

By default, nVision
will not process hidden
layout sheets.

NvsInstanceHook

Both

Sheet

Reference

Indicates the name or
reference of the macro
to be run on completion
of the instance.

NvsLayoutType

Both

Sheet

M3

Indicates the layout
version (unchanged for
several years).
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Name

Sheet Type

Level

Values

Comments

NvsParentRef

Both

File

Reference

Stores the reference of
the cell from which this
instance drilled down.

NvsSheetType

Both

Sheet

M/T

M = matrix, T = tabular,
undefined = non-layout.

NvsASD

Both

File

Vyyyy-mm-dd

Stores the as of date
from the report request.

NvsAutoDrillOk

Matrix

File

Y/N

Indicates whether this
instance includes a
PeopleSoft Query data
source; this controls
whether the AutoDrill
menu appears.

NvsDefaultDrill

Matrix

File

layout[,D]

In layout, specifies
default DrillDown
layout for
NvsAutoDrill (usually
associated with double-
click). Appending D to
the layout name causes
PS/nVision to translate
summary ledgers to
detail for this layout,
without asking the
user. For example,
NvsDefaultDrill might
be defined as =ActPer,
D.

NvsTranslateLedger

Matrix

File

Y/N

Indicates whether the
DrillDown is within a
summary ledger (N) or
detail ledger (7).

NvsInstSpec

Both

File

Criteria string

Specifies the instance
criteria. An instance
for a division
might look like %,
FDEPTID, TMFG
_ DEPARTMENTS,
NPRODUCTS. On a
DrillDown instance,
it may also include
TimeSpan and other
criteria.
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Name

Sheet Type

Level

Values

Comments

NvsInstSpec9

NvslInstSpecl ...

Both

File

Criteria string

ContinuesNvsInstSpec.
This enables PS/
nVision (beginning in
PeopleTools 8.1) to
handle larger strings of
instance criteria despite
the Excel limitation

of 255 characters per
defined name. Because
null strings cause
problems, PS/nVision
defines unused criteria
continuations as a
single comma, =",".

NvsNplSpec

Matrix

File

Criteria string

Specifies nPlosion
Options, from nPlosion
Options dialog box.
Contains the default
nPlosion fields, as well
as zero-suppression
options, for rows and
columns.

NvsPanelBusUnit

Both

File

Vbusunit

Indicates the business
unit used for prompting
when designing a
layout. Trees can be
keyed by either setID
or SETCNTRLVALUE,
and PS/nVision
supports the use

of business unit as
SETCNTRLVALUE.
This value is entered
on the Prompt dialog
box and used only
during layout design to
retrieve trees keyed by
Business Unit.

When running reports,
PS/nVision uses either
the requesting business
unit or its designated
setID as the key for a
given tree.

NvsPanelEffdt

Both

File

Vyyyy-mm-dd

Indicates the layout

effective date (governs
prompting). Entered on
the Prompt dialog box.

NvsPanelSetid

Both

File

Vsetid

Indicates the setID used
for prompting while
entering layout criteria.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.

121



Using Advanced PS/nVision Options Chapter 10

Name Sheet Type Level Values Comments

NvsReqBU Both File Vbusunit Stores the requesting
business unit from the
report request.

NvsReqBUOnly Both File VY/VN Stores the Data from
Requesting Business
Unit only option from
the report request.

NvsSkipDetailStyle Both File 0/1 The value 0 indicates
that nPloded details
appear in the format
applied using the
nPlosion style sheet.

The value / indicates
that nPloded details
ignore the nPlosion
style sheet applied

to the report layout,
and take their style
attributes from the
Microsoft Excel
formatting.

NvsTransLed Matrix File VY/VN Indicates whether
summary ledgers were
translated to detail
when producing this
instance. Used during
DrillDown to know
whether inherited
criteria are already

translated.
NvsTreeASD Matrix File Vyyyy-mm-dd Stores the tree as of

date from the report

request.
NvsTree.treename Matrix Sheet YYyyy Indicates tree

performance options
for a tree name. Each
character is a Y/N
option corresponding
to an option on the
Tree Performance
Options dialog box, in
sequence.
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Name

Sheet Type

Level

Values

Comments

NvsValTbl.fieldname

Matrix

File

Record name

In a layout, identifies
the record name of the
value table from which
values and labels come
for a criteria field. For
DEPTID, the defined
name for the value table
is NvsValTbl. DEPTID,
and its value might

be "DEPARTMENT _
TBL".

NvsAnswerCol

Tabular

Sheet

Reference

Refers to a column

of data returned in a
tabular report. Can

be used to create
references to any
column of data,
including all delivered
answer rows.

NvsQueryName

Tabular

Sheet

Query name

Stores the name of the
query that provides the
data for this tabular
layout or instance.

NvsRowCount

Tabular

Sheet

Integer

Records the number of
rows delivered to this
tabular instance sheet.

NvslInstCritOpt

Tabular

Sheet

R/S/1

Dictates how inherited
criteria are to be
handled for fields that
do not appear in the
current data source.

R = required (error

if inherited fields not
present); S = Select
criteria for those fields
that match, ignore
others; /= Ignore all
inherited criteria.

Formatting Dates

PS/nVision can deliver dates in two different formats, which can be applied to matrix layouts (for
variables such as %ASD%), tabular layouts, and the Excel template QUERY.XLT. (This is used in
QueryLink when PeopleSoft Query delivers a query answer to Excel). These two formats are:

» Excel format, in which a date is represented by a number (12/31/99 is represented as 36525).

Excel formatting can be used to display the date in a variety of formats.

*  String format ('1999-12-31").
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You define the name NvsDateToNumber in your layout or QUERY.XLT to indicate the format you
want to use. Y in NvsDateToNumber means to force dates to Excel numeric format, while V indicates
to use the string format. The default for NvsDateToNumber is N for backward compatibility.

Image: The Define Name dialog box

This is an example of the definition (accessed through the Excel menus: Insert > Name > Define).

F i

Define Hame §|

Mames in workbook:

MysInstCritOpt | O |
MywsInskCribopt Sheetl [P J—
MywsLayoutType |  Close |
MvshplSpec
MysPanelBusUinit | add |
ryvsPanelEFFdE —_—
MyvsPanelSetid I [
MysOueryMame Sheet1 |E—E|—Ehe-|
MvsShest Type Sheet1

RlvsSkylelme

sl pdakeCption Sheetl

Refers to:
="R" |1|

Unlike NvsInstanceHook, NvsDateToNumber is defined at the workbook level. You do not qualify the
name using the sheet name.

Setting Trace Files

Trace files are useful for generating troubleshooting and debugging information. You can configure trace
files to be generated for PS/nVision processes: each nVision process generates its own trace file with time
stamped entries, making troubleshooting easier. You can set the trace level to specify how much detail the
trace files will show.

Enabling Trace Files

124

By default, PS/nVision does not generate trace files because extensive tracing can affect system
performance. You can enable tracing and determine the tracing level when you need debugging.

Tracing for PS/nVision on Windows

You configure tracing in PS/nVision on Windows using the Trace Level setting in PeopleSoft
Configuration Manager. The default value is 0.

See "Understanding PeopleSoft Configuration Manager" (PeopleTools 8.56: System and Server
Administration), "Starting PeopleSoft Configuration Manager" (PeopleTools 8.56: System and Server
Administration).

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 10 Using Advanced PS/nVision Options

Tracing for PS/nVision on the Web

You configure PS/nVision tracing on the web using the Trace Level setting in the PeopleSoft Process
Scheduler configuration file's nVision section. The default value is 0.

See "Using PSADMIN with PeopleSoft Process Scheduler" (PeopleTools 8.56: Process Scheduler).

Tracing Levels

PS/nVision supports five tracing levels: 0, 1, 2, 3, and 4. The following table shows the level of tracing
for each value.

Tracing Level Description

0 No tracing; no log files are generated. This is the default
setting.

1 The lowest level of tracing. With this setting, nVision

generates basic, high-level process flow and status
information. You can use this setting to check whether nVision
was launched successfully and whether it can connect to
Microsoft Excel and process requests. Some of the key entries
in Level 1 settings are: Command Line arguments, Trace
Level, Excel Process ID, Run Control Name, Report Name,
Business Unit, Drill Layout, and Instance Name.

A common scenario for which to use this level is if a PS/
nVision process exits immediately after processing.

2 This level contains entries from level 1 plus additional
information. A high-level code flow is recorded with this
setting.

3 This level includes tracing up to level 2 and SQL statements.

For Microsoft Windows, PS/nVision runtime SQL can be
displayed by selecting the Show Report SQL option from the
nVision > Options menu. The same SQL statements will be
written into the log file by changing the trace level to 3.

4 This level is the highest and includes tracing up to level

3 plus additional function calls, output values, and other
detail information. You can use this setting for identifying
intermittent problems and random behaviors.

In addition to the above trace levels, there are two additional levels available for extended nVision tracing
for identifying critical issues at OpenXML engine level. These levels are available only for OpenXML
mode. The following table shows the level of tracing for each value.

Tracing Level Description

100 This enables extended nVision tracing for function level Entry
Exit in OpenXML engine that logs the details of Line number,
Function Name and File Name in the psnvs_%pid%.nvt trace
file.
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Tracing Level Description

200 This level contains entries from level 100 and also generates
stack trace of OpenXML engine. This generates two additional
files in the log_output folder namely psnamsrv_stack.txt and
psnvssrv_stack.txt

Note: The extended nVision tracing is a tool for PeopleSoft product support to use for better
supportability. We recommend that this feature be disabled in production mode.

Viewing Trace Files
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The trace file's output filename has the format psnvs _[process ID of psnvs.exe].nvt. For example:
psnvs_123.nvt. You can view the trace file from both Windows-based and web-based PS/nVision.

Note: The server module PSNVSOXML generates an .nxt trace file in the same location as the .nvt file.
The .nxt trace file contains log information from the server module PSNVSOXML. The trace settings
of PS/nVision are applicable to both .nvt and .nxt trace files. Naming convention of the .nxt file is
psnvsoxml [process ID of psnvs.exe].nxt; for example, psnvsoxml 123.nxt.

Viewing the Trace Files for PS/nVision on Windows

In Microsoft Windows PS/nVision, the trace file is generated in your system temporary directory; for
example c:\temp\psnvs_123.nvt.

Note: PS/nVision does not delete files generated in tracing for Microsoft Windows PS/nVision. You can
delete the trace files from the temporary directory to save disk space.

Viewing the Trace Files on the Web

On the web, because PeopleSoft Process Scheduler initiates all PS/nVision processes, it is also
responsible for displaying PS/nVision trace information in the Process Monitor after PS/nVision reports
are run to completion. The PS/nVision trace files are independent of the Process Scheduler's status of the
report running, and are always posted regardless of your output types or formats. Trace files are secured
by the same user list as the report, so only the same set of users can view them.

PS/mVision trace files are automatically purged when the reports are purged in the time frame that you
have set from the Process Scheduler System Purge Option. You can view trace files from the View Trace/
Log page in Process Monitor for your completed process instance.

To view a trace file:
1. Select PeopleTools > Process Scheduler > Process Monitor.

2. Find the process instance that runs your nVision report, and then click the Details link to access the
Process Details page.

3. Click the View/Trace Log link to access the Message Log page.

4. Click the nVision Trace link to view the trace file.
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If Process Scheduler has restarted your nVision report running process, this procedure generates
multiple nVision trace files (one for each retry).

Related Links
"Defining System Settings" (PeopleTools 8.56: Process Scheduler)

Dismissing Unattended Dialogs

PS/nVision can detect and close unattended dialog boxes on the batch server. To use this feature, you
must enable the EnablePollDialogs and set the PollDialogSeconds parameters in the PeopleSoft Process
Scheduler.

The EnablePollDialogs parameter is disabled (with setting equal to 0) by default, but if you have
problems with unattended dialogs generated from PS/nVision in batch mode, you should change the
setting to Enabled for debugging purposes. You can do this using the Process Scheduler's PSADMIN
utility. Use the PollDialogSeconds parameter to specify how often to cycle polling for unattended dialogs.
When EnablePollDialogs is enabled, you must set the PollDialogSeconds parameter to a value greater
than 0.

Note: PS/ nVision will close only the dialogs originating from PS/nVision and Microsoft Excel.

See "Using PSADMIN with PeopleSoft Process Scheduler" (PeopleTools 8.56: Process Scheduler).
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Understanding PeopleCode APIs for Excel

PeopleCode APIs for Excel is a framework solution for easier interaction with Excel files or spreadsheets
within PeopleCode. This feature provides the user the ability to interact with Excel spreadsheets by using
PeopleCode APIs. These PeopleCode APIs work across multiple platforms which include Windows,
UNIX and Linux.

This feature allows the user to:

* Develop PeopleCode functionality to interactively generate Excel reports in real-time.
* Read or write data from PIA to Excel documents and vice versa.

*  Output Excel data on a pre-defined template.

Related Links

Using PeopleCode APIs for Excel
"PSSpreadsheet Class Methods" (PeopleTools 8.56: PeopleCode API Reference)

Using PeopleCode APIs for Excel

Following are the operations that a user can perform via PeopleCode :

PeopleCode API Description

Open Opens existing workbook or creates new workbook.
SaveAs Saves existing template file to new workbook.

Save Saves generated excel file to output location.
GetFileContent Retrieves generated excel file data from output directory.
SetCellNumber Sets number data into the cell within the workbook.
SetCellString Sets string data into the cell within the workbook.
SetCellFormula Sets formula data into the cell within the workbook.
SetCellDate Sets Date data into the cell within the workbook.
SetColumnWidth Sets the width of the column within the workbook.
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PeopleCode API Description

SetCellHyperlink Sets hyperlink data in the cell.

SetCellHeaderStyle Sets cell header style.

SetSheetActivate Sets the active sheet in the workbook.
SetActiveSheetName Updates the name of the existing sheet within the workbook.
CreateSheet Creates new sheet within the workbook.
RangeRowOutline Enables or disables outline on the range of rows.
RangeColOutline Enables or disables outline on the range of columns.
RangeApplyStyle Sets style of the range of cells.

InsertRows Inserts rows in the active sheet.

InsertColumns Inserts columns in the active sheet.

SetRowSetData Sets scroll rowset data into the sheet.

Related Links

Understanding PeopleCode APIs for Excel
"PSSpreadsheet Class Methods" (PeopleTools 8.56: PeopleCode API Reference)
Testing PeopleCode APIs

Testing PeopleCode APIs

To test the PeopleCode APIs, a PIA sample test page called ‘SpreadSheet API Sample Page’ is available
to the users. This section tells you how to use this page to test the PeopleCode APIs.

Pre-requisites for Using the SpreadSheet APl Sample Page
1. Output Path should always be specified with the full path and name of file to be created or updated.
2. Output Directory should always exist. Otherwise, there will be an error displaying “Directory cannot

be created.”

Using the SpreadSheet APl Sample Page

To access the SpreadSheet API Sample Page, select Reporting Tools >PS/nVision >SpreadSheet API
Sample Page.
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Image: SpreadSheet API Sample Page

Using PeopleCode APlIs for Excel

This example illustrates the fields and controls on the SpreadSheet API Sample Page. You can find
definitions for the fields and controls later on this page.

Spreadsheet APl Sample Page

Input File Path

Output File Path

Enable Rowset Fill Rowset
User Data: Personalize | Find | View All | B | Ll First ‘& 10of1 ‘& Last
Row Number Col Number Cell Type Cell Data
4 = [=]
Save

Input Path Input path of existing template file.
Output Path Output path where generated excel file is to be saved.
Enable Rowset This field has two modes — enable and disable rowset.

Row Number
Col Number

Cell Type

Cell Data

Save
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When the Enable Rowset checkbox is checked, the entire rowset
data is saved as is to the output excel file in a single operation.

When the Enable Rowset checkbox is unchecked, only the cell
data field within the rowset is saved to the output excel file in a
single operation.

Cell row number within the excel file.
Cell column number within excel file.
Type of cell data (number, string, formula, date).

Following are the defined values of this field:

e Number =0
* String=1

* Formula=2
* Date=6

Cell data to be saved into the excel file.

Invokes Spreadsheet APIs to generate and save the field data
into the output excel file.
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Related Links
Understanding PeopleCode APIs for Excel
Using PeopleCode APIs for Excel

"PSSpreadsheet Class Methods" (PeopleTools 8.56: PeopleCode API Reference)
Testing PeopleCode APIs

Generating Excel Output File

When the user supplies all the input data and clicks on the Save button, it triggers the Spreadsheet
PeopleCode APIs. As a result of this, an excel file is generated and saved to the given output path
location. The user receives the same output file in their browser as a download option, allowing the user

to either open or save the file.

Image: Spreadsheet Showing Entire Rowset Data as Output

The following example illustrates a spreadsheet that shows the entire rowset data as output.

JEJ:;'J\ H ) - 5 tl-1
—/l Home Insert Page Layout Formulas Data Reviey
E ® Caiibr u Claw]|EEEE | o
—:é {E‘* A = = =| raqd - |'$_ -
Paste B [ U -~ - - e
- = = = | |EE =|| ¥ %66 -
Clipboard ™ Font [ Alignment P Mur
Al - fe| 1
A B C D E F
1 1 1 datal 1
2 2 2 dataz 1
3 3 3 12 i)
a4
| |
5

Related Links

Understanding PeopleCode APIs for Excel

Using PeopleCode APIs for Excel

Testing PeopleCode APIs

"PSSpreadsheet Class Methods" (PeopleTools 8.56: PeopleCode API Reference)
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Understanding PS/nVision Personalization

You can personalize numerous PS/nVision options through the Configuration Manager and can even
change the user interface for reporting and DrillDown. PS/nVision provides a Microsoft Excel workbook
(NVSUSER.XLS) with a custom DrillDown menu and buttons for common actions. From this starting
point, you can construct a custom user interface for your organization or for a select groups of users.

Note: PS/nVision also supports previous versions of personalized and non-personalized NVSUSER.XLM
files.

PS/nVision product delivers NVSUSER as a starting point. You can use it with minimal modifications,
make major enhancements, or replace it altogether.

Using Configuration Manager

The PeopleTools Configuration Manager enables you to maintain PeopleSoft-specific configuration
information in the Windows Registry. You should use the Configuration Manager to maintain PS/nVision
settings (and other PeopleTools settings) rather than editing the Windows Registry directly.

This section describes how to:

* Change the Configuration Manager settings.
* Define the directory paths.

» Specify the formatting options.

*  Specify the AsofDateforLabels option.

Changing Configuration Manager Settings

The settings in the Edit Profile — nVision dialog box control where PS/nVision looks for various file
types. PeopleSoft Query Link, the feature that enables you to send PeopleSoft Query output to a
spreadsheet, also refers to these Configuration Manager settings.

Use these steps to access the Configuration Manager:

1. Open the Configuration Manager by double clicking the Configuration Manager icon on your
desktop.

Alternatively, select Start > Program > PeopleTools 8.x > Configuration Manager.

2. Select the Profile tab.
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3. Select the profile to edit, and click the Edit button.

4. Select the nVision tab in the Edit Profile dialog box to view or change PS/nVision settings.
The Edit Profile — nVision dialog box appears.

Image: Edit Profile dialog box: nVision tab

This example illustrates the fields and controls on the Edit Profile dialog box: nVision tab.

FEdit Profile - ‘Default’

[ atabaze/application Sewell Process Scheduler  nivision | Eommunl

Space between Cuen Columns: ||

 Directony paths
Custornization Macros: IZ:'\F'TS.ES'\B:-:CBI

Report Lapouts: |Z:APT8 B3rivisionblayout

Cirilldaan Layauts: IZ:'\F'T8.53'\n\-"isi0n\.layuut'\drilldn

Feport Instance: |E:'\L|SEH\NVISIDN'\INSTANEE

Query Templates: |Z:'\F'T8.53'\e:-:cel

ER ) R R

Style Sheets: |Z:'\F'T8.53'\e>:cel'\stylesheets
Trace Level: 0 =
Az of Date for Label: [ Retrieve Active Tree r

] I Cancel | Apply | Help I

Note: Changes made with the Configuration Manager do not take effect until you sign on to the system. If
you are signed on while making changes to Configuration Manager, you have to sign off and sign back on
to see the effect of the changes.

The following table lists and describes the controls that are available for PS/nVision in the Configuration

Manager.
Control Description
Space Between Query Columns Sets the number of blank Microsoft Excel characters that

PeopleSoft Query Link places between query output columns.
To eliminate spacer columns, set this value to 0. Spacer
columns improve readability, but they can be problematic with
Microsoft Excel list features (such as filters or subtotals) or if
you want to export data to another program.
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Control

Description

Customization Macros

Specifies the directory path PS/nVision should search for
macros used with PS/nVision and PeopleSoft Query Link.

It is usually $PS_HOME$\EXCEL. This is also the path
PS/nVision searches for the user macro sheet (normally
NVSUSER.XLS) if it is not found in the layout directory path.

Report Layouts

Specifies the directory path PS/nVision should search for
layout files. They are usually in \USER\NVISION\LAYOUT,
but you might also have a shared layout directory on the
network. The layout directory path is also searched first for
the user macro file (normally NVSUSER.XLS), enabling you
to use a personalized front-end macro sheet rather than the
standard one for the organization.

DrillDown Layouts

Specifies the directory that contains PS/nVision DrillDown
layouts, usually \USER\NVISION\LAYOUT\DRILLDN.

Report Instance

Specifies the directory into which PS/nVision places report
instances. This value can be overridden via the directory
template in the Report Request dialog box.

Query Templates

Specifies where to look for the QUERY.XLT file. This file
defines the Microsoft Excel styles used to format output. If
no template directory is specified, or if PS/nVision doesn't
find Query. XLT there, it searches in the personalization macro
path.

Style Sheets

Specifies the directory of predefined nPlosion styles for the
style sheet.

AsofDateforLabels

Specifies whether the as-of date or the maximum-eftective
date will be used to retrieve label descriptions of nVision
reports and drilldowns.

*  Deselect this option to enable PS/nVision to always
display maximum-effective dated label descriptions of
tree nodes and detail values.

By default, this option is deselected and PS/nVision
shows the same behavior as earlier versions of PS/
nVision.

Note: PS/nVision has been applying the maximum-
effective date logic in releases prior to PeopleTools 8.52.

»  Select this option to enable PS/nVision to effectively
process date for label descriptions and retrieves
descriptions using the as-of date of the nVision report
being run.

See Using Configuration Manager.
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Control Description

RetrieveActiveTreeLabels Specifies whether only active tree node label descriptions are
retrieved for nVision reports and drilldowns.

»  Deselect this option to enable PS/nVision to disregard the
activeness of the tree node label descriptions.

By default, this option is deselected and PS/nVision
shows the same behavior as earlier versions of PS/
nVision.

Note: PS/nVision has been disregarding the activeness
of the tree node label descriptions in releases prior to
PeopleTools 8.52.

*  Select this option to enable PS/nVision to strictly use the
activeness of the tree node label descriptions. Only active
tree node label descriptions are retrieved by PS/nVision.

Note: These settings are for the Windows version of PS/nVision. To run PS/nVision through Process
Scheduler, the configuration settings are in the [nVision] section of SPSHOME\APPSERV\PRCS\
$databasname\pspres.cfg.

In the Process Scheduler Configuration file (pspres.cfg), the default directory of the report instance is
%PS_SERVDIR%\NVISION\INSTANCE.

The report layout and drilldown layouts are located under %PSHOME%; for example, %PSHOME%
\NVISION\LAYOUT and %PSHOME%\NVISION\LAYOUT\DRILLDN.

%PSHOME% is read-only and only an administrator can add a new layout or modify existing layouts.
You can relocate these two directories outside of PSHOME if all users need the write access to these
directories.

General configuration settings in Process scheduler configuration (psprcs.cfg) for PS/nVision are:

DrillDownDir:%PS_HOME%\NVISION\LAYOUT\DRILLDN
InstanceDir=%PS SERVDIR%\NVISION\INSTANCE
LayoutDir=%PS_HOME%\NVISION\LAYOUT
MacroDir=%PS HOME%\EXCEL
StyleDir:%PS_HOME%\EXCEL\ STYLESHEETS
TemplateDir=%PS_ HOMES$\EXCEL
EnableDrillDownForFile=0
EnablePollDialogs=0

PollDialogSeconds=30

Tracelevel=4

SaveTempFile=0

UseExcelAutomation=0

AsofDateForLabels=0
RetrieveActiveTreelLabels=0

UseExcelAutomation is used to enable or disable Excel automation mode. The default setting,
UseExcelAutomation=0, should not be changed because this is the only mode under which nVision can
run currently.

RetrieveActiveTreeLabels is used to specify whether only active tree node label descriptions are retrieved
for nVision reports and drilldowns. The default setting RetrieveActiveTreeLabels=0 enables PS/nVision to
disregard the activeness of the tree node label descriptions. When RetrieveActiveTreeLabels=1, nVision
strictly use the activeness of the tree node label descriptions.
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Specifying the AsofDateForLabels Option

AsofDateForLabels is used to specify whether the as-of date or the maximum-effective date will be used
to retrieve label descriptions of nVision reports and drilldowns. The default setting AsofDateForLabels=0
enables nVision to always display maximum-effective dated label descriptions of tree nodes and detail
values. When AsofDateForLabels=1, nVision effectively processes date for label descriptions and
retrieves descriptions using the as-of date of the nVision report being run.

Deselecting the AsofDateforLabels Option

If you deselect the AsofDateforLabels option in the Edit Profile — nVision dialog box of the Configuration
Manager, PS/nVision applies the maximum effective dated logic that retrieves the row descriptions only
from the maximum effective dated entries for the tree nodes and detail values. In other words, labels are
retrieved from tree node descriptions and data are retrieved from detail values associated with the tree
leaves and mapped to application data. This maximum effective dated logic is also inherited when you
perform a drilldown from nVision reports.

Image: Tree nodes and detail values show multiple effective-dated tree node with descriptions

In this example, tree nodes and detail values show multiple effective-dated tree node with descriptions.

Tree Hode

SetlD: SHARE  TreeNode: CGSDETAIL
Tree Node Information Find | View 1  First B 1.2 of 2 B Last
- _ [+][=]
*Effective Date; 01/0172001 L ‘Slatus: |AE#WE vl
*Description: Detailed Cost of Goods Sold
[=]
*Effective Date: 01/01/1900 [ sgpatys: | Active -]
*Description: Cost of Goods Sold Detail
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Image: Multiple effective-dated account details with different descriptions

This example shows multiple effective-dated account details with different descriptions.

Chapter 12

Account | Map to Alternate Account

Setld: SHARE Account: 500000

Effective Date

prmiszo01 5
Costof Goods - Latest Account
[cocs

Aftributes
[ Control Account

™ Budgetary Only

[T Statistical Account UOM:

Eind | “iew 1 First 4] 1-2of 2 [} Last

=

ﬂ Attributes
" Control Account

Costof Goods Sold

™ Rudaatan: Nnkhe

Monetary Account Type: | EXpense 4 Book Code: B
Balance Sheet Indicator: | Blance Sheet = I7 Allow Book Code Override
"WAT Account Flag: IW«T Applicable Account LI Physical Nature: | Goods o I"J_a_T fault
I" Openttem Account
Edit Record: ' Q Edit Field: Q
Prompt Table: Q Description of Openitem:
Reconcile Tolerance: Reconcile Currency: Q
Performance Measurement
¥ General Ledger Account [ Performance Measurement Acct " ABM Account
01011900 B rgpatus: | Active =

Even though the descriptions of the tree nodes and detail values are different for 01/01/2000 and
01/01/2001, report results show only the descriptions of 01/01/2001 (Cost of Goods — Latest Account and
Detailed Cost of Goods Sold), which is the maximum effective dated descriptions for both reports.

Image: Report results as of 01/01/2000

Report results of nVision report run as of 01/01/2000.

Cost of Goods - Latest Account 18147 0 18147
Detailed Cost of Goods Sold 18147 1] 18147

Image: Report results as of’ 01/01/2001

Report results of nVision report run as of” 01/01/2001.

Cost of Goods - Latest Account 1598031 0 1598031
Detailed Cost of Goods Sold 1598031 0 1598031

Similarly, when you perform a drilldown from an nVision report as of 01/01/2000, report results show the

descriptions of 01/01/2001, which is invalid in 01/01/2000.
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Image: Drilldown report results as of 01/01/2000

Drilldown report results as of 01/01/2000.

Personalizing PS/nVision

Breakdown by Account & Period
Account 2 Amount

HO00000 Cost of Goods - Latest Account
Detailed Cost of Goods Sold

When PS/Vision applies maximum effective dated logic:

18147 18,147
18147 18.147

* Future effective dated descriptions, which are invalid at present, may be used.

*  The descriptions and the actual data can be out of synchronization, as the data is retrieved using the
as-of date of the report and the descriptions are retrieved only for maximum effective dated values,

irrespective of whether the label is set to Active or Inactive.

* Drilldown report results are retrieved using the maximum-effective date of the parent report.

Selecting the AsofDateForLabels Option

If you select the AsofDateforLabels option in the Edit Profile — nVision dialog box of the Configuration

Manager, PS/nVision applies the as-of dated logic that effectively processes date for label descriptions

and retrieves labels using the As of Date of the nVision report being run. Therefore, nVision report results

display accurate label descriptions.

Image: Tree nodes and detail values with multiple effective-dated tree node and descriptions

In this example, tree nodes and detail values show multiple effective-dated tree node with descriptions.

SetlD: SHARE Tree Hode: CGSDETAIL
Tree Node Information Find |View1  First Bl 1.2 ot 2 B Last
. _ L] (=]
*Effective Date: 010172001 [ sgatys: | Active -]
*‘Description: Detailed Cost of Goods Sold
. [+][=]
*Effective Date: 010111900 [ sgratus: | Active -]
*Description: Cost of Goods Sold Detail

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.

139



Personalizing PS/nVision

Image: Multiple effective-dated account details with different descriptions

This example shows multiple effective-dated account details with different descriptions.

Chapter 12

Account | Map to Alterate Account
SetlD: SHARE Account: 500000
Effective Date Find | Wiew 1 First 4] 1-20f2 [} | Last
Pm1zo0r B giatus: Attributes =
Description: 'Cost of Goods - Latest Account ™ Control Account
et [cocs I™ Budgetary Only
I™ Statistical Account UOM:
Monetary Account Type: | EXpense 4 Book Code: B
Balance Sheet Indicator: I Balance Sheet ;I ¥ Allow Book Code Override
"WAT Account Flag: | VAT Applicable Account | Physical Nature: [Goods  =]vaT Defaul
" Openttem Account
Edit Record: ' Q Edit Field: Q
Prompt Table: l Q Description of Openttem: l
Reconcile Tolerance: . Reconcile Currency: . Q
Performance Measurement
¥ General Ledger Account [ Performance Measurement Acct [~ ABM Account
0UDIN900 [ sgpates; |Active =l smibutes -
intion: [Costof Goods Sold " Control Account
S Lincd Punnncisstng: p ™ Budnotan: Ninkhe

When PS/nVision applies the as-of dated logic, the report results display accurate label descriptions for

both tree nodes and detail values.
Image: Report results run as of 01/01/2000

Report results of nVision report run as of 01/01/2000.

Cost of Goods Sold 18147 0 18147
Cost of Goods Sold Detail 18147 1] 18147

Image: Report results run as of 01/01/2001

Report results of nVision report run as of 01/01/2001.

Cost of Goods - Latest Account 1593031 0 1598031
Detailed Cost of Goods Sold 1598031 0 1598031

140 Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 12 Personalizing PS/nVision

Image: Drilldown report results run as of 01/01/2000

Report results of nVision drilldown report run as of 01/01/2000.

Breakdown by Account & Period

Account ZR)  Amount

HO0000 Cost of Goods Sold 18,147 18,147
Cost of Goods Sold Detail 18,147

Image: Drilldown report results run as of 01/01/2001

Report results of nVision drilldown report run as of 01/01/2001.

E C D E F 5

Breakdown by Account & Period

2001 |

HO0000 Cost of Goods - Latest Account
Detailed Cost of Goods Sold

When PS/Vision applies the as-of dated logic, PS/nVision:
* Retrieves label descriptions that are effective less than or equal to the As of Date of the report.
* Retrieves label descriptions of drilldown reports using the As of Date of the parent report.

*  Only uses label descriptions of the active tree nodes.
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Image: Report results run as of 01/01/2001 with tree node corresponding to 01/01/2001 set to

inactive

In this example, the tree node corresponding to 01/01/2001 is set to Inactive. When you run the
nVision report as of 01/01/2001, PS/nVision uses the next nearest active effective-dated record

01/01/1900 for label descriptions.

Tree Hode

SetlD: SHARE  Tree Node: CGSDETAIL
Tree Node Information Find | iew 1 First B 1.2 of 2 Il Last
| B HE
‘Effective Date: 010172001 [ sgpatys: I Inactive "I
| B FHE=
*Effective Date: 017011900 34 -gtatys: | Active ud
‘Description: Cost of Goods Sold Detail
Cost of Goods - Latest Account 1598031 0 1558031
Cost of Goods Sold Detail 1598031 0 1538031

May returns empty label description.
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Image: Report results with empty description

In this example, the descriptions of tree nodes for 01/01/1900 is Inactive and for 01/01/2001 is Active.
When a report is run as of 01/01/2000, PS/nVision displays empty label description in report results.
because none of the descriptions are effective as of 01/01/2000

Tree Node

SetlD: SHARE Tree Hode: CGSDETAIL
Tree Node Information : First T 4.2 0 2 T | ost
[=]
*Effective Date: 01/0152001 [3 squatys: | Active -]
*Description: Detailed Cost of Goods Sold
linacie 5] [=]
*Effective Date: 015011900 E *Satus: Inactive -
*Description: Costof Goods Sold Detail
Cost of Goods Sold 18147 0 18147

13147 0 158147

Note: To avoid having empty descriptions in nVision report results, deselect the AsofDate for Labels
option in the Edit Profile — nVision dialog box of the Configuration Manager.

Defining Directory Paths

You can specify paths containing multiple directory locations for layouts and several other types of files.
Within a path, semicolons separate directory names, and the directories in the path are searched in the
order listed. For example, the layout path might contain:

C:\USER\NVISION\LAYOUT;N:\PS\NVISION\LAYOUT

When PS/nVision starts, it searches the layout directories in sequence for NVSUSER.XLS. If PS/
nVision cannot find it in any of these directories, it looks in the macro directory path. If it cannot find
NVSUSER.XLS, it looks for NVSUSER.XLM. Similarly, when PS/nVision opens or runs a report, it
searches the layout directories in sequence until it finds the layout. The same path options exist for the
Excel installation path, macros, templates, and DrillDown layouts.

In addition, when searching a directory path, PS/nVision looks first for a subdirectory with the name

of language of the current user. This functionality enables users of different languages to share the

same settings while maintaining layouts in multiple languages. For example, if the language setting in
Configuration Manager is French, then PS/nVision searches the following directories in sequence for the
layout directory in the previous example:

C:\USER\NVISION\LAYOUT\FRA
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C:\USER\NVISION\LAYOUT
N:\PS\NVISION\LAYOUT
N:\PS\NVISION\LAYOUT\FRA

Specifying Formatting Options

Chapter 12

The PeopleSoft Query Link portion of PS/nVision uses a standard Microsoft Excel template,
QUERY.XLT, to format data retrieved from a query. QUERY.XLT contains some special styles that you
can personalize. Use the Excel Format, Styles option and save your changes to QUERY.XLT.

Note: The location of QUERY.XLT is specified on the nVision tab of the Configuration Manager in the

Query Templates dialog box.

The following table lists the special PeopleSoft styles that you can apply to QUERY.XLT.

Style Name Data Type Formatted

PSChar Character fields (such as names)

PSDate Dates

PSDec Numbers with decimal places, such as dollar amounts
PSInt Integers (such as years)

PSHeading Column headings

PSSpacer Space between data columns

Personalizing NVSUSER.XLS

144

The NVSUSER worksheet provided by PeopleSoft includes macros to personalize the user menu and

toolbar.

This section describes how to:

* Customize buttons.

* Add buttons with the button wizard.

¢ Customize menus.

¢ Make Excel row and column indicators visible.

* Change the toolbar.

Related Links
Using PS/nVision API Functions
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Customizing Buttons

Each button on the NVSUSER sheets has a macro assigned to it to perform a function. As delivered,
NVSUSER buttons are grouped into Run, View, and Command groups. You can change the groupings
and meanings of the buttons. You can also format the button sheet to personalize its color and appearance.

To change the macro, a button is assigned to:

1. Position the mouse pointer over the button (it becomes a hand), but do not click it.
2. Right-click and select Assign > Macro from the shortcut menu.

3. Enter the name of the macro you want to run when the button is clicked.

4. Click the OK button to complete the assignment.

Note: If you have macros that were created using Microsoft Excel 95, the Excel Edit Name dialog box
appears when you define the name for the cell in which the macro begins. Select the Command-type
option to identify your macro as a Command macro. The Excel Edit Name dialog box does not appear for
later versions of Microsoft Excel.

Adding Buttons With the Button Wizard

To use the button wizard in PS/nVision:
1. Select Start > Programs > PeopleTools 8.x > nVision.
2. Click the Add Buttons from the NVSUSER.XLS home page.
3. Select whether to run a report or view a report, and click the Next button.
4. Select either your report request or your instance.
You can navigate to an instance from the button with ellipses on it.
5. Click the Next button.
6. Type in a caption for your button.

7. Optionally, select a picture for your button by clicking the Image button and navigating to the location
of an image file.

8. Click the Finished button.

The new button is placed directly below the lowest-positioned button in a specific Run or View category.
After initially placed on the sheet, the button can be moved or changed. However, try not to ungroup
buttons with images. If necessary, remember the defined button name before ungrouping; then, when
regrouped, rename the button group accordingly.

To ungroup the button, right-click it, select the ungroup function from the menu, and make your changes.

To regroup, right-click it again and select the regroup function from the menu.
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Access the PeopleSoft nVision Menu Control Table window by clicking the PSMenu tab on the nVision
homepage NVSUSER.XLS.

Image: PeopleSoft nVision Menu Control Table window

This example illustrates the fields and controls on the PeopleSoft nVision Menu Control Table window.

PeopleSoft.

Actions

PS/nVision Menu Customization

1]
PeopleSoft n¥ision Menu Control Table

Update entriez in the table below, then press buttan to re-build the menu. |

Open Report
Open Scope

Open Layout

Personalize
n¥ision

Report
Preferences

Teolbar

Add Buttons

Go to Main Menu

Rebuild Menu | Help |

Menu Name:

Appli-
cation

Aclive

]

P R R e I R e e e e

Menu Command

Business Unit by Period
Business Unit by Account
Business Unit by Department
Business Unit by Product

Account by Period

Account by Departrment

Account by Praduct

Account by Business Unit

Department by Period

Department by Account
Department by Product
Department by Business Unit

Product by Periad
Product by Account

Product by Department
Product by Business Linit

Busziness Unit by Actuals/Buc BusVar
Accounts by Actuals/Budget: Actar
Departments by Actuals/Bud; Dephar
Products by Actualz/Budgets Prdvar

For each command, enter either a
DrillD own Layout, a Query or a
macro.

AR

DrillDown
Lapout

]

Description

DrillD own Query Macro

BusPer EBreakdown by Business Unit and Period
Bushct Breakdown by Business Unit and Account
BusDep Breakdown by Business Unit and Department
BusPrd Breakdown by Business Unit and Product
ActPer Breakdawn by Account and Period
ActDep Breakdawn by &ccount and Deptld
ActPrd Breakdawn by Account and Product
ActBus Breakdown by Account and Business Unit
DepPer Breakdown by Deptld and Period

Depdct Breakdown by Deptld and Account
DepPrd Breakdown by Deptld and Product
DepBus Breakdawn by Deptd and Business Unit
PrdPer Breakdaown by Product and Period

Prdact EBreakdown by Product and Account
FrdDep Breakdown by Product and Department
PrdBus Breakdown by Product and Buginess Unit

Breakdawn by Business Unit and Actual/Budget Variance
Breakdawn by Account and Actual/Budget Variance
Breakdawn by Department and Actual/Budget Varance
Breakdown by Product and Actual/Budget Vaiance

Note: You can select a DrillDown layout, DrillDown query, or a macro to run when a menu command is

selected.

Application Identifies the application that uses this menu item.
This identification makes it easier to enable or disable the
actions associated with an application by setting its Active
option. The Application field is not used by the supplied
macros, but it acts as a description on this page.

Active Enter Y to make the menu item active or N to keep it in the table

Menu Command

DrillDown Layout

DrillDown Query

Macro

146

but deactivated.
Enter the text that appears when the user pulls down the menu.

Select a layout, present in your DrillDown layout path, to be
used in a matrix or tabular DrillDown.

Enter a query name to be used in a PeopleSoft Query Link-style
tabular DrillDown.

Enter the name of a macro to run when the item is selected.
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Description Enter descriptive text to appear in the status bar when a user

highlights the command.

Rebuilding the Menu

To rebuild the menu with new information that has been entered, click the Rebuild Menu button.

Making Microsoft Excel Row and Column Indicators Visible

To make Microsoft Excel row and column indicators visible for both the PeopleSoft menu and toolbar

sheets:
1. Open Microsoft Excel and select Tools > Options from the Excel menu.
2. On the View tab, select the Row & column headers option and click the OK button.
Row indicators /,2,3, and so on. Column indicators 4,B,C, and so on.
3. [Insert or delete rows or columns by clicking a row or column indicator to highlight the row or column.
4. After you have made your changes to the PeopleSoft menu or toolbar sheet, hide the row and

column indicators by clearing the Row & column headers option before you save the modified
NVSUSER.XLS.

Changing the Toolbar

To personalize the toolbar in PS/nVision:

L.

2.

Access PS/nVision and select the Toolbar tab on the nVision homepage NVSUSER .xls.
Optionally, edit the name of the toolbar in the Toolbar Name box.
Set the location of the toolbar in the Docking Position box.

You can enter left, right, top, or bottom to have the toolbar docked accordingly; or you can select
Float to have the toolbar float over the spreadsheet.

Edit the table of tool commands, adding, changing, and deleting items to get the toolbar you want.
For each tool you add or change, specify one of the following actions:

* A layout, present in your DrillDown layout path, to be used in a matrix or tabular DrillDown.
* A query name to be used in a PeopleSoft Query Link-style tabular DrillDown.

¢ The name of a macro to run when the tool button is clicked.

For each tool, specify the following:
* Active: Select Y to make the tool active; select N to keep it in the table but not in the toolbar.

* Face: The name of the picture that identifies the tool. Either use a picture already defined in the
Toolbar worksheet or design your own using a drawing program such as Paintbrush. The picture
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must be 16 pixels square. Copy the picture from the drawing program and paste it into the Toolbar
worksheet. While it is selected, enter a name for it, and enter this name in the Face column.

* Gap: To leave a gap between tools, enter gap in the Face column.
» Status text: Enter descriptive text to appear in the status bar when the mouse rests over the tool.

* Tip text: Enter a brief description to appear in a tool tip when the mouse rests over the tool.

7. When the table is as you want it, click Rebuild Toolbar to build the new toolbar.

Setting Report Preferences

NVSUSER enables you to store personalized, categorized report requests. You can quickly view
frequently used requests by category and run them with a click of a button. One NVSUSER can be stored
on a remote server location and still enable individual users to view requests from any client workstation.
In addition, you can view and copy other users’ Report Request preferences if given the proper security
access to alleviate the redundancy setup process.

This section describes how to:
» Set report request preferences.
* Copy a user’s report request preferences.

* Customize the report instance view.

Setting Report Request Preferences

148

Use the Personal Report Settings dialog box to set report request preferences in PS/nVision.
Image: Personal Report Settings dialog box

This example illustrates the fields and controls on the Personal Report Settings dialog box.

Personal Report Settings E'
Eusiness Unik Frarn Lisk To Lisk
| QEEU1 j EMPDEPT1 EMPLOYEE — QEBU1l EMPL
Category add =
| EMPL b
ok = Remove
Cancel
‘ | B

To set report request preferences in PS/nVision:
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1. Open PS/nVision and click the Report Preferences menu button on the NVSUSER .xIs home page.
The Personal Report Settings dialog box appears.

2. Select an appropriate business unit.

3. Optionally, enter a new category or select an existing one.

4. Select the reports you want for that category, and click the Add or the Remove button.

5. Click the OK button.

The information is stored in the NVSReports tab of NVSUSER .xls.

Copying a User’s Report Request Preferences
To view or copy another user’s report request preferences in PS/nVision:
1. Open PS/nVision, and click the Operator button on the NVSUSER .xls home page.

A dialog box appears with a drop-down list of all users who have already set and stored report request
preferences on this NVSUSER .xls.

2. Select a user from the list to access that user’s report references and personalized categories.
3. Click the Copy button to copy the other user’s preferences.

4. Click the Report Preferences button to see your report settings.

Note: When you copy another user’s preferences, your previous preferences are deleted. You cannot
change another user’s report request preferences without copying them first.

Customizing the Report Instance View

From the NVSUSER home page, you can pull in report instances from folders that you specify. You

can then select reports from the list and open them without having to navigate through a file directory
system. For example, if a series of report books were being run overnight and placed into a common file
location, a manager could log in to the NVSUSER home page and all the reports would be pulled from
the specified directories.
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Image: View Reports group box

This is an example of the View Reports group box from the NVSUSER xIs home page.

View Report(s)

[——
CAUSERMMVISIOMMMNSTAMCENRLUM_MWH s
CAUSERSMWVISIOMMMNS TAMCENRUM_MWS s

To personalize the report instance view in the Configuration Manager:

1. Select Start > Programs > PeopleTools 8.x > Configuration Manager.
2. Select the Profile tab from the Configuration Manager dialog box.

3. Select the profile to change and click the Edit button.

4. Select the nVision tab in the Edit Profile dialog box.

5. Enter or navigate to the location of your report instance files.

You can have more than one folder listed, but they must be separated by semicolons. However,
Microsoft Excel has a limit of 255 characters.

Customizing Delivered Visual Basic Application Wizards

NVSUSER delivers Visual Basic Application (VBA) forms to perform functions ranging from storing
information in the PeopleSoft system to creating a button to run a report. To find the VBA forms in PS/
nVision, open an report layout and select Tools > Macros > Visual Basic Editor from the Excel menu bar.

The VBA forms provide several examples of using Visual Basic PeopleSoft APIs to personalize PS/
nVision. These features can add depth to your reporting ability.

Several VBA wizards take advantage of the PeopleSoft Open Query method to pull information from the
PeopleSoft system. To use this method, you need to create a query in the PeopleSoft system.

VBA forms also pass prompt values to the queries. The following table lists the queries that PS/nVision
accesses and the wizards that use the listed queries.

Query VBA Wizard
NVS_OPERATORS NVSUSER xls
NVS_PERSNL_RPTS NVSUSER xIs, Personal_Settings
NVS CATEGORY NVSUSER xls, Personal Settings
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Query VBA Wizard

NVS RPT ID Personal_Settings, Button Wizard

NVS_MENU PSDrill

NVS_MENU_BAR PSDrill

NVS_MENU_ITEM PSDrill

NVS MENU PANEL PSDrill

NVS_MENU_PNL_KEYS PSDrill

Related Links

Using Designer Object Methods
Designer Object Methods
Using Session Object Methods
Session Object Methods
Instance Hooks

Changing the Startup File

When you start PS/nVision, it opens NVSUSER.XLS by default. If it cannot locate NVSUSER.XLS, it

looks for the NVSUSER.XLM file.

If you start PS/nVision from a Microsoft Windows shortcut, you can specify a different startup file in
the PS/nVision command line. Include the -SF argument followed by the name of the startup file. For
example, to have PS/nVision open the file NVSDEV.XLS, enter a command similar to the following in
the Target edit box in the Properties dialog box for the shortcut:

c:\pt800\bin\client\winx86\psnvs.exe -SFNVSDEV.XLS

This feature enables you to provide different startup files for different classes of users.

Note: PS/nVision searches for the startup file in the same directories where it looks for its default startup

file.

Related Links

Using Configuration Manager

Using PS/nVision API Functions

PS/nVision has an API function interface. The Excel macros that you write can use these functions to gain

access to PS/nVision features.
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Note: In Microsoft Excel, there are two macro programming languages: Microsoft Visual Basic for
Applications (VBA) and the Microsoft Excel 4.0 macro language. VBA is recommended over Excel
4.0 macros because VBA is more flexible and more powerful than the Excel 4.0 macros. In addition,
Visual Basic may be the only programming language offered in future versions of Microsoft Excel. The

following API functions can only be invoked from Microsoft Excel 4.0 macros.

To use nVision functions from VBA, see Using Designer Object Methods, Designer Object Methods,

Using Session Object Methods, Session Object Methods, Instance Hooks.

The following table lists and describes the API functions, which may not be run within a macro called via

NvslnstanceHook.

Interface Function

Purpose

Arguments

Example

NvsAutoDrill

Performs an AutoDrill, similar
to selecting the AutoDrill
menu item. AutoDrill is

only usable in reports based
on queries, and in ledger-
based reports for which

the NvsDefaultDrill name

is defined in the layout,
specifying the name of the
layout to run as an AutoDrill.

None

=NvsAutoDrill()

NvsDrillDown

Start a matrix DrillDown.
Similar to using the
DrillDown item on the
nVision menu. The user
selects a DrillDown layout
from the Open dialog box.

None

=NvsDrillDown()

NvsDrillLayout

Run a matrix DrillDown using
a specified layout.

Layout name

=NvsDrillLayout("ACTPER.
XNV")

NvsDrillQuery

Run a tabular DrillDown
using a specified query.

Query name

=NvsDrillQuery("Journals")

NvsJumpBack

Return to the sheet and cell
from which the current sheet
drilled down (same as the
Jump Back command).

None

=NvsJumpBack()

NvsLayoutDefn

Show the PeopleSoft nVision
Layout Definition dialog box
for the selected row, column,
or cell. This is the equivalent
of the nVision > Layout
Definition menu item.

None

=NvsLayoutDefn()

NvsNewLayout

Create a new layout. Similar
to using the nVision > New
Layout menu item.

None

=NvsNewLayout()
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Interface Function

Purpose

Arguments

Example

NvsOnWindow

Activate PS/nVision menus
for the current window. This
activation is required when
your macro opens a sheet,
since Microsoft Excel does
not signal PS/nVision that the
new sheet has been activated.

None

=NvsOnWindow()

NvsOpenFile

Open a Microsoft Excel
worksheet, waiting if
necessary in case another
user on the network is
accessing the file. If the

file opens successfully, call
NvsOnWindow to update
menus. Optional arguments
say whether to update links to
other documents and if file is
to be opened read-only.

filespec, updlinks, read-only

=NvsOpenFile ("FSDEMO.
XLS", TRUE, FALSE)

NvsOpenLayout

Open a layout. Similar to
using the nVision > Open
Layout menu item.

None

=NvsOpenLayout()

NvsOpenReport

Open a report request. Similar
to clicking the Open button in
the PeopleSoft nVision Report
Request dialog box.

None

=NvsOpenReport()

NvsOpenScope

Open an existing scope
definition. Similar to clicking
the Open button in the
PeopleSoft nVision Scope
Definition dialog box.

None

=NvsOpenScope()

NvsReDrill

Repeat the most recent
DrillDown from the currently
selected amount cell.

None

=NvsReDrill()

NvsReport Request

Display the PeopleSoft
nVision Report Request
dialog box. This activation
is similar, to the nVision >
Report Request menu item.

None

=NvsReportRequest()

NvsRunCurrent

Runs the current report.
This activation is similar to
the nVision > Run Current
Report menu item.

None

=NvsRunCurrent()

NvsRunQuery

Run a specified query, without
inheriting DrillDown criteria.

Query name

=NvsRunQuery ("AP
Journals")
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Interface Function

Purpose

Arguments

Example

NvsRunReport

When used without a
parameter, prompts the user
to select a report to run,

and then runs the selected
report. With a parameter, runs
a specified matrix report,
without showing the report
key dialog or Report Request.

Business Unit, Report ID

=NvsRunReport() ("M04",
"ISDEMO")

NvsSaveAsLayout

Prompt user to save the
layout with a new name.
This activation is similar to
using the nVision > Save As
Layout menu item.

None

=NvsSaveAsLayout()

NvsScopeDefn

Open the PeopleSoft nVision
Scope Definition dialog box.
This activation is similar to
using the nVision > Scope

Definition menu item.

None

=NvsScopeDefn()

This table lists the nVision command line parameters and their corresponding fields in the Define Report

Request page.

Parameter Corresponding Field
NRN Report ID

NBU Business Unit

NLN Layout

NRT Report Title

NSN Report Scope

NDT Directory Template
NFT File Template

NLT Language

NET Email Template

NDET Content Description Template
NAT Security Template

NPF Folder Name

NTM Time-out Minutes
NRET Retention Days
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Parameter Corresponding Field

NRB Data From Requesting B.U. Only

NEN Enable nPlosion If Specified In Layout

NTL Translate Summary Ledgers to Detail

NADO As Of Reporting Date

NTDO Tree As Of Date

NASD As of Reporting Date (for specify option)

NTED Tree As Of Date (for specify option)

NHL
Note: This parameter is the generated hyper link.

NDL
Note: This parameter indicates whether the output options are
overridden on the Process Scheduler Request page.

This example shows the nVision command line parameters used in the Define Report Request page:

PSNVS.EXE -CTORACLE -CDT853IB02 -COVP1l -CP%OPRPSWD$ -R" " -I10502 -OT6 -OF8 -OPDist=
ribution List -NRNFSDETAIL -NBUUS001l -NHLhttp://gt-ibml2.us.oracle.com:17320/psp/t8=>
53ib02x newwin/EMPLOYEE/QE IBTGT/c/REPORT BOOKS.IC RUN DRILLDOWN.GBL?Action=A -NDLO=
-NLN"FSDETAIL" -NRT"Detailed Financial Statement" -NSNDEPTID -NRBY -NENY -NTLY -NA=
DOU -NASD1999-12-31 -NTDOR -NTED -NDT"C:\TEMP" -NFT"$RID%.XLS" -NLTDUT -NETnvs@peop=
lesoft.com -NDET"SRTTS" -NATU:VP1 -NPFGENERAL -NOT6 -NOF8 -NTM10 -NRET2

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.

155



Personalizing PS/nVision Chapter 12

156 Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 13
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Using Designer Object Methods

Note: You can develop powerful Visual Basic applications (VBA) with the PS/nVision Visual Basic
programming interface. The objects and related methods referenced in this section provide the ability to
call PS/nVision features programmatically for common reporting and analysis tasks.

Object methods are listed in order based on their functionality.

Creates an instance of PS/nVision as in the following example:

Dim objnVision As Object

Dim objDesignerCmd As Object

Dim strAppName As String

strAppName = "PSnvision.nvsdesigner"

Set objnVision = CreateObject (strAppName)
Set objDesignerCmd = objnVision.DesignerCmd

After you finish with the Designer object, clear the PS/nVision object by setting it equal to nothing, as in
the following example:

Set objnVision = Nothing

Designer Object Methods

The following shows details of designer object methods.

Connect

Syntax

Connect ([in, optional] BSTR startMacro)

Description

This method enables the user to sign on to the PeopleTools application.

Example

‘' Straight Connection
objDesignerCmd.Connect

' Connection and run macro
objDesignerCmd.Connect ("MacroName")
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Disconnect

Description

This method enables the user to sign off from the PeopleTools application.

Example

objDesignerCmd.Disconnect

ResetEnvironment

Description

This method resets the working directory and other environment settings needed for PS/nVision to
process reports.

Example

objDesignerCmd.ResetEnvironment

StartMenu

Description

This method causes the designer to register its menu within the grid.

Example

objDesignerCmd.StartMenu

OnWindow

Description

This method refreshes the designer window, including PS/nVision menus.

Example

objDesignerCmd.OnWindow

OpenFile

158

Syntax

OpenFile([in] BSTR filename, [in, optional] BOOL updatelinks, [in, optional] BOOL
readonly)

Description

This method opens a new or existing PS/nVision report layout.
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Parameters

There are three arguments associated with this method: the file name (with full path) and two optional

arguments: update links and read-only.

Example

ObjDesignerCmd.OpenFile ("c:\user\BALANCE.x1s",

OpenLayout

Description

This method opens an existing layout.

Example

objDesignerCmd.OpenLayout

NewLayout

Description

This method creates a new layout.

Example

objDesignerCmd.NewLayout

SaveAslLayout

Description

This method saves the worksheet as a layout.

Example

objDesignerCmd. SaveAsLayout

DefineLayout

Description

This method invokes the PeopleSoft nVision Layout Definition dialog box.

Example

objDesignerCmd.DefinelLayout
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LayoutOptions

Description

This method invokes the PeopleSoft nVision Layout Options dialog box.

Example

objDesignerCmd.LayoutOptions

ReportRequest

Description

This method opens an existing report request.

Example

objDesignerCmd.ReportRequest

RunCurrent

Description

This method runs a defined or previously opened report request.

Example

objDesignerCmd.RunCurrent

RunReport

160

Syntax

RunReport ([in] BSTR BusUnit, [in] BSTR RptRgst)

Description

This method runs a specific report.

Parameters

Chapter 13

There are two arguments required for this request: business unit and report request name. The report

request must be in uppercase letters.

Example

objDesignerCmd.RunReport ("M04", "BALANCE")
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Options

Description

This method to opens the PeopleSoft nVision Options dialog box.

Example

objDesignerCmd.Options

PerfOpts

Description

This method is same as LayoutOptions with just one selection.

Example

objDesignerCmd.PerfOpts

OpenScope

Description

This method displays the PeopleSoft nVision Open Scope dialog box and then the PeopleSoft nVision
Scope Definition dialog box, assuming the user selects a scope.

Example

objDesignerCmd.OpenScope

ScopeDefn

Description

This method invokes the PeopleSoft nVision Scope Definition dialog box.

Example

objDesignerCmd.ScopeDefn

DrillDown

Description

This method initiates DrillDown sequence.

Example

objDesignerCmd.DrillDown
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DrillLayout

Description

This method performs a DrillDown using the specified child layout.

Example

objDesignerCmd.DrillLayout

AutoDirill

Description

If a default DrillDown layout is defined (as DefaultDrill) in the active instance, drills down using that
layout.

For ledger reports, the default drill string may include a D, which indicates that any summary ledgers
should be translated to detail. If no default layout is defined, for a query-based instance, drill down to that
query in DrillQuery (QueryLink) mode. For a ledger-based instance, have the user select the DrillDown
layout, as in DrillDown.

Example

objDesignerCmd.AutoDrill

ReDrill

Description

This method drills the selected cell using the most recently selected DrillDown layout.

Example

objDesignerCmd.ReDrill

DrillQuery

Description

This method performs a DrillDown using the specified query.

Example

objDesignerCmd.DrillQuery

JumpBack

162

Description

This method implements commands to activate the parent instance of the current child DrillDown.
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Example

objDesignerCmd.JumpBack

RunQuery

Description

This method runs the specified query with no inherited criteria, and is not used for DrillDown.

Example

objDesignerCmd.RunQuery

Using Session Object Methods

This object retrieves information about the current session.

The following is an example.

Dim objnVision As Object

Dim objSessionCmd As Object

Dim strAppName As String

Dim strDatabaseType As String

strAppName = "PSnvision.nvsdesigner"

Set objnVision = CreateObject (strAppName)
Set SessionCmd = objnVision.SessionCmd

After finishing with the session object, clear the PS/nVision object by setting it equal to nothing, as in the
following example:

Set objnVision = Nothing

Session Object Methods

The following shows details of the session object methods.

DBType

Description

This property retrieves database types for the current session.

Example

strDatabaseType = SessionCmd.DBType
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DBName

Description

This property retrieves the database’s name for the current session.

Example

strDatabaseName = SessionCmd.DBName

ToolsRelDB

Description

This property retrieves the tool release database version for the current session.

Example

strToolReleaseDatabase = SessionCmd.ToolsRelDB

ServerName

Description

This property retrieves the server’s name for the current session. It retrieves nothing if the user is logged
on in two-tier.

Example

strServerName = SessionCmd.ServerName

Oprid

Description

This property retrieves the user’s ID for the current session.

Example

strOperatorId = SessionCmd.OprId

TwoTier

Description

This property identifies whether the current session is two-tier. If the return value is TRUE (or a value of
1), the current session is two-tier.

Example

bTwoTier = SessionCmd.TwoTier
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ShowWarnings

Description

This property retrieves or sets a ShowWarnings option for the current session.

Example
Retrieve Example:

Dim bShowWarnings As Boolean
bShowWarnings = SessionCmd.ShowWarnings

Set Example:

Dim bShowWarnings as Boolean
bShowWarnings = True
SessionCmd.ShowWarnings = bShowWarnings

AmountSql

Description

The AmountSql property retrieves or sets an Amount SQL option for the current session.

Example

Retrieve Example:

Dim bAmountSgl As Boolean
bAmountSgl = SessionCmd.AmountSqgl
Set Example:

Dim bAmountSgl as Boolean
bAmountSqgl = True
SessionCmd.AmountSqgl = bAmountSqgl

ReadConfig

Syntax

ReadConfig([in] BSTR ConfigDir)

Description

This method retrieves the directory paths of a given PS/nVision Configuration Manager setting (as
defined in the Windows Registry). If the user has multiple directory paths in the same configuration
setting, it retrieves them all. The available configuration settings that can be retrieved are:

* InstanceDir
* LayoutDir

*  TemplateDir
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L]

MacroDir
StyleDir

DrillDownDir

Example

Dim strDirPath as String
strDirPath = SessionCmd.ReadConfig("LayoutDir")

ReadConfigDir

Syntax

ReadConfigDir ([in] BSTR ConfigDir, [in] WORD nPosition)

Description

This method retrieves one directory path of a given PS/nVision Configuration Manager setting (as defined
in the Windows Registry). This method differs from the ReadConfig method: it parses out the list of
available directories by providing a number representing the position of the directory in the list.

For example, if you had two directories, such as c: \user\nVision\layout and c:\user, and
you wanted just the ¢ : \user directory, you would pass in the number two. If the user is looking for
the second directory and there is only one, then nothing is retrieved. The list of available configuration
settings that can be retrieved is as follows:

InstanceDir
LayoutDir
TemplateDir
MacroDir
StyleDir

DrillDownDir

Example

Dim strDirPath as String
strDirPath = SessionCmd.ReadConfig("LayoutDir", 2)

This retrieves the second directory listed.

Instance Hooks

166

Beginning with Excel 97, Microsoft began using Visual Basic as the programming language to write
macros. In earlier versions of Excel, you had to create a macro sheet to use the NvsInstanceHook. Now,
whether recording your macro or writing Visual Basic code within the Visual Basic Editor, you can
invoke the PS/nVision Instance Hook directly from the module within a Visual Basic project without
having to create a macro sheet.
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Note: NvsInstanceHook is not supported in OpenXML mode.

Instance hooks enable user-written macros to be executed by PS/nVision after delivering the data to a
report instance but before saving the instance. Instance hooks are supported for both matrix and tabular
layout sheets. With an instance hook, you can:

* Refresh a pivot table based on data delivered in the instance.
* Change the delivered outline level.
For example, compress reports so the user starts with the top level.
* Apply subtotals or AutoFilter to data delivered in a tabular instance.
* Do high-level zero-suppression or resort data.
» In general, use Excel features that can't be applied in the layout because they require data.

Within an Instance Hook macro, you can call any other Visual Basic methods or functions. But you
should avoid calling PS/nVision functions and closing Excel.

To use instance hooks, identify the layout sheets in the layout workbook (. XNV file) to which you want to
apply post-delivery processing. For each sheet, define the name NvsInstanceHook to refer to the name of
the first cell of an Excel 4 macro sheet or the name of a Visual Basic procedure.

The defined name NvsinstanceHook is sheet-specific. You need to either define the same name on
multiple sheets or, the preferred method, enter the sheet name and an exclamation point (!) with the
name when defining it. By doing this you can fire different macros for different layout sheets in the same
workbook. The resulting name looks like Sheet1!NvsInstanceHook.

To record a macro from within Microsoft Excel, select Tools > Macro > Record a Macro.

To write a macro from within Microsoft Excel, select Tools > Macro > Visual Basic Editor.
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Image: A sample macro

Chapter 13

This example shows a module that combines a recorded macro with additional code that has been added
through the editor.

i File  Edit

. E'H' Ia —Jlﬁéﬂlq

Project - YBAProject

= = =] B

View Insert  Farmat

<l Microsoft Visual Basic - n¥ision_1.xnwv
Debug  Run
0@ b2 B e k| @) ines, col 1

Tools

I3

- n¥ision_1.xnv - Modulel (Code)

add-Ins  windomw  Help

|[General}

ﬂ |I'|.|'Ia|:rn1

+ ﬁ Nysuser (Nvsuser.xls)
= ‘@ ¥YEAProject {n¥ision_1.xnv)
=25 Microsoft Excel Objects
EH] Sheetl (Sheetl)
& Thisworkbook
-5 Modules
#22 Modulel
+ ﬁ ¥EBAProject {n¥ision_2Z_xnv)
+ ‘@ YEAProject (Nvsgo.xla)
+- &% VBAProject (Sheet1)

Sub Macroll)

' Macrol Macro
' Macro recorded 6/12/2009 hy Internal Systems

Sub Boldi()
Range ("E4:P4™") . 3elect
Zelection.Font.EBold =
With 3Felection

True

JHorizontaldlignment = x1Right
Merticaldligrment = x1Bottom
.WrapText = False

.Qrientation = 0

.ShrinkToFit = False
MergeCells = False

AotivelSheet . Outline.Showlevels Rowlewvels:=1
AotivelSheet . Outline.Showlewvels Columnhlewvels:=1

Aotivellorkbook. Save
End With
End Zub

The macro applies bold and right-aligns the nPloded TimeSpan columns, collapses the outline of the
nPloded rows and columns, and saves the instance.

After creating the macro module, return to your PS/nVision layout and attach it using NvsInstanceHook.

To attach a macro using NvsInstance Hook in PS/nVision:

1. Select the cell in the layout in PS/nVision.

2. Select Insert > Name > Define from the toolbar.

For the name, enter the sheet name followed by an exclamation point and the text NvsInstanceHook.
For example, Sheet 1!NvsinstanceHook.

3. Enter the name of the macro in the Refers fo field.

For the name, enter the name of Excel Visual Basic Module, where the macro is located, followed by
a period and the name of the Excel VB Macro. For example, Modulel . MacroName.

4. Click the Add button.

5. Click the OK button.

Your macro is executed after the PS/nVision Instance is created.
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Securing PS/nVision Elements

This section describes how to:

* Secure PS/nVision menu items.

*  Secure report layouts.

e Secure and share report requests in PIA.

* Secure and share report request in Windows client.

Securing PS/nVision Menu Items

Use the Page Permissions page (ACL_PAGES2) in PeopleSoft Security to specify the page permissions
that control the operations users can perform in PS/nVision. Authorizations specified at the Page
Permissions page are applied to both the Windows client and the PeopleSoft Pure Internet Architecture
(PIA).

Navigation

PeopleTools > Security > Permissions and Roles > Permission Lists > Pages
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Image: Page Permissions page

This example illustrates the fields and controls on the Page Permissions page.

Page Permissions

MYWISION [ nvision F Define Layout

Pages Customize | Find | IEI| i First Kl 10of 1 > Last m

[Paneltembame | Authorized? | Display Oniy Add

Define Layout " UpdateDisplay
UpdateDisplay All
Correction

Select All |
Deselact All |

QK | Cancel |

To set component permissions in PIA:

1. Select PeopleTools > Security > Permissions & Roles > Permission Lists.
2. Select the required nVision Permission list.

3. Select the Pages tab.

4. Click the Edit component link, corresponding to the required menu, to display the Component
Permissions page.

5. Click the Edit Pages button for a component to display the Page Permissions page.
6. Change the settings to authorize the action or leave the settings as display-only.

When selecting page permissions, you must select both an action and the Authorized option. For
example, when you allow a user to run report requests, you must select the Update/Display button and
the Authorized option adjacent to the RUN_ REPORT page name on the Page Permissions page.

7. Click the OK button.

Important! If no items are authorized, you cannot run PS/nVision at all.

nVision is controlled through individual components associated with the REPORT BOOKS and
NVISION menus.

The following table lists the available PS/nVision page permissions and describes the actions they control.
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Page Permission

Action Controlled

DEFINE LAYOUT

Allows the user to use the Open Layout, Layout Definition,
and similar menus in Excel.

OPEN_REPORT

Enables the Open button in the PeopleSoft nVision Report
Request dialog box on the Windows client.

EDIT_REPORT

Allows the user to modify values in the PeopleSoft nVision
Report Request dialog box.

Note: The EDIT REPORT setting does not control access
to report layout (Excel XNV) files. To restrict users from
accessing XNV files entirely, use the Network Security
settings.

RUN_REPORT Allows the user to run report requests using the Run button in
the PeopleSoft nVision Report Request dialog box, the Run
Current Request menu item in the Windows client, and the
Run button in the web report request.

SAVE REPORT Enables the Save button in the PeopleSoft nVision Report

Request dialog box on both the Windows client and the web.

Note: When you make changes to a report request, it is
automatically saved when you run the request. To save a report
request without running it, click the Save button. You cannot
change a report request without saving it.

DELETE REPORT

Enables the Delete button in the PeopleSoft nVision Report
Request dialog box on both the Windows client and the web.

OPEN_SCOPE Enables the Open button in the PeopleSoft nVision Scope
Definition dialog box on the Windows client.

EDIT SCOPE Allows the use to modify values in the PeopleSoft nVision
Scope Definition dialog box on the Windows client.

SAVE_SCOPE Enables the Save button in the PeopleSoft nVision Scope

Definition dialog box on the Windows client.

DELETE SCOPE

Enables the Delete button in the PeopleSoft nVision Scope
Definition dialog box on the Windows client.

PERFORMANCE OPTS

Enables the nVision Performance menu item, by which you
access the Tree Performance Options dialog box.

Related Links

"Understanding Permission Lists" (PeopleTools 8.56: Security Administration)

"Managing Permission Lists" (PeopleTools 8.56: Security Administration)

"Defining Permissions" (PeopleTools 8.56: Security Administration)
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Securing Report Layouts

Report layouts (XNV files) are stored on a file server and not in the PeopleSoft database. Set up network
security so that only appropriate users are able to modify or delete report layout (XNV) files in the report
layout directories of the network.

With web-based PS/nVision reporting, reports launched from the browser are run through PeopleSoft
Process Scheduler and executed on a report server. The file server that stores the layouts is associated
with the report server.

A report server is a Windows NT machine with PS/nVision (PeopleTools client software), Microsoft
Excel, and PeopleSoft Process Scheduler installed. Process Scheduler selects the layout from the PS/
nVision layout directory path defined in the Process Scheduler configuration. If you restrict access to
this directory on the report server, unauthorized users cannot modify shared report layouts. Additionally,
access to the PS/nVision directories on the Process Scheduler report server should be restricted.

If the report is run using the Windows client, a user authorized to define layouts can point to the PS/
nVision layout directory (as defined in Configuration Manager) on the local drive and then modify and
save the layout.

If a user has a PS/nVision user profile defined in PeopleSoft Security where only RUN_REPORT is
selected, and all other settings (for example, EDIT _REPORT, SAVE REPORT) are cleared, the user
cannot create a new report request, because the Save button is disabled.

Note: When the report request is run, access to ledger or record data itself is still controlled by the row-
level security defined for that user.

Related Links
"PeopleSoft Process Scheduler" (PeopleTools 8.56: Process Scheduler)

Securing and Sharing Report Requests in PIA

172

You can either share and secure nVision reports in PIA or in Windows client.

In web-based PS/nVision reporting, the procedures and processes used to run a report are performed using
the different pages of the Report Book menu. Those actions include defining and running report requests,
defining and running report books, defining scopes, and running DrillDowns. You can control access to
these menu items and customize the pages to allow users restricted access to certain report requests.

Note: For the Scope and Delivery Templates link on the nVision Report Request page

(NVS_REPORT_ RQST), the system automatically displays an nVision output option page based on

the output type. Security permissions for these secondary pages are inherited from the parent Report
Request page, and the Display Only option set in the nVision Report Request component for these pages
is ignored.

By default, only the creator of a report request has full access to that request. The creator can select
to share the report request with other users or to change the access mode using the Share This Report
Request link on the nVision Report Request page.

You can select Reporting Tools > PS/nVision > Define Report Request to access the nVision Report
Request page. In this page, click the Share This Report Request link to display the nVision Share Report
Request page, where report request creators can view or change the access mode.
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Note: You can share and secure nVision reports either in PIA or in Windows client.

Image: nVision Share Report Request page

This example illustrates the fields and controls on the nVision Share Report Request page. Definitions for
the fields and controls appear following the example.

n¥ision Share Report Request

Business Unit: GEBL1 ReportlD: EMPLOYEE

Last Update User ID: Last Update Date/Time:

Access Mode

) Public ) Secured

Report Request shared i
witth' : Customize | Find | Wiewe A IEll i Fit =t [ (] 1of 1 n Last

1| User v|  [aEDMO Q [=]

] Cancel

Access Mode Specifies the access availability for the report request. Select the
Public option for all users to view or modify the request. Select
the Secured option to specify which users have full access to the
report.

By default, users have the right to share report requests and
access the Security Report Request page. You can change the
default value using the Use Secure Rep Rqgst in nVision (Use
Secure Report Request in nVision) option on the PeopleTools
Options page to restrict the users with this right.

See "PeopleTools Options" (PeopleTools 8.56: System and
Server Administration).

Note: If you change the access mode from secured to public,
all the users and groups who had access to the report will be
removed. If you then change the access mode back to secured,

you will need to reassign the users and groups.
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ID Type Select the User option to add a user, or the Role option to add a
user role.
Distribution ID Enter a valid user or role name, or select one from the list. You

can add more users by clicking the + sign. If you selected User
from the ID Type list, valid users appear; if you selected the
Role option in the ID Type field, user roles appear.

Since report requests are keyed by business unit, the business unit validation is done for each shared user
or role when a report request is opened. If a user or role does not have access to a business unit, that user
does not have access to the report request even if she or he is given access through the Access Mode page.

Note: If a report book contains a report request to which a user does not have access, that user will not be
able to view that report request. A message appears when the user opens the report book.

In Windows-client PS/nVision reporting, you can use the PS/nVision VBA interface to programmatically
create a customized report request that will restrict users to certain parameters and functions of the report
requests.

Administering Report Requests

Use the nVision Report Request Admin page to administer your report requests, including:
* Removing a request.

» Transferring a request from one user to another.

e Making a request public.

Navigation

PeopleTools > Utilities > Administration > nVision Report Request Admin

Image: nVision Report Request Admin page

This example illustrates the fields and controls on the nVision Report Request Admin page. Definitions
for the fields and controls appear following the example.

nVision Report Request Admin

Maove Report Request |

Source User ID:

Target User ID: Transfer Report Request |

) a
No.Of records affected: Make Report Request F'ubliu::|
Source User ID The user whose report requests will be administered.
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Target User ID The user ID to which the selected report requests will be
transferred if the Transfer Report Request button is clicked.

No. of Records Affected The number of records that will be affected (moved, transferred,
or made public) by the selected operation.

Move Report Request Click to remove the source user's report request.

If the report request is not shared by any other user, the report
request will be deleted. If the report request has been shared by
users other than the source user, only the source user will be
removed.

Transfer Report Request Click to remove the source user from the report request and
grant access to the target user.

Make Report Request Public Click to make all report requests owned by the source user
available for any user to view and edit.

Related Links

"Understanding Permission Lists" (PeopleTools 8.56: Security Administration)
"Managing Permission Lists" (PeopleTools 8.56: Security Administration)
"Defining Permissions" (PeopleTools 8.56: Security Administration)

Securing and Sharing Report Requests in Windows Clients

In Windows Client of PeopleSoft nVision, you have the flexibility of making report request either public
or private. By default, all nVision report requests created in Windows clients are public.

All users who create and view reports must have the required privileges to use the Business Unit from
which the reports are generated. If the report creators define the report as secured, other users can use

the secured reports only if the report creators have transferred the reports to them. For example, if user A
creates a report request and shares it with user B, then only user B will have access to that report request.
However, in the same client session, if the Open PeopleSoft nVision Report Request dialog box or the
PeopleSoft nVision Report Request dialog box still retains the shared report request information, user A
will have a temporary access to the shared report request. When these dialog boxes are refreshed with
other report requests information or the client session is closed, then user A will no longer have the access
to the shared report request.

Report creators can use the nVision Share Report Request dialog box to change the access mode of
reports from public to private, and vice versa.
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Image: nVision Share Report Request dialog box

This example illustrates the fields and controls on the nVision Share Report Request dialog box.

PSn¥ision Share Report Request PE|
R eport Detailz
Buzsiness Unit QEBLA Report 1d R _MWH
zer Id LEDMO Last Updated Tirme 12-06-2009 15:15:35

b

Accezs Mode
" Public * Secured

Feport Request Shared with

“Distribution |D |

QEDMO

| ak. | Cancel

Securing Report Requests in PS/nVision Windows Clients

To secure report requests in PS/nVision Windows clients:

1.

Select nVision > Report Request from the nVision toolbar.

The PeopleSoft nVision Report Request dialog box appears.

Enter the required values for the new report request, and click the Save button.
Click the Run button to generate the report instance.

Select nVision > Share Report Request from the nVision menu.

The Share Report Request dialog box appears.

Accept the default settings of Secured.

Double-click the ID Type field.

A list of contain values for ID type appears.

Select an user to share this report instance with.

Alternatively, select a roles to share this report instance to users with certain roles.
After selecting ID type or role, double-click the Distribution ID field or the Distribution List field.

If the ID type cell is User, a list of users appears. If the ID type cell is Roles, a list of roles appears.
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Optionally, repeat step 6 to 8 for adding other users and roles.

10. Click the OK button to make the report instance secured.

Sharing Report Requests in PS/nVision Windows Clients

To share report requests in PS/nVision Windows clients:

L.

Select nVision > Report Request from the nVision toolbar.

The PeopleSoft nVision Report Request dialog box appears.

Enter the required values for the new report request, and click the Save button.

Click the Run button to generate the report instance.
Select nVision > Share Report Request from the nVision menu.
The Share Report Request dialog box appears.

Select the Public option to make the report instance public.

A message appears for confirmation of this report instance to be available to all users.

Click the OK button to make the report instance public.

Alternatively, click the Cancel button to keep the report instance secured and viewed only by the

shared users.

Removing User or Role From the Secured Distribution List

To remove an user or a role from the secured distribution list:

L.

Select nVision > Report Request from the nVision toolbar.

The PeopleSoft nVision Report Request dialog box appears.

Enter the required values for the new report request, and click the Save button.

Click the Run button to generate the report instance.
Select nVision > Share Report Request from the nVision menu.
The Share Report Request dialog box appears.

Select the required user to be removed, and click the Delete button.

Alternatively, select the required role to be removed, and click the Delete button.

Click the OK button to confirm that the selected user or role will be deleted.

Optionally, repeat step 5 and 6 for removing other users and roles.

Setting Report Request Admin

Report creators can also use the PS/nVision Report Request Admin dialog box to transfer the private

reports to other users for use.
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To access the PS/nVision Report Request Admin dialog box:
1. Open nVision client by selecting Start > Programs > PeopleSoft 8.x > nVision.
2. Create a new nVision report, or open an exiting one.
3. Select nVision > Transfer Report from the menu.
The PS/nVision Report Request Admin dialog box appears.
Image: nVision Report Request Admin dialog box

This example illustrates the fields and controls on the nVision Report Request Admin dialog box, which
enables report creators to move reports from one user to another user.

PS/n¥ision Report Request Admin

Sz User tove Report Bequest
T User 1D Tranzfer Report Request

Mo of Records Effected. |

b ake Report Public:

Securing Report Distribution
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You have different security considerations for distribution based on the type of output: file, email, or web.

When you output reports as files, remember that files are stored in the directories and files that you

specified in the directory templates and file templates. These directories and files are on your file server
and are not stored in the PeopleSoft database. You must set up network security to map the accessibility
of the reports and ensure that unauthorized users do not have access to these reports on your file server.

When you output reports as email, you control who receives the reports using the email template in the
report request. You can specify precise email addresses in the email template, or indirectly specify email
addresses by user ID or role ID. If you specify your email recipients using role or user IDs, then the email
addresses from those profiles are used.

When you output reports via the web, the reports are distributed through Report Manager. You control
who receives the reports using security templates in the report requests. If nothing is entered in the
security template, the default recipient is the user who runs the report.

You can associate a scope with the email template or the web security template using %DES% variables.
You must specify who can modify the email template or the security template from the report request, and
who can access the values of the %DES% variable in the table associated with the scope.

Additionally, when a report is distributed through email or web, it uses the report server to run the
report and then distribute the output. In the report server, the directory templates and file templates
from the report requests are used as temporary locations to store the intermediate files before the reports
are transferred to the report repository or to the email system. Access to the file server that stores

the intermediate reports should be secured through your network security. Set up PeopleSoft Process
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Scheduler as a Tuxedo Service so that PS/nVision reports can be run in the background and no data can be
viewed during the report execution time.

Implementing PS/nVision Ledger-Based Data Security

This section provides an overview of PS/nVision ledger-based data security and discusses how to:

* Use the Reporting view.

* Use the Authorization table.

» Use ledger reporting view access.

* Restrict ledger access.

Understanding PS/nVision Ledger-Based Data Security

With PS/nVision row-level ledger security, you can restrict access to specified rows of ledger data. PS/
nVision employs a view that joins an Authorization table (maintained by you through a page) with the
Ledger table to select the rows a user is authorized to see. You can set up an Authorization table based on

any ChartField.

When you define a ledger, you specify the physical table that stores the ledger data in the database. You
can also define a record (view) for reporting purposes. If you define a reporting view, PS/nVision uses this
record in place of the physical Ledger table. By joining the Ledger table with the Authorization table, the
user only sees the rows that they’re authorized to see.

Image: PS/nVision security customization

This diagram illustrates the PS/nVision security customization.

RECNAME
LED_DEFN_TBL

RECNAME_RPTG_VW

LED_AUTH_TEL LED_RPTG_WVW LEDGER
OPRID OPRID B.U.
B.U. B.U LEDGER
LEDGER LEDGER LAMT
AMT

Using the Reporting View

The reporting view, like the Ledger table, is named on the Ledger template in the Secured Rptg Vw
(Secured Reporting View) field.
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To open the Ledger template, select General Ledgers > Ledgers > Templates > Record Definitions.

In the following example, this view (LED RPTG VW) is defined as:

SELECT A.OPRID, L.BUSINESS UNIT, L.LEDGER, L.ACCOUNT,...
FROM PS LEDGER L, PS AUTH TBL A
WHERE L.BUSINESS UNIT = A.BUSINESS UNIT

AND L.LEDGER = A.LEDGER

Image: Record Definitions page

Example of the Record Definitions page that displays the Ledger Template and the Secured Rptg Vw
field.

Record Definitions Eield Definitions

ETTIEW

Ledger Template:  STANDARD *Description: |Standard Detail Ledger

@ petail O Summary Default Ledger Type: | standard General Ledger v| . Default
*Record (Table) Name: LEDGER & accountChartField: [GL_ACCOUNT_TBL @,
Ledger Tmp: LEDGER_THMP 2, Combo Data: COMBO_DATA_TBL|@,
Ledger Tmp2: LEDGER_TMPZ &y Gen Tmp: [JGEN_WRK_TMP @&,
Journal Line: JRML_LM @, Summary Ledger Stage Tbi: [SLEDGER_STG | @,
Journal Line Tmp: JRNL_LN_THMP @ Consolidations Log: ’WQ}
Secured Rptg Vw: LED_RPTG_W & consolidation Equity Temp: [consoL_EQTY_TH @,

Ledger Load Staging table: LED_LOAD_STG @, Led Load Temp Record 2: LED_LOAD_WK2 @,
Led Load Temp Record: LED_LOAD WK1 @&,

Normally, the view includes all the columns in the Ledger table, plus the OPRID field, but you are not
required to include all ledger columns. The OPRID field is defined as a key to the view. Reporting views
can be defined differently for different ledgers. The OPRCLASS or ROWSECCCLASS fields, or any
combination of the OPRID, OPRCLASS, and ROWSECCLASS fields can be used instead of the OPRID
field. In the user profile found in PeopleSoft Security, you can use the OPRID field as the user ID, the
OPRCLASS field as the primary permission list, and the ROWSECCLASS field as the row-level security
permission list for the user.

With this example view, only users that belong to the specified OPRID, OPRCLASS, or
ROWSECCLASS from the LED AUTH_TBL can see those business units and ledgers.

The application provides a template Authorization table and Reporting view. By changing the definition
of the view and the underlying Authorization table, you can revise the security to be at the department
level or any other ChartField. The personalized view can use BETWEEN, OR, and LIKE statements to
implement more flexible (though less efficient) security views.

For example, you could add DEPT_FROM and DEPT TO to the Authorization table. Each user would
have access to all departments that fall within the ranges for their user ID and role. The Reporting view
could include:

WHERE ... L.DEPTID BETWEEN A.DEPT FROM AND A.DEPT TO
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This setting might carry a performance cost on some database platforms, but it can ease the process of
maintaining the Authorization table, all transparent to PS/nVision.

Changes to the view are made using Application Designer. Changes to authorizations are made through a
page that maintains authorized ChartField values for each user. No changes are required to PS/nVision.

To ignore security on a ledger, leave the Secured Rprt Vw (Secured Reporting View) field on the Ledger
Definition page blank. PS/nVision will access the base ledger record.

Related Links

"Security Basics" (PeopleTools 8.56: Security Administration)

"PeopleSoft Online Security" (PeopleTools 8.56: Security Administration)
"PeopleSoft Authorization IDs" (PeopleTools 8.56: Security Administration)
"PeopleSoft Sign In" (PeopleTools 8.56: Security Administration)

Using the Authorization Table

The Authorization table is maintained by a page that can be personalized. Each valid combination of user
ID or role and the secured ChartField values (or ranges) must be defined in this table. Since the system
administrator who has access to this page (through the Administer Security pages) can change all security
provisions, trickle-down authority does not occur.

Using Ledger Reporting View Access

To get data from a ledger, PS/nVision uses a Select statement from the Reporting view, not the actual
Ledger table, using the user’s ID or primary permission list as part of the Where clause. PS/nVision
checks the record definition of the Reporting view and determines whether it includes OPRID,
OPRCLASS, or ROWSECCLASS in its keys, and generates the appropriate phrase in its Where clause.
Individual users are not given direct database access, for example, using a GRANT to either the Ledger
table or the Reporting view. (Using GRANT is specific to Oracle.)

This example shows Select of ledger data as used by PS/nVision, in which both OPRID and OPRCLASS
are specified in the Authorization table:

SELECT ACCOUNT, SUM(POSTED TOTAL_AMT)
FROM PS LED RPTG VW
WHERE BUSINESS UNIT = 'NEWGN'
AND LEDGER = 'ACTUALS'
AND FISCAL YEAR = 1993
AND ACCOUNTING PERIOD BETWEEN 9 AND 12
AND ACCOUNT IN ('800100','800200','800300")
AND DEPTID = '0300'
AND OPRID = 'GLUSER' and OPRCLASS = ‘MANAGER’
GROUP BY ACCOUNT

Restricting Ledger Access

Use the nVision Ledger Security page in PeopleSoft Security to restrict what ledgers a user is authorized
to access.

Navigation

Set Up Financials/Supply Chain > Security > nVision Ledger Security
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Image: nVision Ledger Security page

This example illustrates the fields and controls on the nVision Ledger Security page.

nVision Ledger Security
User ID: BICFOA
= 4] b ]
Business Unit Description Ledger
Us001 @, |US001 NEW YORK OPERATIONS BUDGETS b [+]|[=]
BLGO1 @, |BELGIUM OPERATIONS CC_ORG_EXP v [#]{[=]
Us0032 @, |US002 CALIFORNIA OPERATIONS ADJ-LOCAL b [+]|[=]

Implementing PS/nVision Query-Based Data Security

PeopleSoft Query restricts users to specific rows of data by employing a similar approach to the ledger
Reporting view. Each record definition can have a query security record defined that joins the record data
with authorization record data to restrict the returned result set.

Navigation

1. Select Start > PeopleTools > Application Designer.

2. Open the record on which you want to apply row-level security.
3. Select File >Definition Properties.

4. Select the Use tab from the Record Properties dialog box.
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Image: Record Properties — Use dialog box

Setting Up PS/nVision Security

This example illustrates the fields and controls on the Record Properties — Use dialog box.

Record Properties

General Use l

Set Contral Field: |

Recard Relationzhips

L

Parent Recaord ;

|E!FEYEHIT55HEH_WK

Related Language Recard: |

[uem Security Recard: |

Analptic Delete Record:

Recaord Audit

Recard Mame:

Record-level Auto-Update

|PLIST_QUERY_wRE

Audit Ophionz

[ Add

[ Change
[ Selective

[ Delete

Lol Led L] L

Syztem |D Field | Hane ﬂ
Timestamp Field | Hane j
Sync type [MS5F] R ecord Information

[ v Tools Table

|— [

X

o ]

Cancel

Related Links

"Record Definition Planning" (PeopleTools 8.56: Application Designer Developer's Guide)
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Tuning PS/nVision Performance

Understanding PS/nVision SQL

This section discusses:

* PS/nVision SQL basics.
* Tree joins.

* Combination rules.

* Capture of PS/nVision SQL.

PS/nVision SQL Basics

PS/nVision produces a great variety of reports from multiple database tables. The SQL statements
it generates are not overly complex but are sensitive to the performance of the underlying database,
especially in the following areas:

» Large tables (ledgers often have millions of rows) make efficient use of essential indexes.

» The use of trees and reporting (security) views causes multiple tables to be joined. The database’s
efficiency in processing these joins dictates most PS/nVision performance.

* Most PS/nVision aggregate queries are defined with minimal built-in criteria and could tire your
database server if executed without the added criteria of a PS/nVision layout.

Unlike traditional batch-reporting tools, PS/nVision supports interactive, focused reporting using a
probing or querying approach to database access. PS/nVision queries tend to be more numerous than
traditional report writers but also more focused on the specific data the user needs to see.

Much of these topics focus on the performance aspects of retrieving information from ledgers for
financial reporting. However, most of the information is equally applicable to other types of fact tables,
particularly when trees are used to retrieve the data.

Tree Joins

PS/nVision often relates tree node criteria to data tables by joining the data table to a tree selector table.
This selector table contains a row for every detail range defined for the tree in PeopleSoft Tree Manager
and is keyed by SELECTOR NUM (a system-generated constant number for all the rows representing a
particular tree) and the tree node number. Because some database platforms join tables efficiently only if
the field sizes match, we use up to 30 selector tables, one for each supported field length. Each selector
table has RANGE FROM nn and RANGE TO nn columns matching the corresponding field size.
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The following is a typical Select statement for selection via nodes on a single tree.

SELECT L.TREE NODE NUM, SUM(POSTED TOTAL AMT)
FROM PS LEDGER A, PSTREESELECT06 L
WHERE A.LEDGER='ACTUALS'
AND A.FISCAL YEAR=1991
AND A.ACCOUNTING PERIOD BETWEEN 1 AND 9
AND A.ACCOUNT>=L.RANGE FROM 06
AND A.ACCOUNT<=L.RANGE TO 06
AND L.SELECTOR_NUM=198
AND (L.TREE NODE NUM BETWEEN 1612345 AND 3098765
OR L.TREE NODE NUM BETWEEN 3512345 AND 4098765)
GROUP BY TREE NODE_ NUM

The bold part of this statement accomplishes the tree criteria selection. If the report had tree criteria for
other fields, their selector tables would be added to the From list and similar Join criteria to the Where
clause. The Group By clause returns an answer row for each node that has a detail range attached to it;
these node numbers are used to post amounts from the answer set into the appropriate rows or columns of
the report.

Related Links
Using Tree Tables

Combination Rules

186

PS/nVision tries to retrieve the data for each report instance with as few Select statements as possible.
It examines all row and column criteria to determine which can be combined. It then builds a Select
statement to retrieve each intersection of a combined group of rows with a combined group of columns.
The following built-in rules should be understood when you design indexes:

» Different ledgers cannot be combined.
» Different TimeSpans cannot be combined.
¢ nPloded rows or columns cannot be combined with non-nPloded rows or columns.

*  To be combined, multiple rows or columns must have criteria for the same set of fields, and each
field’s criteria must be of the same type. (For example, selected tree nodes cannot be combined with
selected detail values).

o Ifcriteria for a field are specified by tree node, they can be combined only if they use the same tree.

» Ifthe combined rows or columns have identical criteria for a particular field, the criteria are included
in the Where clause, but a Group By clause on that field is not required. But if different rows or
columns in the group have different criteria, PS/nVision adds this field (or the corresponding tree node
number) to the Group By clause to retrieve a value for use in posting the answer set to the appropriate
rows or columns of the report.

* A single Select statement can retrieve amounts for multiple combined rows and columns.
» Different scope instances are retrieved with separate Select statements.
Some additional rules apply for layouts defined using queries rather than ledgers:

» Different queries are not combined.
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* References to different answer columns in the same query can be retrieved with a single Select
statement if they meet the above tests.

Capture of PS/nVision SQL
To examine the SQL produced by PS/nVision, you can capture the statements in one of two ways:

* Use the Show Report SQL option in the PeopleSoft nVision Options dialog box. This option causes
PS/nVision to display each Select statement used to retrieve labels or amounts in a dialog box. You
can select the text with the mouse, then copy (CTRLAC) it to the Clipboard, then paste (CTRL+V) the
text into another application, such as Notepad, WordPad, an interactive SQL tool, or a text editor. You
can then save the text to a file or work with it within the application.

Note: To capture the SQL without waiting for it to execute, you can also select the Suppress Amount
Retrieval option. PS/nVision generates all the SQL but does not execute Select statements for
amounts.

*  Turn on the PeopleTools SQL trace through the Trace tab on the Configuration Manager. The SQL
statements executed by PeopleTools will be written to a file that you specify.

Assigning Ledger Tables

Each ledger is assigned to a database table, but different ledgers might not be stored in the same table.
Some ledgers need different amount formats (for example, number of decimal places) or a different field
configuration than others. Summary ledgers must be stored in different tables than their corresponding
detail ledgers.

Because each installation of PeopleSoft General Ledger has different ChartFields and reporting
requirements, each installation must assign ledger tables and indexes to meet its requirements and ensure
good reporting performance.

Using Indexes and PS/nVision Tuning

This section provides an overview of indexes and discusses how to use:
*  Optimizers.

» Filter factors.

* Index matching.

* Ledger access paths.

* Access path analysis.

* Index column suggestions.
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Understanding Indexes

An index is a fast way to find data. At a simple level, an index works like the tabs on a large dictionary;
you can go directly to all the words that begin with a particular letter. After that, you need to do some
additional searching, taking advantage of the fact that the words are stored in alphabetical sequence. The
range of words on a page is generally printed at the top, so you do not have to scan through individual
words until you find the page you want. Many database systems include a type of index, often called a
primary or clustered index, that has the same sequence as the data.

But suppose you are searching an atlas, where data is generally stored in geographical sequence. If you
are looking up Majorca, you are likely to look it up first in the alphabetical index, and then search the
page that has a map of the Mediterranean. Data is accessed through an attribute different from its storage
attribute.

Suppose you wan to find all the words in the dictionary derived from Finnish words. Unless you had a
dictionary with an etymological index, your scan of the data pages would be very time-consuming. This
type of access should be avoided when accessing large database tables, because it is slow even on the
fastest server.

Typically, the Where clause in a query contains a mixture of criteria resolvable through an index and
criteria resolvable only through access to the data pages. To be efficient, use the index criteria to limit the
number of data rows searched.

Multi-Column Indexes

Relational databases allow indexes over multiple columns, so that if you have Where criteria for two
or more columns in the index, the database manager can use one index to satisfy criteria on multiple
columns at a time. Having the pertinent criteria columns in an index, however, does not guarantee that
index will be used or that it will be used effectively on all the columns that have criteria.

Optimizers

Most relational database systems include a cost-based optimizer, a complex program responsible for

choosing an access path to satisfy a particular query, such as a Select statement issued by PS/nVision.
Using statistics stored in the database, the optimizer tries to determine the index to use for each of the
tables accessed in the query and the table access sequence that yields the data with minimal searching.

Some database optimizers have a choice between cost-based and rule-based optimizers. For PS/nVision,
and for most PeopleSoft software, you should use the cost-based optimizer because:

*  PS/nVision creates dynamic SQL based on the report criteria you provide.
Rule-based optimizers are designed for static SQL that is written following its rules.

* Cost-based optimizers adapt much better to changes in data and indexes because they use statistics in
their optimum access path calculations.

This discussion of tuning PS/nVision's SQL performance assumes use of a cost-based optimizer.

Filter Factors

Although it might be named differently, a filter factor applies to all optimizers. It estimates how effective
a particular index will be in narrowing a search.
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Assume we have a table in which financial results are stored by fiscal year, period, and account number.
The table has two indexes, one on fiscal year and another on account. Assume that our query contains the
following:

WHERE FISCAL YEAR = 1994 AND ACCOUNT='500120"

If the table has data for 4 fiscal years and 800 accounts, then the filter factor for the fiscal year index is
Ya or 0.25; and the filter factor for the account index is 1/800 or 0.00125. Using the index for fiscal year
narrows the search to about one fourth of the total table, which is not that great. But using the index for
account narrows the data searched to about one eight hundredth of the total table and will be much more
efficient. Of course, an index combining fiscal year and account would be even better.

The measure of the selectivity of an index, or a column within an index, is often called its cardinality.
Cardinality is the number of discrete values in that column or the number of discrete combinations
represented by a multicolumn index. Cardinality is one of the most important statistics used by optimizers
to select indexes and access paths. Like most other statistics, cardinality is updated on request rather than
constantly.

When data changes substantially, update the statistics so the optimizer has accurate information. Updating
statistics requires different processes on different database platforms.

See the Peoplelools Installation Guide.

Index Matching

The effective filter factor for an index is the combined cardinalities for the index columns actually used
in a particular access. For example, if an index is built over FISCAL YEAR, LEDGER, and ACCOUNT,
and the table contains 4 years, 5 ledgers, and 800 accounts, the potential filter factor is 1/(4*5%800), or
1/16000, or 0.0000625. However, if the ACCOUNT field in the index couldn’t be used because of the
nature its criteria, the filter factor would be only 1/20, which isn’t very selective.

These general rules apply to matching index columns:

» Database systems provide direct access to data very quickly if the criteria can be processed through an
optimized look-up process (such as searching a tree structure) within the index.

Scanning index pages to satisfy criteria is much slower, although it is usually much faster than
scanning the corresponding data.

*  Columns are matched from left to right in the order they were specified when the index was created.

If, for example, an index is created over DEPTID, BUSINESS UNIT, and ACCOUNT, but no criteria
were provided for BUSINESS UNIT, only the DEPTID field in the index would be matched, even if
criteria were specified for ACCOUNT.

* To get index matching on multiple columns, the leftmost columns must have simple criteria, often
equality (such as FISCAL YEAR=1996).

More complex criteria, such as In (...), Between, or a Join to another table, generally either prevent a
random-access match on the index column or prevent matching any of the columns to its right.
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Ledger Access Paths

As a general rule, it is most efficient to access ledger data through trees by accessing the tree table first,
then using the detail ranges (or values) for the selected nodes to select the desired rows from the ledger.
If the Select statement joins multiple trees, the database engine should select the one that best fits the
available indexes or the one with the highest cardinality (if multiple indexes are possible).

Access Path Analysis

190

Different techniques exist for showing the access path for a given SQL statement.

DB2

First, create a PLAN_ TABLE if your database doesn’t already have one. You can find a sample Create
statement in the DB2 Performance Tuning guide.

Include the SQL statement in the following and execute it via a utility like SPUFI:

DELETE FROM PLAN TABLE WHERE QUERYNO=nnn;
EXPLAIN PLAN SET QUERYNO=nnn FOR statement;

where nnn is a number you assign to this statement.

Retrieve the plan from the PLAN TABLE with the following Select statement:

SELECT QBLOCKNO, PLANNO, TNAME, ACCESSNAME, METHOD, ACCESSTYPE, MATCHCOLS, INDEXONL=
Y, PREFETCH, SORTC GROUPBY

FROM PLAN TABLE

WHERE QUERYNO=nnn

ORDER BY QBLOCKNO, PLANNO;

The table contains other plan information; these are generally the most pertinent columns for PS/nVision
queries.

Oracle

First, create a PLAN TABLE if your database does not already have one. Here is a sample Create
statement:

CREATE TABLE PLAN_TABLE(
STATEMENT_ID VARCHARZ2 (254),
TIMESTAMP DATE,

REMARKS VARCHARZ2 (80),
OPERATION VARCHAR2 (30),
OPTIONS VARCHARZ2 (30),
OBJECT_ NODE VARCHARZ2 (128),
OBJECT_ OWNER VARCHARZ2 (30),
OBJECT_NAME VARCHARZ2 (30),
OBJECT_INSTANCE NUMERIC,
OBJECT TYPE VARCHAR?2 (30),
OPTIMIZER VARCHARZ2 (255),
SEARCH_COLUMNS NUMERIC,

ID NUMERIC,

PARENT ID NUMERIC,
POSITION NUMERIC,

other long);

You can use SQL*Plus to evaluate access plans interactively. First, include the SQL statement in the
following code and execute it.

DELETE FROM PLAN TABLE WHERE QUERYNO=nnn;
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EXPLAIN PLAN SET STATEMENT ID = 'nnn' FOR
statement;

where nnn is an identifier you assign to this statement.

Retrieve the plan from the PLAN_ TABLE with the following Select statement:

SELECT LPAD(' ',2*LEVEL) | |OPERATION, OPTIONS, OBJECT NAME,
OBJECT INSTANCE, SEARCH COLUMNS

FROM PLAN TABLE

WHERE STATEMENT ID='nnn'

CONNECT BY PRIOR ID = PARENT ID
AND STATEMENT ID='nnn'

START WITH ID = 1
AND STATEMENT ID='nnn'

ORDER BY 1ID;

The plan is retrieved in a hierarchical tree format, in which the steps are evaluated from inside out,
and then top to bottom. The first step listed (not indented) is actually the final step in the plan, and it
is preceded by the step on the following line. For example, a Join is presented first, followed by two
indented lines showing the two tables joined and the indexes used to access them.

Index Suggestions

Designing indexes for PS/nVision can be difficult because different reports can have different criteria. The
following table lists the index columns and suggestions.

Index Column Suggestions

Fiscal Year When using a TimeSpan (required for ledger reporting but
optional for queries), PS/nVision always generates an equality
for fiscal year (for example, FISCAL YEAR=1996).

If the TimeSpan requires data from multiple fiscal years, then
PS/nVision generates multiple Select statements, one for each
fiscal year, which makes Fiscal Year a good candidate for the
first column in a multicolumn index.

Ledger When accessing ledger data, PS/nVision retrieves data from
only one ledger at a time, so this column is guaranteed to
have an equality. Thus, Ledger is a good choice as the second
column in a multicolumn index.

Business Unit If you use the report request option to retrieve data from
the requesting business unit only, PS/nVision generates an
equality (for example, BUSINESS UNIT=‘MO04°) for this
column.

If this is the most common way of requesting reports or if you
use a scope to get instances by business unit, then use business
unit as the second or third column in a multicolumn index,
especially if you have many business units in the same ledger
table.

If most of your reporting accesses multiple business units in a
single instance, position it in the index as you would any other
field.
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Index Column Suggestions

Accounting_Period When using TimeSpans, accounting period is specified using
either an equality (ACCOUNTING_PERIOD=12) or a range
(ACCOUNTING_PERIOD BETWEEN 10 AND 12).

If you do a lot of reporting for the current period or other
single periods (such as current period a year ago), performance
may be improved using an alternate index beginning with
accounting period. A good optimizer uses this index only
when accounting period has an equality.

Account In many companies, Account is the field with the highest
cardinality. It also has criteria in almost all ledger reports, in
part because PS/nVision enforces this rule. Use it as the next
index column following the columns that you expect to have
equalities.

Using Trees

This section provides an overview of using trees with PS/nVision and discusses how to:
* Enhance tree performance with SQL techniques.

* Set tree performance options.

Understanding Trees and PS/nVision

PS/mVision performance may suffer when trees are used, especially when the SQL statements used to
retrieve data access two or more trees at once. On some database platforms, the Where criteria used

with most tree joins can cause the database optimizer to select the wrong access path, making the
PSTREESELECTnn table an obstacle to performance rather than an aid. This often happens when the tree
uses ranges of detail values.

To address these performance issues, PS/nVision includes techniques for building SQL that implement
tree criteria, and it also implements SQL that is readily understood by database optimizers, yielding better
access paths with less need for index tuning and so on. Additionally, you have control over the techniques
used, so you can tune the performance of individual reports.

Enhancing Tree Performance with SQL Techniques

192

PS/nVision includes a number of SQL techniques to improve performance whenever trees are used. You
can use static selectors or dynamic selectors. You can specify where or how to use selectors. A selector
represents nodes of a single tree and is represented by the set of rows in the PSTREESELECTnn table
having a single SELECTOR_NUM value.

Static Selectors

A static selector represents the entire tree, and it remains valid until the tree changes. For all database
platforms, these selectors contain ranges (unless the tree had no ranges).
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Static selectors do not need to be rebuilt except when the tree changes. However, the SQL statements

that join static selectors to fact tables (such as ledgers) can be complex because they include both range
predicates (if the tree has ranges) and node criteria to select that portion of the tree required on a particular
section of a report. This can be difficult for database optimizers to process, especially if multiple trees use
this technique.

Note: You should not run reports while you are modifying trees; it could lead to incorrect results.

Dynamic Selectors

A dynamic selector is created for use in a section of a single report, so it only lasts to the end of the report
request. This section, however, may be selected several times, especially if the report uses a scope to
produce multiple instances.

In addition to the ability to use a pre-existing (static) selector, PS/nVision can build one on the fly when
preparing to run a report. This technique can boost performance, but can also create more overhead,
especially if there are multiple users running the same report (using static selectors, users can share
selectors).

PS/nVision builds each dynamic tree selector for a specific set of criteria (such as a set of rows or the
current instance node), so that a selector (SELECTOR _NUM value) has exactly the nodes needed for a
group of rows or columns to be retrieved with a Select statement. This eliminates the need for the often-
cumbersome selection criteria PS/nVision generates for a static selector:

TREE NODE NUM BETWEEN x AND y OR TREE NODE NUM BETWEEN...

A dynamic selector creates a new SELECTOR_NUM value that PS/nVision uses and then deletes once
the report is complete. Therefore, distribution statistics (or skew statistics) are not present for that selector.
(Distribution statistics are still a factor for static selectors.) With certain PS/nVision reports, the absence
of distribution statistics can improve performance significantly; that’s because distribution st atistics can
make the SELECTOR_NUM criteria appear less selective to the database system optimizer, preventing
the optimizer from accessing the selector table first.

The disadvantage of dynamic selectors is that one or more selectors may be needed to process a single
report. In some cases, the time used to create the selectors can exceed the time saved by using them.
Dynamic selectors are most effective on joins that drive the access path; static selectors may be just as
fast, or faster, for additional criteria that do not affect the access plan.

Single-Value Selectors

Use single-value selectors only in conjunction with dynamic selectors. Combining dynamic and single-
value selector techniques improves the performance of PS/nVision in many cases where trees are used.

Single-value selectors enable a more efficient equi-join between
PSTREESELECTnn.RANGE FROM nn and the criteria field in the fact table (the one you are selecting
data from). In building the dynamic selector, we do not merely copy the ranges of values (such as
account numbers) from PSTREELEAF into PSTREESELECTnn. Instead, we join the tree ranges to the
underlying detail table (such as the GL. ACCOUNT _TBL), and insert the individual detail values into the
RANGE _FROM_nn column of PSTREESELECTnn. This may generate more rows in this table, but it
can also generate a more efficient join without maintaining the tree with individual detail values (the only
way you could get equi-joins without this option).
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A disadvantage of this technique is that, especially where the tree has large ranges containing many detail
values, single value selectors can contain many more rows than ranged selectors have. Unless the join is
processed in a more efficient manner, the number of rows in the selector can mean slower join processing.

Suppress Join

The suppress join technique eliminates a SQL join by retrieving the detail ranges associated with the
selected node and coding them in the Select statement. This technique is most effective in the following
cases:

* The selected tree is used in the scope you expect to be used with this report, and each instance of that
report is a tree node.

* The node or nodes selected represent a relatively small number of detail values or ranges.

The suppress join technique cannot be used where PS/nVision needs to group the answer set by tree
node number, because these numbers are not available without joining the data to the tree. This happens,
for example, if multiple rows or columns with otherwise similar criteria select different nodes of this
tree. This is typical in the rows of most financial reports. However, if nPlosion to underlying details is
specified for these rows or columns, the suppress join technique can be used, because PS/nVision can
Group By the detail values rather than tree nodes.

Additionally, when the selected node (or nodes) includes large numbers of detail ranges, the suppress join
technique may not be practical or efficient. While PS/nVision can build the very large statements that can
result in this case, use of the suppress join technique when tree nodes refer to very large lists of detail
ranges can be slower than the other techniques, or even fail to run because the statements exceed the size
limits imposed by your database platform.

Sub-Select Tree Selector

The sub-select method is very similar to a join. Instead of adding the tree selector to the From list of

the main query, the tree selector criteria and its relation to the data (for example, DEPTID) in the main
query is within an "Exists (Select ...)" clause in the Where portion of the main query. This is called

a correlated sub-query, because part of the criteria in the sub-select relates to data in the main query
(A.DEPTID=B.RANGE_FROM 05). This is what makes it so much like a join. Database engines and
optimizers differ in how they handle this syntax. Some process a correlated sub-query just like a join,
while others are subtly different. You may need to experiment to determine which works better for which
reports on your database platform.

Data from the sub-select statement cannot be included in the main Select list; thus, none can be visible
to the program (for example, PS/nVision) that is running the query. This is because the sub-select
statement is hidden in the Where clause, rather than appearing in the From clause. When PS/nVision
retrieves multiple nodes of data for different rows or columns of a report, it uses the node number (from
the tree selector) to distinguish the data, and this means a join is required. If you specify either sub-
select or Suppress Join in this case, PS/nVision ignores the option and forces a join. You need to specify
join options even if not using a join method, because you may get a join after all. If you don't see a
performance benefit using the sub-select method, we recommend using join instead, because it can be
used whether or not tree node criteria are needed in the answer set.
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Additional Options

Before the tree performance options were added, PS/nVision invoked the following type of syntax when
joining a selector for a tree with ranges:

WHERE _ field >= L.RANGE FROM nn AND field <= L.RANGE TO nn _

This syntax is equivalent to using the Between predicate. It resulted in better access plans on the DB2/
MVS platform. PS/nVision now includes an option to generate the following syntax:

WHERE _ field BETWEEN L.RANGE FROM nn AND L.RANGE TO nn _

This syntax should result in better access plans on certain database platforms.

Note: This option is only relevant to trees that use range selectors.

SQL Examples

Below is an example of the SQL alternatives made possible through the use of tree performance options.
Here is the default query (with the node criteria highlighted):

SELECT L1.TREE NODE NUM, SUM(A.POSTED TOTAL AMT)
FROM PS LEDGER A, PSTREESELECT05 L, PSTREESELECTO06 L1
WHERE A.LEDGER='ACTUALS' AND
A.FISCAL YEAR=1996 AND
A.ACCOUNTING PERIOD BETWEEN 1 AND 8 AND
L.SELECTOR NUM=216 AND
A.BUSINESS UNIT>=L.RANGE FROM 05 AND
A.BUSINESS UNIT<=L.RANGE TO 05 AND
(L.TREE_NODE NUM BETWEEN 1000000000 AND 1666666665) AND
A.CURRENCY CD='USD' AND
L1.SELECTOR NUM=215 AND
A.ACCOUNT>=L1.RANGE_FROM 06 AND
A.ACCOUNT<=L1.RANGE TO 06 AND
(L1.TREE_NODE_NUM BETWEEN 1916275676 AND 1923430847) AND
A.STATISTICS CODE=' '
GROUP BY L1.TREE_NODE NUM;

Here’s an alternative query using the Suppress Join technique for business unit criteria and a dynamic,
single-value selector for ACCOUNT:

SELECT L1.TREE NODE NUM, SUM(A.POSTED TOTAL AMT)
FROM PS LEDGER A, PSTREESELECT06 L1
WHERE A.LEDGER='ACTUALS' AND
A.FISCAL YEAR=1996 AND
A.ACCOUNTING PERIOD BETWEEN 1 AND 8 AND
(A.BUSINESS UNIT BETWEEN ‘B0006' AND ‘B0006'
OR A.BUSINESS UNIT BETWEEN ‘B5030' AND ‘B5030'
OR A.BUSINESS UNIT BETWEEN ‘B9013' AND ‘B9014'
OR A.BUSINESS UNIT BETWEEN ‘B0015' AND ‘B0015'
OR A.BUSINESS UNIT BETWEEN ‘B9026' AND ‘B9026'
OR A.BUSINESS UNIT BETWEEN ‘B0019' AND ‘B0031'
OR A.BUSINESS UNIT BETWEEN ‘B00l16' AND ‘B0018') AND
A.CURRENCY CD='USD' AND
L1.SELECTOR NUM=1215 AND
A.ACCOUNT=L1.RANGE FROM 06 AND
A.STATISTICS CODE=' '
GROUP BY L1.TREE NODE NUM;

Next is another form of the same query, with dynamic business unit selectors and dynamic ACCOUNT
selectors:

SELECT L1.TREE NODE NUM, SUM(A.POSTED TOTAL AMT)
FROM PS LEDGER A, PSTREESELECTO05 L, PSTREESELECT06 L1
WHERE A.LEDGER='ACTUALS' AND
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.FISCAL YEAR=1996 AND

.ACCOUNTING PERIOD BETWEEN 1 AND 8 AND

.SELECTOR NUM=1216 AND

.BUSINESS UNIT = L.RANGE FROM 05 AND

.CURRENCY CD='USD' AND
L1.SELECTOR NUM=1215 AND
A.ACCOUNT=L1.RANGE FROM 06 AND
A.STATISTICS CODE="' '

GROUP BY L1.TREE NODE NUM;

i = i = =]

Setting Tree Performance Options

196

PS/nVision and PeopleSoft Tree Manager each provide a number of techniques and tuning options that
can dramatically improve reporting performance. These performance enhancement techniques apply to
both query-based and ledger-based layouts.

To change the technique used for a given tree, you can specify the technique using the Tree Performance
Options dialog box in PeopleSoft Tree Manager. To override any Tree Manager settings and specify the
technique used for a particular report layout, you specify the technique using the Tree Performance tab on
the Layout Options dialog box in PS/nVision.

The tree performance options enable you to control the database access techniques PS/nVision uses to
implement tree criteria for your report. These options can have a dramatic effect on how fast your reports
run.

In setting these options, work with your database administrator to determine the best options, and to
ensure that indexes are tuned for the SQL techniques selected. You should be prepared for some trial and
error to find the best settings for your data and reporting requirements.

Note: The performance-tuning information presented here is intended for database administrators and
advanced PS/nVision users who understand how PS/nVision accesses relational databases. The techniques
discussed are not useful for casual users or for customizing performance on a workstation-by-workstation
basis.

Access the Tree Performance tab from Excel, select nVision > Open Layout > Layout Options; and then
select the Tree Performance tab.
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Image: PeopleSoft nVision Layout Options dialog box: Tree Performance tab

This example illustrates the fields and controls on the PeopleSoft nVision Layout Options dialog box:

Tree Performance tab.

r

PeopleSoft n¥ision Layout Options

F'ru:umpts] nPlode Rowes ] nPlode Columnz  Tree Performance l

Tree Mame: |I]E_.5.EE_848_EMF'L
Aocezs Method

{* Jain to tree selectar

" Suppress join; use literal values

" Sub-5ELECT tree selector
Tree Selectors

{ Static: Selector

" Dynamic Selectors
Selector Optionz

" Single Yalues

f* Ranges of values [>= ... <=)

" Ranges of values [EETWEEM]

Other

[ Mor-specific node criteria [above 2 billion)

Clear

_ Cear_|
Defaults

] Cancel

Tree performance options are saved in the sheets named NvsTree.treename for each specified tree.

You are setting performance options for a specific layout, one tree at a time. Optimum performance often
is achieved using different techniques for different trees, depending on the nature of those trees and the

way each tree is used in the report.

If you do not specify the tree performance options for a tree used in a report layout, and no performance
options are defined in Tree Manager for that tree, PS/nVision uses the same SQL techniques used in the

past on your database platform.

Join to tree selector

Suppress join; use literal values

Select to include the tree selector table in the From clause and
use join criteria to select the appropriate rows from the fact
table.

This method is sometimes used by PS/nVision even when
another method is specified, if tree node information is needed
to produce the report.

Select to eliminate a SQL join by retrieving the detail ranges
associated with the selected node and coding them in the Select
statement.

If you select the suppress join technique, but PS/nVision cannot
use it because of the need to group results by tree node, it will
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Sub-SELECT tree selector

Static Selectors

Dynamic Selectors

Single values

Range of values (>= <=)

Range of Values (BETWEEN)

Non-specific node criteria (above 2
billion)
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automatically use the join method you select (that is, either
static or dynamic). However, if PS/nVision can use the suppress
join technique, it ignores the selector options for this tree.
Therefore, pick a selector technique in addition to selecting the
suppress join option.

Note: This option is not available for use with winter trees.

Select to add the tree selector to the From list of the main query.

The tree selector criteria and its relation to the data in the main
query is within an Exists clause in the Where portion of the
main query.

Select to build a selector that represents the entire tree and
remains valid until the tree changes.

Select to creates a new tree selector for use in a section of a
single report.

The dynamic selector represents just the requested nodes.
Used only with dynamic selectors.

Select to cause PS/nVision or PeopleSoft Query to build a
selector using the individual detail values (from the detail table
specified in the tree structure) that fall within the detail ranges
of the selected nodes.

For a tree with ranges of values, select to make the selectors
more compact (fewer rows) and less likely to become obsolete
as detail values are added.

For some database optimizers, the syntax “fieldname >=
RANGE FROM nn AND fieldname <= RANGE TO nn” gets
a better access plan than BETWEEN.

Note: If you specify one of the range syntax options, but the tree
has no ranges, PS/nVision uses the single-value syntax (field =
L.RANGE_FROM_nn).

Select to use the syntax “fieldname BETWEEN RANGE
FROM_nn AND RANGE TO nn”.

This choice is best for ranged selectors on most database
platforms.

Select to prevent the optimizer from selecting the driving
criteria field based on how inclusive the node number criteria
are.

This option has been used on DB2 when criteria for multiple
trees were present. Unless you are a DB2 customer who has
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tuned your database around this extra criteria, we recommend
that you not use this option.

Note: Trees with a mixture of dynamic detail and range detail are not supported by nVision. Reports
generated using such trees may not be accurate.

Related Links
Using PS/nVision-Defined Names
"Setting Tree Performance Options" (PeopleTools 8.56: Tree Manager)

Understanding Restrictions on Tree Performance Options

In certain cases, PS/nVision may override the specified tree SQL technique. The dynamic selector
technique is not used when a field has tree criteria in multiple dimensions (for example, both row and
column), or when a field has the same tree criteria in multiple places (for example, in both sheet level

and row level). This can also happen at DrillDown time if criteria for a field are inherited from multiple
dimensions (for example, the scope and column) of the parent report. With the dynamic selector technique
unavailable, PS/nVision uses either the suppress join technique (if requested and if feasible) or the static
selector technique.

You cannot select the single value option with static selectors because the static selector remains
unchanged until the tree changes. However, the addition of single values to the fact table, which the tree
detail is based on, doesn’t affect a tree change. The single-value options exist for dynamic selectors and
for enabling you to control the syntax used with ranged selectors.

PS/nVision ignores the suppress join technique if specified for a tree with summary ChartField node
criteria. Summary ChartField nodes, or detail values in summary trees, are tree nodes from a detail tree
rather than values from a database field. In addition, PS/nVision does not support translation of summary
ChartField nodes when drilling down to the detail ledger, so we recommend that you use the summary
tree criteria.

The suppress join technique is available for reports based on summary trees, as long as tree node
information is not needed to group the result. It may be possible to recode some reports that use detail
value criteria for summary trees for performance reasons.

These performance-enhancement techniques are not used when retrieving labels (such as account
descriptions). Labels for detail fields associated with tree criteria are retrieved using static selectors. The
SQL code used to retrieve labels is defined at a different level from the SQL used to retrieve amounts, so
it isn’t possible to use the same dynamic selectors for both.

Because criteria from multiple rows and columns are combined with the instance (scope) criteria in a
single Select statement, SQL statements generated by PS/nVision can be long and complex. While current
releases of PS/nVision no longer enforce a statement size limit, every database platform has a maximum
statement size, and even statements shorter than the maximum may be inefficient. You control statement
size through judicious use of the performance options.

Here are the common causes of oversized SQL statements:

» Use of the suppress join technique on a tree (or trees) from which nodes representing too many detail
ranges are requested.
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Suppressing a join can be very useful, but is recommended only when criteria from a given tree
require a relatively short list of detail values or ranges.

Use of static selectors with a very long list of nodes.

PS/nVision combines node number ranges for sibling nodes where possible, so it takes lots of nodes to
exceed the limit. Use of dynamic selectors makes the SQL much shorter.

An extremely long list of detail values.

The messages that indicate a statement is too long vary from platform to platform. For statements
made long by tree criteria, the most successful solution is generally to use the dynamic selectors
technique on one or more of the trees involved.

Optimizing Indexes With Dynamic Selectors

If you use the dynamic selector technique heavily for certain criteria fields, you should try an index on
that field’s selector table that is optimized around this technique. For example, a ACCOUNT is a six-
character field (meaning its selector table is PSTREESELECTO06) and you plan to use dynamic selectors,
with single values, for the ACCOUNT trees on most of your production reports. You should create an
index on PSTREESELECT06 on SELECTOR _NUM and RANGE FROM 06, since these are the only
fields that will appear in the Where clause with single-value dynamic selectors. But also note that:

Other fields that are the same size may use the same selector table, so you might not want to eliminate
an index if removing it would penalize those reports.

Although only SELECTOR NUM and RANGE FROM 06 will appear in the Where clause,
TREE NODE NUM may appear in the Select list (if PS/nVision needs to Group By tree node).

An index that includes this field as well would enable index-only access (that is, access with no need
to read the data table) when using this selector.

Index use varies depending on the optimizer and the volume and distribution of data, so experiment to
get optimum results.

Using Tree Tables

Understanding the structure of the various tree tables that PS/nVision uses and how they interact is
helpful. The main tables used in this example are PSTREEDEFN, PSTREELEAF, PSTREESELCTL, and
PSTREESELECTnn.

200
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Image: Tree tables used by PS/nVision

This example shows the tree tables that are used by PS/nVision.

PSTREEDEFN PSTREELEAF
HHK HHK HHH HHK HK HK
HHK HHK HHK HHK HAK HAK
HHK HHK HHK HHK HHK HHK
Matches Copies

Keys Fields To
PSTREESELCTL PSTREESELCTnn
Indentifies

HHK HHK HHK HHK HAK HAK
HHK HHK HHK HHK HHK HHK
WK HHK HHE MK MK MK

The following sections provide details about each of these tables.

PSTREEDEFN: Tree Definition
PSTREEDEFN (Tree Definition) table is the system table that defines an effective-dated version of a tree.

The following table lists the field names, types, lengths, formats, and long names of the PSTREEDEFN

table.

Field Name Type Length Format Long Name

SETID Char 5 Upper SetID

SETCNTRLVALUE Char 5 Upper Set control value.
Alternative to setID

TREE NAME Char 18 Upper Tree name

EFFDT Date 10 N/A Effective date

EFF _STATUS Char 1 Upper Status as of effective
date

VERSION Nbr 10 Raw B Version

TREE STRCT ID Char 18 Upper Tree structure ID

DESCR Char 30 Mixed Description

ALL VALUES Char 1 Upper All values
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PSTREELEAF: Tree Leaf
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Field Name Type Length Format Long Name
USE_LEVELS Char 1 Upper Use levels

VALID TREE Char 1 Upper Valid tree

LEVEL COUNT Nbr 3 N/A Level count
NODE_COUNT Nbr 5 Raw B Node count

LEAF _COUNT Nbr 5 Raw B Leaf count
TREE HAS RANGES | Char 1 Upper Tree has ranges
DUPLICATE LEAF Char 1 Upper Allow duplicate leaf
TREE CATEGORY Char 18 Upper Category

TREE ACC Char 1 Upper Tree access method
METHOD

TREE ACC Char 1 Upper Tree access selector
SELECTOR

TREE ACC_SEL Char 1 Upper Tree access selector

OPT

option

PSTREELEAF (Tree Leaf) table is the user table that defines the data value ranges, which are the leaves
of a tree. For each leaf node (nodes without children), one or more ranges define the detail values that
correspond to that node.

The following table lists the field names, types, lengths, formats, and long names of the PSTREELEAF

table.
Field Name Type Length Format Long Name
SETID Char 5 Upper SetID
SETCNTRLVALUE Char 5 Upper Set control value
TREE NAME Char 18 Upper Tree name
EFFDT Date 10 N/A Effective date
TREE_BRANCH Char 20 Upper Tree branch name
TREE NODE NUM | Nbr 10 Raw B Tree node number
RANGE FROM Char 30 Upper Range from
RANGE TO Char 30 Upper Range to
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Field Name Type Length Format Long Name
DYNAMIC RANGE | Char 1 Upper Dynamic range
OLD TREE NODE | Char 1 Upper Old tree node
NUM

PSTREESELCTL: Tree Selection Control

PSTREESELCTL (Tree Selection Control) table is the system table that controls and manages static
selectors (see PSTREESELECTnn). Each row in this table corresponds to a row in PSTREEDEFN and to
a group of rows (with the same SELECTOR _NUM) in PSTREESELECTnn.

Note: PSTREESELCTL table is only used for static selectors.

The following table lists the field names, types, lengths, formats, and long names of the PSTREESELCTL

table.
Field Name Type Length Format Long Name
SETID Char 5 Upper SetID
SETCNTRLVALUE Char 5 Upper Set control value
TREE NAME Char 18 Upper Tree name
EFFDT Date 10 N/A Effective date
VERSION Nbr 10 Raw B Version
SELECTOR_NUM Nbr 10 Raw B Selector number
SELECTOR_DT Date 10 N/A Selector date
TREE ACC_SEL Char 1 Upper Tree access selector
OPT option
LENGTH Nbr 5 Raw B Length

PSTREESELECTNN: Tree Select Work-Size nn

PSTREESELECTnn (Tree Select Work-Size nn) are the system tables that define selectors used by PS/
nVision to speed tree-based data selection. A selector table is defined for every possible detail field length
(nn = 01-30); thus this description applies to tables named PSTREESELECTO01, PSTREESELECTO02, and
so on, through PSTREESELECT30.

The following table lists the field names, types, lengths, formats, and long names of the
PSTREESELECTnn table.
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Field Name Type Length Format Long Name
SELECTOR_NUM Nbr 10 Raw B Selector number
TREE NODE NUM Nbr 10 Raw B Tree node number
RANGE _FROM nn Char n Upper Range from
RANGE TO nn Char n Upper Range to

PSTREESELNUM: Tree Selector Number

PS/nVision uses the PSTREESELNUM (Tree Selector Number) table to assign a unique
SELECTOR_NUM value to each tree selector as it is built.

Note: The PSTREESELNUM table has only one row.

The following table lists the field name, type, length, format, and long name of the PSTREESELNUM

table.
Field Name Type Length Format Long Name
SELECTOR_NUM Nbr 10 Raw B Selector number
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Running PS/nVision Reports on the Web

Understanding PS/nVision Reporting on the Web

Users with Internet access can run, view, drill down into, and distribute PS/nVision reports through a
browser, without needing a PeopleSoft application installed on client machines. Users can send reports as
email attachments rather than requiring recipients to navigate to a location on a file server.

PS/nVision on the web includes:

* Internet versions of report requests, report books, and scope definitions.

e Output in Microsoft Excel (.xIsx) format.

* DrillDown for Microsoft Excel reports.

* Email options to send PS/nVision reports to individual users or users in specified roles.

» Integration with PeopleSoft Process Scheduler and PeopleSoft Report Manager to send bursting report
instances to designated users or users in specified roles.

*  Support for multiple PS/nVision sessions when PS/nVision is invoked from PeopleSoft Process
Scheduler.

* A restart feature that allows the system to restart a process if it is marked No Success.

Note: Microsoft is no longer offering mainstream support for Excel 2003. As a result, beginning with
PeopleTools 8.51, PeopleSoft is no longer supporting Excel 2003 usage with PS/nVision.

PS/nVision will no longer support the HTML output format because Microsoft Excel 2007 removes
certain features when an Excel file is saved in an HTML format. For example, Defined Names and other
features are removed when the Excel file is saved in an HTML format. Without the Defined Names
feature, you cannot use PS/nVision drilldown. As there will be loss of nVision-specific information

in HTML reports, the support for the HTML output format is no longer available beginning with
PeopleTools 8.51. Please note that the Microsoft Excel Format is still supported as an output format

for nVision reports. The generated reports will be in the Excel 2007 (.x1sx) format beginning with
PeopleTools 8.51. All nVision features, including drilldown, are supported with this output format. These
features continue to function the same way they did with the Excel 2003 (.xIs) output format.
PS/nVision uses Microsoft Office OpenXML SDK (Software Development Kit) to generate Excel-
compatible PS/nVision reports on the batch server without using Excel in an unattended mode. Design
and usage of PS/nVision windows client are not impacted by the OpenXML SDK, and PS/nVision
windows client continue to use Microsoft Excel and Excel API.

See PeopleTools Installation Guide: Installing Products for PS/nVision.

Related Links
Converting Existing Layouts and Reports to OpenXML Format
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"Defining Process Definitions" (PeopleTools 8.56: Process Scheduler)

Configuring PS/nVision on the Web

PS/mVision processes on the web are all run by Process Scheduler. All the equivalent settings that PS/
nVision needs in the Windows client (such as layout directory and instance directory) are defined in the
nVision section of the Process Scheduler configuration file. Other configurable options include:

* The EnableDrillDownDownForFile parameter, which supports DrillDown on File output type reports
in the web-based nVision environment.

The setting only takes effect when the report request is defined to run in File output type on the web.
By default, EnableDrillDownDownForFile is set to be 0 (false). When the option is set to /, users are
able to access the report instances in the instance directory and drill down the report instances on the
web. When the option is set to 0, the generated report instances are not drillable.

* The EnablePollDialogs and PollDialogSeconds parameters, which dismiss unattended PS/nVision
dialog boxes.

Note: Because this option can affect performance, it should be used with caution.

* The TraceLevel option, which enables you to generate and view trace logs specifically for PS/nVision.

» The SaveTempFile parameter enables you to save or delete the temporary reports that are created
when running nVision to email, print, or web output.

When SaveTempFile parameter is set to true (1), temporary reports will not be deleted. If run to email
or print output, the reports will be saved to the folder specified in the Directory Name Template field
of the report request. If that field is left blank, the report is saved to the nVision instance directory. If
run to web output, the report is always be saved in the nVision instance directory.

Related Links
Setting Trace Files

Dismissing Unattended Dialogs

Using Configuration Manager
"Using PSADMIN with PeopleSoft Process Scheduler” (PeopleTools 8.56: Process Scheduler)

Configuring the Report Node

206

Both PeopleSoft Process Scheduler and Report Manager use report distribution nodes to deliver PS/
nVision reports. The distribution node definition specifies the report repository location and the location
of the stored content (the files) for Report Manager. When PS/nVision creates a report instance, it passes
the physical file location information to PeopleSoft Process Scheduler. Process Scheduler then passes the
file to Report Manager using the information defined on the Distribution Node page.

Related Links
"Setting Distribution Options" (PeopleTools 8.56: Process Scheduler)
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"Defining Report Nodes" (PeopleTools 8.56: Process Scheduler)

Creating Scope Definitions

Creating a scope definition on the web is similar to defining it in the Windows client with the following
exception: You cannot specify an effective date for the tree node table or value table. The current date is
used as the effective date.

Select Reporting Tools > PS/nVision > Define Scope to access the Scope Definition page where you can
create scope definitions.

See Understanding Report Scopes, Defining Scopes, Creating Report Requests.

Image: Scope Definition page

This example illustrates the fields and controls on the Scope Definition page.

Scope Definition

Setld: QEDMZ Report Scope: QEDEFTID
Description; |S|:npe on QE_DEFTID Business Unit:
Field Combination Table: | Q

Scope Fields Find | View Al Firs.tn 1of 1 n Last

Delete Scope

[+ [=]

*Field Hame: Department

*How Specified:
Business Unit Keyed Tree

Tree Hame:
|
Customize | Find | View Al 2] 38 First B 4 of 4

u Last

I

1 [REGION Q (=]

Scopes are defined based on a tree node record or a value table such as Department table or Product table.
By defining your scope based on a table that includes an email address or user ID for each value you can
direct each scope based-report instance to a different user. For example, the record shown the following
table can be used with a scope definition as a value table to have each report instance sent by email or
posted to a different user in Report Manager.

Department | Description Manager Email Address User ID
(DEPTID) (DESCR) (EMAILID) (OPRID)
12000 Sales Canada John Smith john_smith@abc.com U:JOHNSMITH
13000 Sales USA Jane White jane_white@abc.com U:JANEWHITE
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Department | Description Manager Email Address User ID

(DEPTID) (DESCR) (EMAILID) (OPRID)

14000 Sales Asia Asia Manager Kathy Lin@abc.com; U:KathyLin;U:PeterYU,
U:PeterYu;R:AsiaManager R:AsiaManager

Scope variables are used in the Email and Security templates the same way that you use them to create
unique file names with the File template or directory names with the Directory template in your report
request. The Scope Descriptive Variable (%DES%) is used to select a related field value from the Scope
Value table or the Tree Node table. You can use values for email addresses, user Ids, or role Ids. The
general syntax of the %DES% variable is:

$DES. [scope field].[detail field].[node field]%

If your scope is based on a value table, replace [node field] with [detail field]. The [detail field] is
repeated so that the basic format of the syntax remains the same.

Note: The %DES% variable requires the associated field value be in the same table that the scope is
based on.

Email Template Variables

To have each report instance sent as email to the associated email address of department manager, you
would enter the following values in your email template:

$DES.DEPTID.EMAILID.EMAILIDS

This values enables PS/nVision to use the associated email address from the EMAILID field from the
value table where the DEPTID is located. You need to specify email as the output type on the report
request.

The scope descriptive variable (%DES%) is used to select a related field value from the scope value

table. For example, if your scope were based on the record shown above, you would produce three report
instances, and each instance would be sent to the associated email address. The report for department
12000 would be emailed to john smith@abc.com, and the report for 13000 would be emailed to
jane_white@abc.com. The report for department 14000 would be emailed to several recipients—Kathy
Lin, Peter Yu, and the email addresses for the users who belong to the role Asia Manager. You can specify
the user email addresses associated with users and roles in the user profiles of Maintain Security.

Security Template Variables

Using the record above for the value table, you could post each report instance to Report Manager for the
associated user. In this case you would use web as the output type and enter the following variables in the
security template:

$DES.DEPTID.OPRID.OPRID%

The report for department 12000 would be posted to Report Manager for user JOHNSMITH, and the
report for 13000 would be posted for user JANEWHITE. John Smith would not be able to access the
Department 13000 report. The report for department 14000 would be posted to Report Manager for Kathy
Lin, Peter Yu, and the other users belonging to the role Asia Manager.
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Sample Record Definition
Image: Application Designer window — NVS_DEPT_VIEW record

This example shows the record definition used to create a view that joins the department record
(DEPT_TBL) with a PeopleSoft security record (PSOPRDEFN).

“J Application Designer - Untitled - [DEPT_TBL (Record)]
@ File Edit “iew Inserk Build Debug Tools Go Window  Help

D[ H|9 & e 83 |3 e x

Record Fields IRE.;.;.M Type l

Field Hame Short Hame

Long Hame

1 |DEPTID pper DeptD D epartrent
2 |DESCH Char a0 tined Dezor D ezcription
3 |DESCRSHORT Char 10 bined Short Desc Short Description
4 |OPRID Char a0 bined |zer zer D
5 |EMAILID Char Fil] bined Ernail ID Email ID
6 |EMPLID Char 11 Upper  |ID ErnpllD
SQL View Text

The SQL view text joins the PS DEPT TBL.MANAGER ID with the PSOPRDEFN.EMPLID in
security. The email address and user ID (OPRID) are taken from PSOPRDEFN.

SELECT B.DEPTID

, B.DESCR

, B.DESCRSHORT

, ‘U:' + A.OPRID

, A.EMAILID

, A.EMPLID

FROM PSOPRDEFN A

, PS_DEPT TBL B

WHERE B.EFFDT = (

SELECT MAX (B_ED.EFFDT)

FROM PS DEPT TBL B ED

WHERE B.DEPTID = B_ED.DEPTID

AND B_ED.EFFDT <= SUBSTRING (CONVERT (CHAR, GETDATE (),121), 1, 10))
AND A.EMPLID = B.MANAGER ID AND B.MANAGER ID <> ‘’

Note: This simple example uses Microsoft SQL database platform-specific syntax and should not be used
without careful evaluation. You may get unpredictable results if the scope definition returns more than
one row from the value table for each scope value.

Setting Up Report Requests

This section describes how to:

*  Create report requests.

* Configure delivery templates.
» Use portal folders.

»  Copy report requests.
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* Set advanced options.

Creating Report Requests

210

To access the nVision Report Request page (NVS_REPORT RQST):

1. Select Reporting Tools > PS/nVision > Define Report Request from PIA.
The Report Request search page appears.

2. Search for an existing business unit, or enter a new one.
The nVision Report Request page appears.

Image: nVision Report Request page

This example illustrates the fields and controls on the nVision Report Request page.

Chapter 16

nVision Report Request | Advanced Options | Query Prompts

Business Unit: QEBUY  ReportlD:  EMPLOYEE Copy to Another Business Unit/ Clane
Delete This Report Request
Employee Info
Report Title: | ploy Transfer to Report Books
Process Monitor
*Layout: |emp|nyee Report Manager

Share This Report Request

* Report Date Selection

*As Of Reporting Date: |Specifg.r v| |12J’31J‘20E|E| Eﬂ

*Tree As OFf Date: | se As Of Reporing Date v|
Override Tree As of Date if Specified in Layout

* Output Options

Scope and Delivery Templates

*Type: | File w |

*Format: | Microsoft Excel Files (*.xIs) v|

Run Report

By default, report requests you create are secure, meaning that they are available only to you and to any

users or groups you assign. You can make a report request public and allow access to any user.

The report request security options are configurable using the PeopleTools Options page.

See Creating Report Requests, Securing and Sharing Report Requests in PIA, "PeopleTools Options"

(PeopleTools 8.56: System and Server Administration).

Searching Report Requests

When you search for report requests, the search returns only the reports to which you have access. These
include your own report requests, any to which you have been given access by other users, and any that

are public.
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Configuring Delivery Templates

Use the nVision File / Printer Output page (NVS_RQST_FILE SBP) to configure the nVision delivery
templates.

To configure nVision delivery templates:

1. Select Reporting Tools > PS/nVision > Define Report Request from PIA.

2. Search for an existing business ID, or enter a new one.

3. Click the Scope and Delivery Templates link on the nVision Report Request page.
Image: nVision File / Printer Output page

This example illustrates the fields and controls on the nVision File / Printer Output page.

nVision File [ Printer Qutput

Business Unit: Uso01  ReportlDi EARMSLIOA

Report Scope:

Q Enter your report scope. Scope Definition

Directory Hame Template:
Enter a directory name for your instances. Use
CATEMPINVISION variables to create unique directory names. Ifthe
directory doesnt exist P3/nVision will create it.
Examples: Q\Repontsi%sSFV%%- %RID%. htm, C:%
FYd% “RTT%

File Template:
Enter a file name for your instances. Use variables to

%RID% XLS create unique report file names.
Examples: expensexls, %RID%. htm, %FY4% %
RTT%.xls
QK | Cancel |

See Creating Report Requests.

Using the Retention Day in the nVision Web Output Page

Report retention days are the number of days a report is stored in the report repository before it is expired
and purged by the purge process. Beginning from PeopleTools 8.51, you are able to set the values of
retention days for:

* nVision reports at different level: System Settings page, Process Level, Process Type, and Job.

* nVision reports that have the Web output type when you run Report Book.
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* An individual nVision report request (that has the Web output type) in PIA using the nVision Web
Output page.

* nVision drilldown reports using the System Settings page and the process type DRILLDWN.

See “Setting the Value of Retention Days for Drilldown Reports” in Using the PS/nVision DrillDown
on the Web and “Using the Retention Day in the nVision Web Output Page” in Setting Up Report

Requests.

Note: The value of retention days for a Report Request is inherited by all the report instances that are
created by the scope attached to the report. The value of retention days set at the Report Request level
overrides the settings at the Process Type, Process, Job, and System Settings levels.

The value of retention days set at the Distribution Detail page overrides the value of retention days set at
the Report Request page.
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Image: nVision Web Output page

Running PS/nVision Reports on the Web

This example illustrates the fields and controls on the nVision Web Output page
(NVS_RQST_WEB_SBP).

nVision Web Output

Business Unit: QEBUZ  Report D

Report Scope:;

QEDEPTID @ Enter your repart scope.

Folder Name:

General »

Retention Days: 10

Directory Hame Template:
BORTT 4

Content Description Template:
WRTT%

Security Template:

LVPLEEMITH

EMPDEFPTZ

Zcope Definition

GEMERAL

Enter a Faolder name for yourinstances. Use
variahbles to create unique Folder names. If
the folder doesn't exist PSinVision will
create the folder in Report Manager.
Examples: Reports'\%3FV%- %RID%.htm,
BEFY 4% WRETT%

Enter a description of the report instances for
identification in Report Manager. Use variables to
dynamically create the descriptions.

Examples: Stmt. Rev & Exp, Vacation REegister - %3F/%

Enter user |Ds or variahles to give access to report
instances in the Content Repository.

Examples: "LEVP 1 LESMITHDYY, “LEVRP T R:Manager, "%
DES.DEFTID.CPRID.CGFPRID%

To set the value of the retention days using the nVision Web Output page:

1.
2.

Select Reporting Tools > PS/nVision > Define Report Request from PIA.

Search for an existing business ID, or enter a new one.

The nVision Report Request page appears.

In the Type drop-down list box, select the Web option.

In the Format drop-down list box, select the Microsoft Excel File (.xls) option.

Click the Scope and Delivery Templates link.

The nVision Web Output page appears.
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6.

Enter an appropriate value in the Retention Days field.

Configuring Report Request Template Options

Report request template options enable you to use PS/nVision variables or static text to specify report
delivery options, including using portal folders. Using the nVision File / Printer Output page, you can also
specify scope fields to personalize reports. Template options are displayed dynamically based on your
output type on the PS/nVision Web Output page—only the options that you must specify for that output
type appear. By combining scope and DES variables in templates, you can have different instances of the
same report delivered to different email addresses, or posted to individual users in Report Manager.

To see all available template options:

1.

2.

Select Reporting Tools > PS/nVision > Define Report Request from PIA.
Search for an existing business unit, or enter a new business unit.
Select the Advanced Options tab from the nVision Report Request page.

Click the Scope and Delivery Templates - View All link from the nVision Report Request — Advanced
Options page.

The PS/nVision Report Templates page appears.

Image: PS/nVision Report Templates page

This example illustrates the fields and controls on the PS/nVision Report Templates page
(NVS_RQST TEMPL_SBP).

PSinVision Report Templates

Business Unit: QEBU1 ReportiD:  EMPLOYEE

Content Description Template: |%RTT%

Report Scope: Q

Directory Harme Template:
File Template: |%FI0% <L
Language Template:

Email Template:

Security Template:

Qs | Cancell

Using Portal Folders

214

You can use portal folders to organize nVision report results into meaningful groups. When creating a
report request with the output option of Web or Window, you can select the top level folder, and then
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define a subfolder where the report result will be posted. Subfolders can be created dynamically by using
nVision variables to generate the folder names, or statically by entering the actual folder name. Subfolders
are created under the selected top level folder and can be viewed from Report Manager.

To create a subfolder in PIA:

1. Select Reporting Tools > PS/nVision > Define Report Request.

2. Enter report request information.

3. Select the Web or the Window option as the type in the Output Options section.

4. Click the Scope and Delivery Templates link to display the nVision Web Output page.
5. Select the Top Level Folder option from the Folder Name drop-down list.

6. Enter the name of your subfolder in the Directory Name Template field.

You can use variables to create unique folder names. If the folder does not exist, PS/nVision creates
the folder in Report Manager. For example, Reports\$SFV%- $RID%\My Folder\Finance
Reports.

Selecting Portal Folders

You can select portal folders from:
* Distribution Detail page.

Select report request and run report. Change Output Type to Web or Window, and then click the
Distribute To icon.

* Scope and Delivery Templates - nVision Web Output page.
* Process Definition page.
Select PeopleTools > Process Scheduler > Processes.
Select Process Type as nVision-Report and enter NVSRUN as the Process Name.

Select the Destination tab.

Note: Subfolders can only be created from the Enter Delivery Options - nVision Web Output page.

At runtime, Process Scheduler creates the top-level folder based on the following priority order:
* Distribution Detail page.

» Enter delivery Options - nVision Web Output page.

* Process Definition page.

If a folder has not been selected on any of the above pages, Process Scheduler will use the default folder
defined by the administrator.

Related Links
"Understanding PeopleSoft Processes and Reports" (PeopleTools 8.56: Applications User's Guide)
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"Requesting Reports in PeopleSoft Applications" (PeopleTools 8.56: Applications User's Guide)
"Checking the Status of Reports" (PeopleTools 8.56: Applications User's Guide)
"Viewing Reports in Report Manager" (PeopleTools 8.56: Applications User's Guide)

Copying Requests
To access the Copy Report Request page (NVS RQST BUCPY_SBP):
1. Select Reporting Tools > PS/nVision > Define Report Request.
2. Enter report request information.
3. Select the Copy to Another Business Unit/Clone link from the nVision Report Request page.
The Copy Report Request page appears.
Image: Copy Report Request page

This example illustrates the fields and controls on the Copy Report Request page. Definitions for the
fields and controls appear following the example.

Copy Report Request

Business Unit: QEBU1  ReportiD: ENMPLOYEE

Enter the Business Unit you wish to copy this

Business Unit: Report [D: nVision Report Request to.

Q EMPLOYEE To clone a Report Request, select the same
Business Unit and change the Report |d to a
unigue value,
QK | Cancel Push the OK button when ready..
Business Unit Select a business unit to copy the report request to.

To clone the request, select the same business unit as the
original request.

Report ID Text Box Enter a new report ID to copy the report request to another
business unit.

To clone the request, enter the same report ID.

Security and Copying Report Requests

When you copy a secure report request, all the groups and users associated with that request are copied
from the original request to the new copy:

* If you copy a report request to another existing report request, the existing request must either be
public or you must have access to it.
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» Ifyou do not have access, an error message will display.

* If you copy a report request to another report request, only those users and groups with access to the
original will have access to the target after the copy.

* Any users or groups who had access to the target prior to the copy but not the original are removed
from the access list; if you want them to have access, you must reassign it after the copy is complete.

For example, assume users A and B have access to Report Request 1, and users A and C have access to
Report Request 2. If User A copies Report Request 1 to Report Request 2, then following the copy only
users A and B will have access to Report Request 2—user C no longer has access.

Setting Advanced Options

Use the nVision Report Request — Advanced Options page (NVS_REPORT RQST3) to change high level
specifications for your report request.

Navigation

1. Select Reporting Tools > PS/nVision > Define Report Request.

2. Enter report request information.

3. Select the Advanced Options tab from the nVision Report Request page.
Image: nVision Report Request — Advanced Options page

This example illustrates the fields and controls on the nVision Report Request — Advanced Options page.

nVision Report Request Advanced Options Cluery Prompts

Business Unit: QEBU1 Reportll  EMFLOYEE

* Advanced Report Instance Options

Enable nPlosion If Specified In Layout
[]Translate Summary Ledgers to Detail
[ 1 Data From Requesting B.U. Only

Time-out Minutes
* Foreign Language Translation

Enter an alternate language code for automatic translation.
Available if alternate language features are in the layout.

Language; |

Enter Delivery Template Options - View All

Related Links
Creating Report Requests
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"Using PS/nVision Reporting for Global Implementations" (PeopleTools 8.56: Global Technology)

Setting Query Prompts

218

Use the Query Prompts page (PTNVSREPORTRQST4) to view all run-time parameters of queries that
are used in the layout.

Note: The Query Prompts page is available if the Report Layout uses query as data source.

Navigation

1. Select Reporting Tools > PS/nVision > Define Report Request in PIA.
2. Select an existing report or add a new one.

3. Select the Query Prompts tab.

Image: Query Prompts page

This example illustrates the fields and controls on the Query Prompts page. Definitions for the fields and
controls appear following the example.

nvision Report Request Advanced Options Query Prompts

Business Unit: US001 ReportiDd:  MATPA

Update Parameters

Query Prompts Find First 4] 1of1 m Last

Query Name QE_MATPROMPT

Find | View A1 1 B First BY 42082 B Last
Prompt Name Prompt Value

BUSINESS _UNIT Us001
LEDGER LOCAL

Update Parameters Click to access a subpage where you can update the query
prompts values with the most updated parameters of the query.

The Update Parameters link does not appear when the user
creates and saves a new query based nVision Report Layout.

Do one of the following after creating and saving a new query
based nVision Report Layout:

*  Run the layout through the PS/nVision client.
OR

* Run the layout without defining any Prompt Values.
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Thereafter, the Update Parameters link appears in the Query
Prompt section and the user can run the layout by clicking on
this link.

Prompt Value Enter prompt values that are used for mapping the parameter
with the query at runtime.

A query report that runs from PIA and requires run-time prompt input may receive the following errors:
* Missing bind value.

Indicates that the query used in the report layout is modified or a different query was used (there are
mismatches between prompt details).

*  Empty bind value.

Indicates that an empty value was provided for a prompt in PIA.
* Invalid bind value.

Indicates that there is an invalid value for a prompt.

Related Links
Submitting Report Requests

Submitting Report Requests

This section describes how to:
* Run reports.

* Set report distribution.

Running Reports

Use the Process Scheduler Request (PRCSRQSTDLG) page to run nVision reports.

Note: Changes to the nVision report request are not saved when the user clicks the Run button, thus
enabling the user to run ad hoc reports as they would from the nVision windows client. If changes have
been made to the report request and the user attempts to navigate to a different page, such as using the
Process Monitor link, then the user is prompted to either save or discard the changes made to the report
request.

Navigation
1. Select Reporting Tools > PS/nVision > Define Report Request in PIA.
2. Select a report ID or add a new one.

3. Click the Run Report button.
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Image: Process Scheduler Request page

This example illustrates the fields and controls on the Process Scheduler Request page. Definitions for the
fields and controls appear following the example.

Process Scheduler Request

User ID: PTDOCCD Run Control 10:

Recurrence: RunTime: | 11:4153PN Resetto Current DaterTime |
a

Time Zone:

Process List
Select |Description Process Name Process Type *Type *Format

Server Name: PENT ~ | Run Date: 06/04/2009 =

nVision Report NVSRUN nvision Report Default | |Default v |

oK | Cancel |

Select the Default option in the Type and Format fields to use the options specified in the report request,
or override the request by selecting other options.

The Type menu includes these options:

Email

Sends the report instances using email.

The mail server to deliver the reports must be specified in the Process Scheduler Configuration file.
File

Saves the report instances in a specified file directory in the file server of your PS/nVision report
server.

The directory of the file server must be specified in the Process Scheduler Configuration file. PS/
nVision variables can be used when identifying the output destination.

Printer
Sends the report instances to a network printer.

All destination printers must be set in the PS/nVision report server. The default printer is the default
printer for the report server.

Web
Sends each report instance to Report Manager.

The Process Scheduler server that runs the report must be associated with the distribution node to
deliver the reports to Report Manager.
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Note: When running the report to Web output type, the file template must be within 80 characters

in length to prevent any errors. This limitation applies to the completely resolved filename if using
variables. The same limitation applies when using the File output type if the EnableDrillDownForFile
flag is enabled in the psprcs.cfg file. The report is successfully created, but web drilldown on the
report is not possible.

Window

Results of the process request is automatically delivered to a new browser window, and a copy is sent
to Report Manager.

This option is not valid for report books, or when a scope has been included in the report request. An
error message appears and the output type changes to Default.

Note: When you select to run the process request, a new browser window opens and displays the
processing page. When processing is complete, the results is delivered to this window. If the window
is closed before processing is complete, you need to access the Report Manager to view the results.
The Process Scheduler server that runs the report must be associated with the distribution node to
deliver the reports to Report Manager.

Important! This output type is not available if the user does not have REN Server Report Window
permission, or there is no active REN Server cluster available for Reporting.

To grant access to the new browser window, the permission lists of the users must include full access
to the Realtime Event Notification permission for Reporting Window and the WEBLIB_RPT web
library with full access.

Running Layouts Containing Macros in OpenXML Mode

Note: OpenXML mode does not support execution of macros during report generation time, so
NvsInstanceHook macros are not supported in OpenXML mode.

To run layouts that contain macros in OpenXML mode:

1.
2.

S.

Open the layout that contains macro.
Press ALT+F11 to open the Microsoft Visual Basic Editor window.
Double-click the Thisworkbook item list in the left pane.

Select the Workbook and Open options from the drop-down lists provided in the right side code editor
window.

Add the macro function that is intended to be called via NvsInstanceHook.

This example shows the macro function TestLayout 123 in the workbook; this macro function will be
executed when the report is opened in Excel:

Private Sub Workbook Open ()

TestLayout 123

End Sub

See “Instance Hooks” in the Using Designer Object Methods section.
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Running Layouts Containing Macros in Cross Platform Mode

Note: Cross Platform mode does not support execution of macros during report generation time, so
NvslnstanceHook macros are not supported in Cross Platform mode.

To run layouts that contain macros in Cross Platform mode:

1. Open the layout that contains macro.

2. Press ALT+F11 to open the Microsoft Visual Basic Editor window.
3. Double-click the Thisworkbook item list in the left pane.

4. Select the Workbook and Open options from the drop-down lists provided in the right side code editor
window.

5. Add the macro function that is intended to be called via NvsInstanceHook.

This example shows the macro function TestLayout 123 in the workbook; this macro function will be
executed when the report is opened in Excel:

Private Sub Workbook Open ()
TestLayout 123
End Sub

See “Instance Hooks” in the Using Designer Object Methods section.

Related Links

"Submitting Process Requests" (PeopleTools 8.56: Process Scheduler)

"Scheduling Process Requests" (PeopleTools 8.56: Process Scheduler)

"Defining Event Notifications and Configuring a REN Server" (PeopleTools 8.56: Process Scheduler)
"Defining Permissions" (PeopleTools 8.56: Security Administration)

Setting Report Distribution

222

Use the Distribution Detail page to select the recipients of your report instances separate from what you
have specified in your report request. If the output type is email, you can enter email addresses, email
subject, and message. If you are entering a list of email addresses, make sure to use a semicolon (;) to
separate each address from the others.

Navigation
1. Select Reporting Tools > PS/nVision > Define Report Request in PIA.
2. Select a report ID or add a new one.
3. Click the Run Report button.
The Process Scheduler Request page appears.
4. Select a report type, and click the Distribution link.

The Distribution Detail page appears if the output type is web, window, or email.
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Image: Distribution Detail page

This example illustrates the fields and controls on the Distribution Detail page.

Distribution Detail

Process Name: MYSRUMN

Process Type: nYision-Report

Folder Name: | > |

Retention Days: | 7

Email Subject: Email With Log: Email Web Report: Fi

Message Text:

Email Address List:

Distribute To

ID Type *Distribution ID T
Role v |[PTDOCKN Q [#] [=]

QK | Cancel |

Note: To distribute reports to a role ID or a user ID using email, all recipients must have an email address
entered in their Security user profile.

Related Links

"Understanding User Profiles" (PeopleTools 8.56: Security Administration)
"Setting Up Access Profiles" (PeopleTools 8.56: Security Administration)
"Setting Up User Profile Types" (PeopleTools 8.56: Security Administration)

Using Report Books

This section provides an overview of report books and describes how to:

*  Define report books.
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Run report books.
Set type and output options.

Run multiple report books.

Understanding Report Books

You can group multiple report requests into a single report book. Report book features include:

An interface to Process Scheduler Manager.

Using a browser, you schedule a group of reports to run using a Process Scheduler request. Your
reports are executed on the server in the format that you select, and you can run the entire report book
with the same output type and format without changing any individual component requests. You can
also schedule your report books to run at a particular time on a regular basis.

An effective status associated with each request in the report book.

You can set individual report requests within a report book as inactive. Inactive report requests remain
part of the report book but are not run as part of a request.

Security associated with each request in the report book.

Each individual report request in a report book has its own security setting that allows it to be
accessed by specific users and groups or by the public.

A method for individual report requests to inherit dates from the report book.

You can run an entire report nook using the same as of date, without changing any individual
component requests.

Multiple nVision sessions can be scheduled on a single report server.

Each nVision session is associated with its own Excel executable. This enables you to maximize use
of your report server without requiring multiple report servers for multiple report books.

Robust batch processing of message logging.

You can generate an entire set of reports without the process being interrupted due to an error
condition.

Note: Date and time variables are resolved based on the calendar being used by the PS/nVision report
server that runs the report.

Defining Report Books

224

Use the Report Books page (IC_ NVSBOOK) to create a report book. Before creating a report book, make

sure you have report requests defined for all the reports you want to include in the book. The report book
is a list of requests, not a substitute for the request. You might also want to review the requests you plan to

use to ensure they use the desired scope and layout, and ensure that you have access to all the reports you
want to include in the report book.
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Navigation

1. Select Reporting Tools > PS/nVision > Define Report Book.

2. From the Define Report Book page, search for an existing report book or create a new one.
Image: Report Book page

This example illustrates the fields and controls on the Report Book page. Definitions for the fields and
controls appear following the example.

Report Book

Run Control ID: FTOMO Report Manager Process Monitor Run

As Of Date | Today's Date v

Tree Effective Date | Use As Of Reporting Date ¥ ¥ Ignore Runtime Errors

Retention Days 10
Report Requests Personaiize | Find | View Al |E0 | B First Bl 12012 B ot

Seq |Business Unit  |FReport ID View Run
1|QEBUZ O [EMPSCOPE Q view | s [=]
2[cEBUZ |, [EMPDEPT2 a view | v [=]
Select All Deselect All | Flip Al |

As Of Date Available options are:

*  Default: To use the As Of Date from the report request.
* Todays Date: To use the current date for the report.

*  Business Unit Reporting Date: To use the date specified for
the business unit.

*  Specify: To enter the date you want to report on.
Tree Effective Date Available options are:

*  Default: To use the specified Tree Effective Date from the
report request.

*  Specify: To enter the date you want to report on.

*  Use As of Reporting Date: To create the report based on the
As Of Reporting Date that you specified in the report.

Ignore Runtime Errors Select to keep the entire Report Book from stopping if one of
the reports encounters an error.
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Retention Day

View

Business Unit

Report ID

Run

Select All

Chapter 16

Note: In such a case, the completion status will be Success, even
though one or more reports may have had errors.

If the report has the output type set to Web, enter the number of
retention days.

Note: This field is not available when the output type of the
report is not Web.

The value of retention days set at the Distribution Detail page
overrides the value of retention days set at the Report Book
page.

The value of retention days set at the Report Book level
overrides the value set at the individual report request that are
attached to the Report Book. When the value of retention days
is not set at the Report Book level, the value set at the Report
Request level is used.

See “Using the Retention Day in the nVision Web Output Page”
in Setting Up Report Requests.

Click to launch another browser window displaying the report
request.

Select the business unit of the report requests for this report
book.

To reorder your entries, insert or delete rows as necessary.
Select the report ID of the report requests for this report book.
To reorder your entries, insert or delete rows as necessary.

Click the Run button for all reports you want to run when this
book is requested.

For example, you might define a book of reports to be run at
month end, and include a report that is only run quarterly, but
select its Run button indicator only at quarter end.

Click the Add icon to add a new blank row, and you are enable
to enter a new report request.

Note: You cannot add a report request to a report book if you do
not have access to the report book.

Click the Delete icon to delete the current row.

The Select All button marks all Reports in the Report Book to
be “Run”, i.e. for all the Report Requests on the Report Book,
all the Run checkboxes are checked.
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Deselect All The Deselect All button unchecks all Reports in the Report
Book to be “Run”, i.e. for all the Report Requests on the Report
Book, all the Run checkbox are unchecked.

Flip All The Flip All button flips the status of all the Reports in the
Report Book to be “Run”, i.e. if the current status of the Run
checkbox is set as “True” (checked), then by clicking on the Flip
All Button, the Run checkbox is set to “False” (unchecked) and
vice-versa.

Running Report Books

Access the Report Book page (PRCSRQSTDLG) by selecting Reporting Tools > PS/nVision > Define
Report Book. In the Report Book page, you can run all the reports in a group or select specific reports by
selecting their check boxes in the Run column.

Note: If the report book contains secured report requests to which you do not have access, these report
requests appear inactive and you are not able to select them.

Report books are run through Process Scheduler Request page. However, when the report begins to run,
you are returned to the Report Book page. If you want to check the status of your job, click the Process
Monitor link. If you want to view a list of reports that you have access to, click the Report Manager link.

If you run all report requests in a report book that contains secured report requests, only those requests to
which you have access are run. If you run reports that you do not have access to, those processes are not
success and an error message appears in the error log.

Related Links
Securing and Sharing Report Requests in PTA

"Submitting Process Requests" (PeopleTools 8.56: Process Scheduler)
"Scheduling Process Requests" (PeopleTools 8.56: Process Scheduler)

Selecting Type and Output Options
To select type and output options for nVision reports:
1. Select Reporting Tools > PS/nVision > Define Report Book.
2. From the Define Report Book page, search for an existing report book or create a new one.
3. Click the Run Report button.

4. Select the Default option in the Type and Format menus to use the options specified in the report
book, or override the report book by making new choices.

See Running Reports.

Running Multiple Report Books

To define your process server to handle multiple report book jobs:
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1. Select PeopleTools > Process Scheduler > Server.
2. Search for the server name that you are using for your report books.
In general, your server name is PSNT. However, a list of available servers appears for your selection.

3. In the process type named nVision—Report Book, ensure that the Max Concurrent field is set to the
required number.

This setting allows multiple report book jobs to run concurrently.

Using the PS/nVision DrillDown on the Web

This section provides an overview of drilldown on Microsoft Excel reports and describes how to:
* Register DrillDown layouts.
* Use DrillDown.

* Set the value of retention days for nVision drilldown reports.

Registering DrillDown Layouts

228

All DrillDown layouts are created in the Windows version of PS/nVision, but can be used in both
Windows and a browser.

When you register a DrillDown layout, you associate it with a Process Scheduler server. You can have a
set of DrillDown layouts specific to financial applications registered to a Process Scheduler server that

is dedicated to financial applications and have a set of DrillDown layouts specific to Human Resources
registered to its own Process Scheduler server. To make a DrillDown layout available to multiple Process
Scheduler servers, register the DrillDown layout on each server. When you drill down, you can select a
report server to run the report.

To register a DrillDown Layout:

1. Select Reporting Tools > PS/nVision > Register Drilldown Layout.

2. Enter a new server name, or use the Search button to select one from a list of available servers.
The Drilldown Layouts page appears.

3. Add a new row to the Drilldown Layouts section.

4. Enter the name of the DrillDown layout and its description.

The name of the layout must match the name of the DrillDown layout that you created in Microsoft
Windows.

5. Click the Save button.
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Image: DrillDown Layouts page

Running PS/nVision Reports on the Web

This example illustrates the fields and controls on the DrillDown Layouts page.

Drilldown Layouts

Server Name; P3MT

Drilldown Layouts

Description: MNT Server Agent

|
Customize | Find | Wiew All | @| -

First n 18 of 8 u Last

Description
[APVchr AP Detail [=]
|A|:1Elus |A|:|:nunt by Business Unit [=]
|A|:1Dep |A|:|:nunt by Department E|
|A|:1F'er |A|:|:nunt vy Period E|
|A|:tF'r|:I |At:|::nunt by Product [=]
|A|:War |A|:|:nunts by Actuals/Budgets [=]
IBUSPER [Business Unit by Period [=]
|EIL|5A|:1 |Elusiness UInit by Accout [=]

Related Links
Using DrillDown Layout Formats

DrillDown and Summary Ledger

"Setting Report Distribution" (PeopleTools 8.56: Process Scheduler)

Using DrillDown

After a report has been run as web, window, or file output, you can open it and run DrillDown on specific

amount fields.

To drill down on a report that will be run as file output, you must first set the Process Scheduler

configuration for the nVision - EnableDrillDownForFile option as /.The default value is 0, which means

drilldown is disabled.

If you drill down on a report that has been run to file output, and you are not logged onto a PeopleSoft

domain—or the PeopleSoft web server domain that you are logged onto is not the web server domain of
the report server—and your ByPassSignOn Web server configuration property is set to True, then you will
not be able to access the drilldown results. The system will return the signon page with an error message
indicating that your default password is not authorized.

When you use http/https as the transfer protocol (in report node), there is an additional criterion that needs
to be met to enable drill down from a report sent to file output. The security template of the parent report
request should be set to specify which Users or Roles will have the authorization to be able to perform a
web drilldown on the report. If the Security Template is blank, then only the user that ran the parent report

will be able to perform a web drilldown on it. When using file output type, you can access the security

template by going into the advanced tab of the report request, and clicking on the Enter Delivery Template

Options - View All link.
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You can use the web drilldown from an Excel report (using the DrillToPIA add-in) if the report sheet
name had spaces in it. However, do not use special characters suchas *,”,<,>,[,],/,\,*, 7.

A PeopleTools upgrade may cause the web server domain name, port number, or servlet path to be
required to access web server resources in the PeopleSoft PIA to change. As a result, PS/nVision
drilldown operations on reports that were created prior to upgrade would fail, primarily because drilldown
links are by design hard-coded into PS/nVision reports. This utility is located in UpdateNvsDrill.xIs

file. Use the simple search and replace utility that is provided to replace old links with new ones. This
Microsoft Excel macro is located in the PS_ HOME\Excel directory.

See "Understanding the Sections in PSPRCS.CFG File Based on Operating Systems" (PeopleTools 8.56:
Process Scheduler).

Performing nVision Drilldowns on Microsoft Excel Reports Using DrillToPIA Add-
in

To perform nVision drilldown on a Microsoft Excel report using the DrillToPIA add-in:
1. Open the report in Report Manager.
2. Highlight the field that you want to drill on, and click the Drill menu when the cell is selected.

If the selected cell is not drillable, you receive a warning message that says: DrillDown only works at
the intersection of an amount row and column.

The Run Drilldown page appears in a new browser window.
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Image: Run Drilldown page

This example illustrates the fields and controls on the Run Drilldown page.

Run Drilldown

Report Instance: B1_T1
Row: g Colurmi: i
“Type: Wind o [v]
Customize
Description *Server Hame  Run Drilldown
AP Detail PESNT  |%| | Run Crilldown

Account by Business Unit FEMNT Run Drilldowen

Account by Department FEMNT Run Drilldowen

Account by Period FEMT Run Drilldown

|EFEI|EI(E

Account by Product PEMT Fun Drill down
Accounts by Actuals/Budgets PEMT Fun Drill o
Business Linit by Period PSMT Fun Drill down

Business Linit by Account PSMT Fun Drill down

|ER|ER|ER)

Business Linit by Department PSMT _ Fun Drilldown

Business Unit by Product FEMNT Run Drilldowen

Business Unit by ActualsiBudge FEMNT Run Drilldowen

<

Department by Account PEMT . Fun Drill down
Department by Business Linit PEMT Fun Drill o

Select output type Window or Web from the Type drop-down list box.
Select the server that you want your report to run on.

The Server drop-down list box only includes the servers that have the associated layout registered
with them.

Click the Run Drilldown button for the drilldown layout that you want to use.

If the nVision report instance uses the queries that contain run-time prompts, enter the prompt values.

Note: If an nVision report instance is generated with one or more queries as data source, and if those
queries require prompt inputs, then performing drilldown on this nVision report instance also requires
query prompt inputs.

If the prompt values are blank or invalid, an error message appears. If so, you can close the error
message and reenter the prompt values.

You can also enter the query prompt values when you perform nVision drilldowns using nVision
client. See Using DrillDown.
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7. Click the OK button on the prompt window.
8. Note that:
» If'the output type is Web, the Report Manager - Report List page appears again.

» If the output type is Window, the result of the drilldown is automatically delivered to a new
browser window, and a copy is sent to Report Manager.

When you select to run the drilldown, a new browser window opens and displays the processing
page. When processing is complete, the results of the drilldown are delivered to this window. If
the window is closed before processing is complete, you need to access Report Manager to view
the results.

9. On the Report Manager — Report List page, click the Refresh link.

After your drilldown runs, it appears as a report in your report list. Drilldown report descriptions
always include DR, the parent process instance number, and the original report description.

10. Click the Report link for the drilldown to display the Report Index page.
11. Click the link for the drilldown to see the drilldown results.

Web-based drilldowns persist. They are files that permanently exist on your report server, not just
temporary files as in the Windows client. Drilldown instances in the Web can be viewed and distributed in
the same manner as any other report that you run on the browser.

Setting the Value of Retention Days for Drilldown Reports

Retention days for all drilldown reports can be defined at the DRILLDWN process level. Setting the value
of retention days for each individual drilldown report is not available because:

* A PS/nVision drilldown report does not have a report definition of its own.
* Commonly in the PIA, only a list of drilldown layouts is available to end users.

* End users can set the value of retention days for each process request using the Distribution Detail
page.

Performing nVision Drilldowns Using nVisionDrill VSTO Add-in

To perform nVision drilldown on an Excel report using the nVisionDrill VSTO add-in:
1. Generate the parent report to perform the drilldown.

2. Open the parent report from the nVision Instance folder.

3. Highlight the field that you want to drill on for an Excel report.

4. Expand the Add-ins tab in the Ribbon bar to view the nVisionDrill VSTO menu.

Note: The nVisionDrill VSTO menu appears under the Add-ins tab only if nVisionDrill add-in was
successfully installed.

5. With a drillable cell in the report selected, click the nVisionDrill VSTO menu.
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A login page appears.

Note: For nVision drilldown to work in VSTO mode, SSL configuration is required. This means that
the URL should have https instead of http. Drilldown can be done on those reports that are previously
generated using the https url.

6. Enter a valid PeopleSoft user ID and password.
If the entered ID and password are valid, a list of drilldown layouts appears.
Image: List of drilldown layouts from within the nVisionDrill menu

This example shows the list of drilldown layouts from within the nVisionDrill menu.

i d=9-c FSDETAILMs [Compatibility Mode] - Microsoft Excel
J Home Insert Page Layout Formulas Data Rewiew Wiews Developer Add-Ins
[n'in"i siunDﬂ'.Il *-:
.APi)at_a'iI
Account by Business Unit
Account by Department
Account by Period
Account by Produc

Accounts by Acuals/Budgets nenl
RATIONS

Business Unit by Period
Business Unit by Account
Business Unit by Department
Business Unit by Product
Business Unit by Actuals/Budge
Department by Account
Department by Busines: Unit
Department by Period
Department by Product
Departments by Actuali/Budgets
Employee Salary Details

Journal Lines

Product by Account

Product by Business Unit
Product by Department
Product by Period

Note: When you click the nVisionDrill menu, the status of the Process Scheduler server appears to
inform you whether the Process Scheduler server is running. If the Process Scheduler server is down,
a message appears warning: Process Scheduler is down. nVision Drilldown is not possible at this time.

7. Select an appropriate layout option from the layout list.
The status bar displays the message: nVision drilldown has been submitted.

The nVisionDrill runs and a Save As dialog box appears.
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Note: If the selected cell is not drillable, you receive a warning message that says: nVision drilldown
ran to Error. Check Server log for more details.

After you submit a drilldown request, the drilldown process gets submitted at the server. The status
of this drilldown process is polled at specific time intervals. This polling interval value (PollingTime)
is configurable in the nvsdrill.cfg file, which is located in the add-in installed directory. The polling
interval value is read once during the opening of the Excel file.

8. Click the Save button to save the generated drilldown report.

Note: You must save the generated drilldown report before it is opened in a new Microsoft Excel
window.

Image: nVision drilldown report opened in Microsoft Excel

This example shows an nVision drilldown report in Microsoft Excel window.

Op) 90 )¢ Microsoft Excel

= Home Insert Page Layout Formulas Data Pewiew Wiew Developer Add-Ins
AP Detail
Account by Business Unit
Arcount by Department
Account by Period i Other Current Assets
Account by Produck I
Accounts by ActualyBudgets

E F G H | J | K| L|M

Business Unit by Period T Y Y Y
Business Unit by Account ) M30_BSds [Compatibility Mode]

B [ D E E G H

Business Unit by Department

Business Unit by Product
Business Unit by Aduals/Budge
Department by Account

TR T T

Department by Business Unit
Diepartment by Period
Department by Product
Departments by Achuals/Budgets
Emplonee Salary Details

Jourmal Lines

Product by Account

Product by Business Unit

B[R [= S w|a ~ @[ | &wr] =]

Product by Department
Produdt by Period

Note: By default, the drilldown report is opened in a Microsoft Excel window. You can view the
drilldown report in real-time while remaining in Microsoft Excel. The report is also posted to the Report
Manager.

Error Messages While Performing Drilldown on a Report

When you are performing a PS/nVision drilldown on an Excel reports, the system may display the
following error messages:

*  DrillDown only works at the intersection of an amount row and column.

¢ No criteria; cannot drill down from this cell.
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DrillDown is not allowed for this file. It is generated with no DrillDown Option. To Enable the
DrilDown, re-run the report with EnableDrillDownForFile = 1 in the Process Scheduler Configuration
File.

DrillDown can only be performed on a Matrix report.

nVision drilldown failed. Check Server log for more details.

nVision drilldown ran to No Success. Check Server log for more details.
nVision drilldown ran to Error. Check Server log for more details.
Error retrieving drilldown report.

Drilldown report is not saved.

Error opening drilldown report.

Your User ID and/or Password are invalid.

Error while retrieving drilldown options.

Error while Authorization. Try logging in again.

Communication is secured using SSL. Import Certificate and try again.
nVision drilldown has been submitted.

Problem occurred during drilldown. Check Server log for more details.
Drilldown execution in progress.

Retrieving drilldown report.

Process Scheduler is down. nVision Drilldown is not possible at this time.
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Creating Report Requests

This section describes how to:
* Create requests.
*  Open existing report requests.

* Delete report requests.

Note: Most end users create report requests, run and distribute reports, and view reports using Report
Manager on the Web in the PeopleSoft Pure Internet Architecture. Topics in this section are used by
developers who use the Windows environment to perform the same tasks.

Related Links

Understanding Report Scopes

Defining Scopes

Understanding PS/nVision Reporting on the Web
Configuring PS/nVision on the Web

Setting Up Report Requests

Creating Requests

Before you can run a PS/nVision report, you must create a corresponding report request. Each report
request is a collection of report-specific information such as request name, report title, associated layout,
scope, and so on. In a report request, you can use the Scope feature to create multiple instances of a report
from a single request.

Use the PeopleSoft nVision Report Request dialog box to enter information about the report that you’re
running, such as what layout to use, what time period to report on, and where to store the reports. This
information makes up a report request, which you can save and reuse.

To access the PeopleSoft nVision Report Request dialog box:
1. Open nVision client by selecting Start > Programs > PeopleTools 8.x > PS/nVision.
2. Select nVision > Report Request from the nVision menu.

The PeopleSoft nVision Report Request dialog box appears.
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Note: You can specify effective date for trees either when you run the report request or when you define

criteria.

Image: PeopleSoft nVision Report Request dialog box in Windows

This example illustrates the fields and controls on the PeopleSoft nVision Report Request dialog box in

Windows.

PeopleSoft n¥ision Report Request

aE

Ok

Request 1D
Request Name: |-"-"-|-|-|:|F|D
Report Title: |.-'1‘-.II Orders

Fiequesting Business Unit— — Layout

Cancel

s il

Run

INAMOT j [&0rders

Ihztance Controls

Scope: |

=

Dpen

Directary Template: |

Save

File Template; |E§HID‘Z_:-:I3

il

Delete

Language Template: |

Ernail Template: |

Deszcription Template: |

Securnity Template: |

Cutput Options
Type |Fi|e j
Format |Miu:ru:usu:uft Excel Files [*.xlz] j

Options
[+ Enable nPlozion If Specified In Layout
[ Data From Bequesting Business Uit Dealy

Error Handling

Tire-out after {0 mirutes

b ain Az Of Date
f+ Today's Date
" Specify:

" From Business Unit Table

Az OF Date for Trees

[v Overide Layout

o |sze Main &z Of Date
" Specify:

While you run the report, its layout file is opened in read-only mode to protect the layout from accidental
changes while the report runs. To modify the layout file, open the layout from the nVision menu or from
the Open Layout button on the NVSUSER home page.
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Note: Microsoft Excel does not support the following characters in its file names: <>? [ ] : | or *. PS/
nVision has an additional restriction of not allowing the characters of /\ ““ or © in report names and not
allowing % or a space at the beginning of report names.

Report requests that are created in PS/nVision for Windows are public. If you want to create secured
report requests, you must use PS/nVision on the web, where requests are secured by default.

Request ID

Request Name Enter a name to identify your report request.

By naming and saving report requests, you can retrieve all the
information of a report request the next time you run the report.
You can use the %RID% variable within a layout to display
name of a report instance.

Report Title Enter a description to describe your report request.

Use the %RTT% variable within a layout to display this title on
a report instance.

Requesting Business Unit Enter the business unit that the report belongs to.

You can retrieve data for this business unit alone or for several
business units. Use the %RBN% variable on your layout to
show the description of the requesting business unit on a report
instance. To show the value of the requesting business unit, use
the %RBU% variable.

Layout Select the report layout (the XNV file) to use for this report.

The directory for saving layouts is found in Configuration
Manager on Windows and in Process Scheduler Configuration
file on Web. Use the %LYNY% variable on your layout to show
the layout name on a report instance.

Note: The table that stores nVision report definitions (PS_NVS REPORT) now has a related language
table, so the description of the reports are translatable.

Instance Controls

Most report layouts enable you to create multiple instances of a report using a single report request. For
example, you might run three instances of an expense report that differ only in the division they report on.

Note: If you enter a list of values in any template field, make sure to use a semicolon to separate each
item.

Scope Select a scope definition to specify the data each report instance
includes and how many instances PS/nVision creates.

For example, you can select a scope to create multiple instances
of a report based on specific values for a field, such as instances
for business unit, department, or product. Use the %SCN%
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Directory Template

File Template

variable on your layout to show the scope name on the report
instance.

See Adding Variable Criteria.

If you create multiple report instances, you must ensure that
each instance has a unique directory or file name, or each new
instance will overwrite the previous one. Use variables in the
Directory Template and File Template fields to have PS/nVision
generate directories or names on each instance it creates. For
example, if you are running a report for multiple business units,
you can have the business unit appear as part of the file name, or
you can opt to save each instance into a different directory.

Enter a directory name from the nVision report server for your
instances.

Use variables to create unique directory names. If a directory
does not exist, PS/nVision creates one. If this field is blank,
PS/nVision on Windows uses the directory specified in the
Report Instance path setting in Configuration Manager. PS/
nVision on the Web uses the path specified in Process Scheduler
Configuration file.

For example, you can use \\<servername>\Directory
1\Directory 2, but you have to make sure all the subdirectories
under the servername (which comes from the combination of
directory template and file template) are accessible from your
client machine. Examples are:

o Q:\Reports\%SFV%-%RID%.htm
o C:\%FY4%%RTT%)

Include the %BUV% and %APA% variables to yield directories
that indicate the business unit and as of accounting period for

which the report was produced. Example: C:\User\nVision\
%BUV% and %APA%.

A directory for each business unit and as-of date combination is
created.

Enter the file name to give report instances.

You can include PS/nVision to dynamically create file names
at runtime. The %RID% variable instructs PS/nVision to use
the Request Name value as the file name, with the appropriate
extension according to your output format. Use the %IFN%
variable to use the file name in the layout. If this field is blank,
PS/nVision uses the layout name as the default file name.

For example:

*  expense.xls
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e %RID%.htm
o %FY4%%RTT%.xls

The instance counter variable 26/CT% causes each instance to
be consecutively numbered. For example, for a report named
OPSUM, the file template %6RID%%ICT% creates files named
OPSUMI1.XLS, OPSUM2.XLS, and so on for each instance
generated by this report request.

Enter an alternate language code for automatic translation on the
report instances.

This option is available only if alternate language design
features are included in the layout design. If you are applying
a scope to the report request, you can enter a string containing
one or more PS/nVision variables (like the File Template and
Directory Template fields).

For example:
ENG%DES.DEPTID.LANGUAGE CD.LANGUAGE_ CD%

Enter a list of email addresses or use variables to specify who
receives report instances.

This template has no default. You must have values in this
field if your output type is EMAIL, or the instances will not be
sent. If you use role or users in your email templates, the email
addresses associated with these users are entered into their user
profiles in Security.

You can enter up to 254 characters in this field. If you have a
long list of email addresses, use the role or user variables. To
enter a list of email addresses, separate each address with a
semicolon.

For example:
*  username(@xxx.com

*  usernamel @xxx.com,username2(@yyy.com

%DES.DEPTID.EMAILID.EMAILID%

*  R:Manager ;U:SMITHJ

Note: If you want to email a multi-tab spreadsheet or a
spreadsheet with an image (a graph, pivot table, or an embedded
image), you must run the report with an output type of .XLS or
distribute it through the Web using Report Manager.
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Description Template

Security Template

Output Options
Type

Format

Main As Of Date

Enter a description of the report instances for identification
in Report Manager, or use variables to create the descriptions
dynamically. For example:

Stmt. Rev & Exp or Vacation Register%SFV%

Enter user IDs, role IDs, or variables to give specific users
access to report instances in Report Manager.

To authorize a user ID, enter a U followed by a colon before
the user ID. To authorize a role, enter an R followed by a
colon before the role ID. If this field is blank, the report is
automatically distributed to the user running the report. For
example:

R:VP1U:SMITHJ%DES.DEPTID.OPRID.OPRID%

Select between sending output to a file or sending it to a local
printer.

Email, window, and web output types are not valid selections
unless you are running a report from your browser.

Select an appropriate file format.

Set the reporting period for this report. Many report layouts associated with PeopleSoft Financials
applications report on data over a given accounting period, such as the current quarter or year-to-date. PS/
nVision uses the main as of date to determine the meaning of any TimeSpans used in the layout. The date
you select is compared to the calendar to determine the current period, and TimeSpans are then evaluated
relative to that period. Available options are:

Today’s Date

From Business Unit Table
Specify
Options

Enable nPlosion If Specified In
Layout

Select this option to use date of today.

Select this option to use the date as specified on the business
unit table.

Select this option to specify another date for the report.

Select this option to enable nPlosion.

This specification overrides the specification in layout. If you do
not select this option, nPlosion is disabled—even if the layout
definition uses it.

Data From Requesting Business Unit Select this option to make the report reflect data from the

Only
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requesting business unit only. nVision will add the WHERE
criteria for requesting business, either from layout or scope
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definition, if there is no any explicit BUSINESS UNIT criteria.
This option is selected by default.

Clear this option for PS/nVision to extract data for all business
units with the criteria specified within the layout unless the
business unit is specified in report scope.

Translate Summary Ledgers to Select this option to retrieve data from the underlying detail
Detail ledger whenever you specify a summary ledger in a layout.

This option is not available if the Selected Summary ChartField
Nodes method was used in the layout to retrieve summary
ledger balances.

As Of Date for Trees

Use these options to specify trees that are in effect as of the reporting date by selecting the Use Main

As Of Date option. Or, you can specify a different date and use a set of trees in effect on that date. For
example, you may have a reporting structure set to go into effect in three months (remember that trees
are effective-dated). You can select to run the report using the new tree structure by specifying the future
effective date of the new tree.

The Override Layout option enables you to define layout-specified As of Date criteria, if any. This
Override Layout option is selected by default, and:

» If this Override Layout option is selected, the As of Date for trees specified in layout definition is
overridden when you run report request.

» If this Override Layout option is cleared, the As of Date for trees specified in layout definition is used.

» If this Override Layout option is cleared and the As of Date for a tree is not specified during the time
of layout definition, the As of Date for the tree from Report Request is used.

See Selecting Filter Criteria Options.

Error Handling (Time-out)

Use this option to specify the maximum processing time for this process and enable the system to kill
the process if processing exceeds this time. The default value is specified in the Process Definition. If a
nonzero value is specified in the report request, that value is used—if the report request's value is zero,
the value from the Process Definition is used. If no value is specified in the Process Definition, a default
value of 15 minutes is used.

Related Links

Selecting Filter Criteria Options
Adding Variable Criteria

Using TimeSpans

Defining Scopes

Defining nPlosion Criteria

Defining nPlosion Defaults
Using Configuration Manager

Securing and Sharing Report Requests in PIA
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Applying Scopes to Your Reports

A report scope enables you to create multiple instances of a report using a single report layout and report
request. Using a scope, each report instance is generated with data specific to an individual field value
(such as a business unit or department) or to a group of values (such as a tree node summarizing all sales
departments). In this way, each report instance can share the same layout, while containing data unique to
these field values.

For example, if you have a report request with a scope that produces one income statement for each
division in the company, you could use a scope variable in the Email template to have each divisional
report emailed to VP of that division. Alternatively, you could make each VP's report available in Report
Manager by using a scope variable in the Security template.

Scope variables are used in the Email and Security templates the same way that you use them to create
unique file names with the File template or directory names with the Directory template in your report
request. The Scope Descriptive Variable (%DES%) is used to select a related field value from the Scope
Value table or the Tree Node table. You can use values for email addresses, user Ids, or role Ids. The
general syntax of the %DES% variable is:

$DES. [scope field].[detail field].[node field]%

Note: The %DES% variable requires the associated field value be in the same table that the scope is
based on.

Opening Existing Report Requests
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Use the Open PeopleSoft nVision Report Request dialog box to enter the Business Unit and the Report
Name.

Image: Open PeopleSoft nVision Report Request dialog box

This example illustrates the fields and controls on the Open PeopleSoft nVision Report Request dialog
box.

b

Open PeopleSoft n¥ision Report Request E|
[ualifiers
Business Urit:  [S001 2| o

Cancel
Report Marne: |
Get List

Businesz Unit; Report Reguest -- D escription;

EARMSUDT - Quarterly Earnings Summary
EARMNSUDZ - Quarkerly Earnings Surrmany
EARMNSUOS - Quartery Earnings Surmmany
EARMSUO4 - Quarterly Earnings Summary
EARMNSUOS - Quarkerly Earnings Surmrmany
EARMSUOE - Quartery Earningz Surmmany
EARMSUOY - Quarterly Earmings Summary
EARMSUOE - Quarterly Earnings Surmmany
EARMSUOS - Quartery Earningz Surmmany

EARMSUTO - Quarterly Earmings Summary
F&RMSIT - Doartedn Farninns Sormman

To open an existing report request in PS/nVision:
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With a layout opens, selecting nVision, Report Request from the nVision menu.

Click the Open button on the PeopleSoft nVision Report Request dialog box.

Enter a business unit.

Click the Get List button to display a list of report requests in the Report Request list box.

After you click the Get List button, if the Report Request list box is too long to scroll through, enter a
partial report name and click the Get List button again.

Click a report request and click the OK button, or double-click a request name in the Report Request
list box.

The Open PeopleSoft nVision Report Request dialog box closes and the report request information
appears in the PeopleSoft nVision Report Request dialog box.

Deleting Report Requests

To delete a report request in PS/nVision:

1.

2.

With a layout opens, selecting nVision, Report Request from the nVision menu.
Select nVision > Report Request from the nVision menu.
Open the report request that you want to delete.

Click the Delete button.

Running Reports

This section describes how to:

Run a report from a report request.

Run a report from the NVSUSER home page.

Understanding Running Reports

As PS/nVision runs the report, it does the following:

Creates a copy of the layout for each instance of the report.

Calls the database to extract information defined in the layout of the report, replacing the selection
criteria with specific values.

Examines the report request, scope, and accounting calendars to transform PS/nVision variables into
values.

Microsoft Excel then performs the calculations you entered on the layout. The finished report—a normal
Microsoft Excel spreadsheet—appears on your screen. This spreadsheet is also saved in the directory you
specified.
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If you produced multiple instances of a report, each instance is saved in the specified directory, all
instance are closed except the last instance to save Microsoft Excel memory.

Running a Report from a Report Request

When you run a report from the PeopleSoft nVision Report Request dialog box, PS/nVision opens the
layout for you, checks the detail values and trees that you’ve specified as valid, extracts the data from
your database, and enables Microsoft Excel to run its functions.

To run a report from the PeopleSoft nVision Report Request dialog box in PS/nVision:
1. Select nVision > Report Request from the nVision menu.
The Report Request dialog box appears.
2. Create a new report request or search for an existing one.
3. Modify the report request as necessary.

4. Click the Save button to save your settings.

Note: When you run the report, the dialog box closes and unsaved changes are lost.

5. Click the Run button.

Note: To run the last opened report request, select nVision > Run Current Report from the nVision menu.
The report request last opened in the PeopleSoft nVision Report Request dialog box runs automatically.

Running a Report from the NVSUSER Home Page

You can run a report from the NVSUSER home page in several ways. If you have a report layout open on
your screen, click the Run Current Report icon from the toolbar. The report runs and the results appears
on your screen.

To run a report from your Preferences list:

1. Inthe NVSUSER home page, select any number of report requests from your Report Request list.
2. Click the arrow buttons to move the reports to other positions in the queue, if necessary.

3. Click the Run Report(s) button.

The reports are run in sequential order from top to bottom.

Related Links

Setting Report Request Preferences

Working With Report Instances
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After running a report, the last report instance created remains open. If other report instances were also
created, you can select File > Open to review those reports. For the reports that you view frequently,
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you can create buttons in the NVSUSER home page to open these report instances. NVSUSER also
displays a list of files in the View Reports list. This list comes from the directory that you specify in the
Configuration Manager.

Image: View Reports list displaying current instances

This example shows the View Reports list displaying current instances.

View Report(s)

————————————————————
C:h U zertMhiziont netancehd, wls -
C:A D serMYiziont natance ADHOC «lz —
C:h U sertMVizionh nstancehBALANCE #lz
C:A U zertMYiziont netanceh\BUDGET xlz
A serMYiziont nstance\ CONSBAL xls
C:h U sertMYizionh netancehEARMNS UMMM 2
C:A U zertMYiziont netancehEMPLSAL. Rl
C:Ad et MYizionhnstancehempszal s
C:h U sertMYizionh nztancehFRIDAY sz
C:AUsetMYiziont nstance\FSDETAIL sls
CAdzertMYiziont netancehGL_PARMS «ls
C:h U sertMViziont netanceh MCOME xls ;I

The layout upon which a report instance is based is never modified when the report is run. You can return
to the layout by selecting it from the Window menu; or selecting nVision > Open Layout if PS/nVision is
not open.

You print a report instance just as you would print any other Microsoft Excel spreadsheet by selecting
File > Print. If you select the Printer as your output type when you request the report, your reports are
printed as they are generated.

Related Links

Understanding PS/nVision Personalization
Personalizing NVSUSER.XLS
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Distributing Reports in PS/nVision

Understanding Report Distribution

Email and security templates in a report request are the key entries for PS/nVision report distribution.

In most of cases you use the scope variable %DES% for the distribution setting so the reports can be
distributed to different recipients according to different values in its scope field. However, you can also
override the distribution recipients in Process Scheduler Request page for a particular running of a report
request.

In general, you specify the content of email and security templates in either of these ways:

L.

You can specify the same set of recipients for all report instances from a report request.

In this way, you specify a set of user IDs (U:<user id>) or role IDs (R:<role id>) in the email or
security template, or a set of email addresses for the email template.

If you use user IDs or role IDs in the email template, you need to make sure that the corresponding
users have valid email addresses specified in their User Profile settings.

You can use scope variable %DES% in the email and security templates to select a related field value
from a value table or a tree node table that the scope field is based on.

The field values in the scope table need to be populated in the same way, as you would specify them
in the first option. The general syntax of the %DES% variable is the following:

%DES%. [scope field].[detail field].[node field]

PS/nVision evaluates the %DES% variable to the value of the detail field in the value table or the
node field in the tree node table for the scope field. In all cases, the detail fields or the node fields are
the email and web distribution fields, and they must be presented in the scope tables.

Distributing Reports for Scopes Based on Tree Nodes

If your scope is defined based on PeopleSoft tree nodes, you can attach routing information to the tree that
can be used for bursting PS/nVision reports.

The following section provides an example how to distribute PS/nVision reports for scopes based on tree
nodes. The basic steps include:

1.

Clone tree node table—create record DEPT NODE TBL.

2. Clone tree node page—create page DEPT NODE TBL.

3. Grant access to tree node pages.
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4. Update tree structures to use the new node table and node page.
5. Populate routing information.
6. Link routing information into PS/nVision.

In this example, you have a scope DIVISIONS with scope field DEPTID based on the node table in
DEPARTMENTS tree. The tree structure for DEPARTMENTS tree is DEPTID. In tree structure DEPTID,
the node table is TREE NODE TBL, the node page is DEPARTMENT, and the detail field is DEPTID.

Cloning Tree Node Table — Creating Record DEPT_NODE_TBL

250

Since your scope is based on tree nodes, the key to entering appropriate distribution information into
the tree is to modify the tree node table to include additional distribution fields. You need to add the
additional fields, DISTLIST and EMAIL_TO.to the node table to be the distribution fields for web
and email distribution separately. You can run the following SQL scripts to move the nodes from
record TREE NODE TBL to record DEPT NODE TBL, while adding the two new fields to record
DEPT NODE TB.

To move all nodes where the tree has detail values based on a given field (such as DEPTID), use the
following script:

Note: You need to change the field name in quotes to the field you want to key from.

INSERT INTO PS DEPT NODE TBL
SELECT DISTINCT A.SETID, A.TREE NODE, A.EFFDT, A.EFF STATUS, A.DESCR, ' ', ' '
FROM PS TREE NODE TBL A, PSTREENODE B
WHERE A.TREE NODE = B.TREE NODE
AND B.TREE NAME IN (SELECT C.TREE NAME
FROM PSTREEDEFN C, PSTREESTRCT D
WHERE D.TREE STRCT ID = C.TREE_ STRCT ID
AND ( C.EFFDT = B.EFFDT
AND C.SETID = B.SETID
AND D.DTL FIELDNAME = 'DEPTID' ))

To move all nodes for a given tree name, use the following script:

Note: You need to change the tree name in quotes to the tree name you want to key from.

INSERT INTO PS DEPT NODE TBL
SELECT DISTINCT A.SETID, A.TREE NODE, A.EFFDT, A.EFF STATUS, A.DESCR, ' ', ' '
FROM PS TREE NODE TBL A, PSTREENODE B
WHERE A.TREE NODE = B.TREE NODE
AND B.TREE NAME = 'DEPARTMENTS'

To move all nodes where the tree is based on a specific tree structure ID, use the following script:

Note: You need to change the structure name in quotes to the structure ID you want to key from.

INSERT INTO PS DEPT NODE TBL
SELECT DISTINCT A.SETID, A.TREE NODE, A.EFFDT, A.EFF STATUS, A.DESCR, ' ', ' '
FROM PS TREE NODE TBL A, PSTREENODE B
WHERE A.TREE NODE = B.TREE NODE
AND B.TREE NAME IN (SELECT C.TREE NAME
FROM PSTREEDEFN C
WHERE C.TREE STRCT ID = 'DEPTID'
AND ( C.EFFDT = B.EFFDT
AND C.SETID = B.SETID ))
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Cloning Tree Node Page - Creating Page DEPT_NODE_TBL

In Application Designer, clone the DEPARTMENT page to get a new DEPT NODE TBL (Department
Node Table) page.

In this table, add new page fields (as in the Routing Information section of the example below) to be the
data population area for record fields DISTLIST and EMAIL TO.

Note: The page DEPT_NODE TBL has associated PeopleCode to construct a single DISTLIST and
EMAIL TO field for each node in the node table with the multiple recipients (Email ID or Distribution
ID) that users enter in the Routing Information of the page.

Also in Application Designer, create a new component DEPT NODE and include the
DEPT NODE TBL page in it. And then, make this new component DEPT NODE a part of the Tree
Manager page system.

Image: Example of the DEPT_NODE_TBL page

This example illustrates the fields and controls on the DEPT NODE TBL page.

SetiD: SHARE  Tree Hode: ADMIN_DIV

*Effective Date: 01011900 [ »gpapys; | Active i +=

*Description: Administration Division

= e e 4 »

Email ID ID Type Distribution ID
1 [VP2@abc.com User | [vP2 Q & =
2 [Fred Smith Role | [cusToMER Q & =
3 User w | |apat Q [+ [=]
|Fing. I

Granting Access to Tree Node Pages

Use the Page Permissions page (ACL_PAGES?2) to grand security permissions, set distribution
information, and make the new node pages available to users when they maintain the tree.

Navigation

PeopleTools >Security >Permissions & Roles >Permission Lists >Pages >Edit Components >Edit
Pages
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Image: Page Permissions page

This example illustrates the fields and controls on the Page Permissions page.

Page Permissions

Dept Mode Thl ] Update/Display

TREEMAMAGER / Use / Dept Dist List

customize | Find | 1 B irst I 4 o ¢ Il s

Authorized? | Display Only Add

Update/Display All
Correction

Select All
Deselect All

ok | cancel |

To grant security permissions for the tree in PIA:

1.

2.

Select PeopleTools > Security > Permissions & Roles > Permission Lists.
Open a permission list.

For example, to grant user VP1 to maintain the tree when VP1 belongs to the ALLPNLS permission
list, open the permission list for ALLPNLS.

Select the Pages tab.
Find the TREE_MANAGER item in the list and click the Edit Components link.

The Component Permissions page appears, and the Dept Node (Department Node) component should
be in the list and not authorized.

Click the Edit Pages link in the row where the Dept Node component is listed.
Click the Select All button to grant access to the page, and then click the OK button.
Click the OK button on the Component Permissions page.

Click the Save button on the Permission List page.

Updating Tree Structures to Use the New Node Table and Node Page

Use the Tree Structure — Nodes page to modify the tree structure to use the new node table and node page.
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Image: Tree Structure — Nodes page

This example shows a version of tree structure (TREE_NODE_DISTRIB) that was modified to use the
new node table (DEPT_NODE_TBL) and node page (DEPT_NODE_ TBL).

[ I | Nodes
Tree Nodes
Structure ID; TREE_NODE_DISTRIB
*Record Name: DEFT_MODE_TBL @
*Field Hame: TREE_NODE Q
*Page Name: DEPT_MODE_TBL Q
Component Name: DEFT_NODE Q
Menu Mame: TREEMAMNAGER Q,
Menu Bar Name: USE Q
Menu Item Name: DEFTMNODE Q

To set up Tree Manager in PIA to use the new page:

1. Select Tree Manager > Tree Structure.

2. Select a structure.

3. Select the Nodes tab to change where the node information is stored.

4. Modify the structure to use the new DEPT NODE TBL record and new DEPT NODE TBL page.

Populating Routing Information

Use the Dept Node Tbl (Department Node Table) page to enter either email addresses, distribution IDs, or
a combination of both in the new node page DEPT NODE TBL. When populating distribution IDs, you
are populating the users or roles that Report Manager uses.

To add distribution route information to a tree:

1. Select Tree Manager > Tree Manager > and select the required tree.

2. Highlight the tree nodes and click the Edit Data icon to add the distribution routing information.
The Dept Node Tbl page appears.

3. Add the distribution routing information.
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4. Click the OK button to save.

Linking Routing Information Into PS/nVision

Chapter 18

When Security and Tree Manager have the correct information, the final step is to connect it to PS/

nVision.

This section describes the steps to complete this task:
*  Check scope definition.

*  Specify scope in report request.

*  Specify email and security delivery template options.

Checking Scope Definition

The following example shows the scope definition DIVISIONS, which is on the field DEPTID against all

nodes at the level DIVISION using the DEPARTMENTS tree.
Image: Scope Definition page

This example illustrates the fields and controls on the Scope Definition page.

Scope Definition

SetlD: QEDMZ Report Scope: DIVISIONS
Description: |Di“'i5i0”5 Business Unit: Q
Field Combination Table: | Q

Delete Scope

*Field Hame: |DEPT|D Q Department

*How Specified: |AII Modes at Selected Levels v|

(] Business Unit Keyed Tree
Tree Hame: | Q
Customize | Find | View Al 20| B First B 4 o4

u Last

[ [select value N
1 |DIVISIONS Q =

Scope Fields Find | Wiews All First (] 10f1 n Last

Specify Scope in Report Request

Specify the scope for which the report is being run. The scope drives the distribution process. So in this

example, make sure scope DIVISIONS is used in your report request.
To specify scope in nVision report request:
1. Select Reporting Tools > PS/nVision > Define Report Request.

2. Search for an existing business unit or create a new one.
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3. Click the Scope and Delivery Templates link in the nVision Report Request page.
4. Click the Scope Definition link in the output page.
5. Enter the set ID and report scope, as needed.

The Scope Definition page appears.

6. Specify the scope for which the report is being run.

Specifying Email and Security Template Options

The Email and Security template fields in the report request tell PS/nVision who to distribute the report
to and by what route, for example, email or via the web. To route each scope-based report instance to the
person associated with each scope value that drives the generation of the report, use the %DES% variable
to pick a field value from the tree node table.

1. Select Reporting Tools > PS/nVision > Define Report Request in PIA.
2. Click the Scope and Delivery Templates link.
3. To distribute the report by email, enter 2DES...EMAIL TO% in the Email Template field.

When you run the report, PS/nVision bursts report instances based on the nodes in DIVISION level of
the DEPARTMENT tree and delivers the results through email to the email addresses associated with
each node. Those email addresses are the ones specified in the Email ID in NODE DEPT TBL page.

Alternatively, to distribute the report via the web, enter %DES... DISTLIST% in the Security Template
field.

When you run the report, PS/nVision bursts report instances based on the nodes in DIVISION level of
the DEPARTMENT tree and delivers the results to the Report Managers of associated users of each
node. Those users are specified in the Distribution ID in NODE DEPT TBL page.

Related Links

Creating Scope Definitions

Distributing Reports for Scopes Based on Value Tables

If your scope is defined in a value table, such as Department table or Product table, you can create a
database view based on the value table to include additional email and web distribution fields. For each
scope field value in the value table, you can direct each scope-based report instance to a different user.

In the following example, NVS_DEPT VW below is a SQL View with all the DEPT TBL characteristics
and OPRIDs of department managers as distribution fields:

SELECT B.DEPTID
, B.DESCR
, B.DESCRSHORT
, 'U:' + A.OPRID AS OPRID
, A.EMAILID
, A.EMPLID
FROM PSOPRDEFN A
, PS_DEPT TBL B
WHERE B.EFFDT = (
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SELECT MAX (B_ED.EFFDT)

FROM PS DEPT TBL B ED

WHERE B.DEPTID = B_ED.DEPTID AND
B ED.EFFDT <= SUBSTRING (CONVERT (CHAR,GETDATE (),121), 1, 10)) AND
A.EMPLID = B.MANAGER ID AND
B.MANAGER ID <> ''

Note: This example shows the SQL Viewer for Microsoft SQL database platform. You need to alter the
syntax if you want to use it for other database platforms.

You can now create a scope with scope field DEPTID based on the value table and use this scope in your
report request. To have each department report instance sent, either by email or web distribution, to each
associated department manager, you would enter the following value in your Email or Security template:

$DES.DEPTID.OPRID.OPRID% or S$DES..OPRID%

This value allows PS/nVision to use the value in the OPRID field to distribute each department report
to its department manager. The report is distributed by either email or web, based on the output type
specified in your report request.
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